Welcome to Leica Infinity

Leica Infinity - the intuitive office software solution from Leica Geosystems. You need to visualize your data to form decisions. Infinity is the ideal place for managing data to and from your field instruments.

Leica Infinity is the bridge between field and office.

To find the help you are looking for:

• Use the Contents tab to browse to a topic you need
• Search for key words
• Select a link from a topic to quickly jump to related topics

Note

Depending on the licensed features of Leica Infinity, some of the topics in the online Help may not be applicable.

Video tutorials

Video tutorials are available on the Infinity YouTube channel:
https://www.youtube.com/playlist?list=PL0td7rOVk_iV_al3ziSKuAYA1VVu6W0rM

Training materials

For training purposes refer to the following materials:

• Video tutorials
• Tutorials, downloadable in the Infinity software
**Tutorial downloads**

Tutorials are available for download in the Localisation tool. Refer to "Localisation tool".

<table>
<thead>
<tr>
<th>Location</th>
<th>Data</th>
<th>Settings</th>
<th>Download path</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>Advanced Adjustment Concepts</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Advanced GNSS Processing</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Advanced Network Adjustment</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ambiguity statistics interpretation</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>How to adjust a GNSS+Level network</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>How to create a Road design from polylines in a CAD file</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>How to download reference data</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>How to manage an Antenna Calibration Set</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>How to manage TPE setups and data edits</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>How to manually create a road and use it for volume calculations</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>How to predict satellite availability for a site</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Argentina</td>
<td>How to prepare a Road job from data defined by cross sections</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Austria</td>
<td>How to process a traverse</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Belarus</td>
<td>How to process GNSS baselines</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Belgium</td>
<td>How to process level data</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Brazil</td>
<td>How to send and receive data to and from the field - Working with Leica Exchanger</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Canada</td>
<td>How to prepare a Road job from data defined by cross sections</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Czech Republic</td>
<td>Working with level lines</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Denmark</td>
<td>How to process a traverse</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Egypt</td>
<td>How to process GNSS baselines</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Finland</td>
<td>How to process level data</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>France</td>
<td>How to send and receive data to and from the field - Working with Leica Exchanger</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Germany</td>
<td>Working with level lines</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4 files selected
Licensed Modules

Leica Infinity - The bridge between field and office
• is designed to support the user by grouping product features to workflows. These workflows are grouped to modules, and most modules are optional letting you choose what work you perform with Leica Infinity.

Infinity Basic Option
Includes the core data in and data out modules: Home, Features and External Services for easy field to office or office to field data preparation. As well access to all the Backstage Tools to support getting started and working with your Leica precision measurement sensors.

Home
• Import and export all supported data formats.
• Generate extensive reports including Data Source and Stakeout.
• View or share data using Google Earth.
• View base maps: with an active CCP use the HxIP accurate orthorectified imagery.
• Quality control and correcting field errors.
• COGO to calculate distance, Compute Points and Shift/Rotate/Scale.
• Images: Link/Unlink images to features, Clip Base Map and Georeference Image.

Features
• Create and edit thematic code information.
• Automated feature code processing (blocks and layer).
• Create and manage points, lines and areas.
• Copy of entities from CAD, IFC, Shape files and WFS to the project.
• Rename Tool.

Services
• Send and receive data to and from the field using external services: Leica Exchange, Leica ConX, Autodesk BIM 360.
• Direct download of reference station data by connecting to SmartNet.
• Connect to Map services: WMS, WMTS and WFS.

Processing

TPS Option
• Create or edit TPS setups to update orientation or positions.
• Support of further point calculations: sets of angles, measure foresights.
• Build or edit traverses.

GNSS Option
• Process single or multi frequency GNSS raw static and kinematic data for determining the most reliable and accurate solution.
• View cycle slips, SNR and residual plots with statistics using advanced GNSS data analysis tools.
• Process multiple frequencies of GPS, GLONASS, Beidou, Galileo and QZSS.
• Use Autoprocessing to build up automatically all possible combination of baselines and process your data within one click.

Level Option
• Manage level lines - edit start/end points, join or split lines.
• Process level lines - edit staff corrections, reprocess and generate reports.
• Level network adjustment (1D) - complete levelled height networks.

**Surfaces Option**
• Compute 3D surface using individual points and point clouds.
• Add break lines, boundaries or exclusion areas, to edit a mesh.
• Calculate volumes.
• Create contours.
• Cut Fill Maps and compute tolerance lines.

**Scanning Option (incl. Surface option)**
• Measure within point clouds for comparison and checks.
• Visualise scan data in different colour modes - SNR, Intensity, RGB.
• Automatic and manual point cloud cleaning tools.

**Imaging Option**
• Compute points from images taken from TPS stations.

**Point Clouds from Images Option (incl. Imaging Option)**
• Orientate images.
• Create dense point clouds.
• Generate digital surface models and orthophotos.

**Infrastructure Option**
• Import, visualise and organise road design data.
• Repair road data before sending it to the field, for example live edits to road geometry or fixing string line connections.
• Document and report field applications, including stakeout and checks with tolerance flags.
• Manually input a road and compute daylight string lines.

**Adjustments Option**
• Combine TPS, GNSS and Level data.
• Full 3D, 2D and 1D computation.
• Compute loops and display of error ellipse and reliability.
3 Getting Started with Leica Infinity

3.1 Understanding How to Work with Leica Infinity

3.1.1 Leica Infinity Objects

Leica Infinity is an object-oriented software. The objects are the basic entities for performing operations. All objects are intelligent objects which means that they are interrelated with each other.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Points</td>
<td>A point is a named object that represents a location with either local or global latitude and longitude coordinates, and possibly a height or elevation.</td>
</tr>
<tr>
<td></td>
<td>Lines</td>
<td>A line is used to describe feature objects by drawing a line between two or more points.</td>
</tr>
<tr>
<td></td>
<td>Areas</td>
<td>An area is a closed line object.</td>
</tr>
<tr>
<td></td>
<td>Setups</td>
<td>A setup is the source of any measurement observation.</td>
</tr>
<tr>
<td></td>
<td>Observations</td>
<td>An observation is the measurement that defines the source of a point.</td>
</tr>
<tr>
<td></td>
<td>GNSS Tracks</td>
<td>A GNSS Track is an object resulting from processing moving or mixed data.</td>
</tr>
<tr>
<td></td>
<td>Traverses</td>
<td>A traverse is a series of intervisible points at which angles are measured and also distances can be measured, to determine the station setups.</td>
</tr>
<tr>
<td></td>
<td>Sets of Angles</td>
<td>A set of angles is a series of observations that are reduced to an angular value. The angular value is then coordinated from the source of the observations.</td>
</tr>
<tr>
<td></td>
<td>Surfaces</td>
<td>A surface is a triangulation network representing points, cloud points, lines and areas.</td>
</tr>
<tr>
<td></td>
<td>Point Cloud Groups</td>
<td>A point cloud group is a defined group of point clouds that represents a single object, used for cleaning or surface creation.</td>
</tr>
<tr>
<td></td>
<td>Point Clouds</td>
<td>A point cloud is a measurement object from the data source.</td>
</tr>
<tr>
<td></td>
<td>Image Groups</td>
<td>An image group is a defined group of images that a user can measure image points from.</td>
</tr>
<tr>
<td></td>
<td>Images</td>
<td>An image is a picture captured that is represented by its position or object it is assigned to.</td>
</tr>
<tr>
<td></td>
<td>Georeferenced</td>
<td>An image that has been ortho rectified and can be placed in the project coordinate reference frame.</td>
</tr>
<tr>
<td>Symbol</td>
<td>Object</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>↓↑</td>
<td>Alignments</td>
<td>The alignment is a linear object made of multiple segments geometrically defined and joined together. It defines the route of a road construction, generally its centreline or axis.</td>
</tr>
<tr>
<td>🔍</td>
<td>Roads</td>
<td>A road is made of several objects including a centreline and a material layer. The material layer describes the stringlines assigned to it.</td>
</tr>
<tr>
<td>🛠</td>
<td>Material Layers</td>
<td>Are the layers constituting a road. A Material Layer groups a set of stringlines that belong to the same level, material or phase of construction.</td>
</tr>
<tr>
<td>🔒</td>
<td>Cross Sections</td>
<td>A cross section is a slice or cut at a certain chainage of the road, displaying the position of different linear features connected together in a cross section view.</td>
</tr>
<tr>
<td>🔒</td>
<td>Cross Section Assignments</td>
<td>Result from cross sections templates being assigned to a road. Stringlines result from interconnecting cross section assignments.</td>
</tr>
<tr>
<td>⛅</td>
<td>Stringlines</td>
<td>Are special line objects that can either be imported from CAD or defined via cross section assignment.</td>
</tr>
</tbody>
</table>

**Point Roles and Point Symbols**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Point Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>●</td>
<td>Control point (not fixed in adjustment)</td>
<td>This is a Control point that is not considered for adjustment and not fixed.</td>
</tr>
<tr>
<td>🔋</td>
<td>1D Control point (fixed in height)</td>
<td>This is a 1D Control point that is considered for adjustment, fixed only in height.</td>
</tr>
<tr>
<td>🔋</td>
<td>2D Control point (fixed in position)</td>
<td>This is a 2D Control point that is considered for adjustment, fixed only in position.</td>
</tr>
<tr>
<td>🔋</td>
<td>3D Control point (fixed in position and height)</td>
<td>This is a 3D Control point that is considered for adjustment and fixed in position and height.</td>
</tr>
<tr>
<td>🔐</td>
<td>Adjusted measured point</td>
<td>This is a measured point that has been adjusted by least squares method or in a traverse computation. The Adjusted Least Squares point role will include the adjustment method 3D, 2D or 1D.</td>
</tr>
<tr>
<td>🔍</td>
<td>Station Setup</td>
<td>This is a point on which a station setup exists after import of field data.</td>
</tr>
<tr>
<td>🔁</td>
<td>Averaged Point</td>
<td>This point is derived by averaging two or more measured points.</td>
</tr>
<tr>
<td>Symbol</td>
<td>Point Role</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>TPS reduced measurement</td>
<td>This point is generated from the reduced observation computed from sets of angles, reduced foresights or a traverse.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>TPS measured with reflector</td>
<td>This is a point that has been measured using a reflector.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>TPS measured reflectorless</td>
<td>This is a reflectorless measured point.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>TPS measured</td>
<td>This is a point that has been measured without instrument EDM information. Typically, such points are imported from XML.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>TPS measured Setup point (with reflector)</td>
<td>This is a Control point used in a Setup application and a measurement has been taken with reflector EDM.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>TPS measured Setup point (reflectorless)</td>
<td>This is a Control point used in a Setup application and a measurement has been taken with reflectorless EDM.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Fixed RTK/Fixed PP</td>
<td>This is a GNSS RTK measured or post-processed phase fixed point (most accurate).</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>xRTK/Widelane PP</td>
<td>This is GNSS xRTK measured or a Widelane post-processed phase fixed point.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>PPP converged</td>
<td>This is a GNSS point measured with Precise Point Positioning, final position converged.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Float RTK/Float PP</td>
<td>This is a GNSS RTK measured or post-processed point with float solution (less accurate).</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>PPP converging</td>
<td>This is a GNSS point being measured with Precise Point Positioning, final position not yet converged.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Code RTK/Code PP</td>
<td>This is a GNSS RTK measured or post-processed point with code solution (least accurate).</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Navigated RTK/Navigated PP</td>
<td>This is a GNSS RTK measured or post-processed point with lower accuracy. It is measured without using a reference station. When the GNSS point roles have got a green background then this indicates a tilted measurement.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>GNSS Measured</td>
<td>This is a measured GNSS point with unknown solution type. Typically, such points are imported from XML or SKI ASCII.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>GNSS Track Post Processed</td>
<td>This is a post-processed GNSS Track (using a reference station).</td>
</tr>
</tbody>
</table>
### Data Objects - Local and Global

**Global objects** are managed and/or created from the Tools menu in the backstage.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="Icons" /></td>
<td>5.6.2 Code Tables</td>
</tr>
<tr>
<td><img src="#" alt="Icons" /></td>
<td>5.6.3 Targets</td>
</tr>
<tr>
<td><img src="#" alt="Icons" /></td>
<td>5.6.4 Antennas</td>
</tr>
<tr>
<td><img src="#" alt="Icons" /></td>
<td>5.6.5 Coordinate Systems</td>
</tr>
<tr>
<td><img src="#" alt="Icons" /></td>
<td>5.6.6 Georeferenced Images</td>
</tr>
</tbody>
</table>

Use Copy to Project to use them inside your active project.

The basic principle for working with data objects in Infinity:

- Global objects are managed or created in the Tools menu, and can be used in many projects.
- Local objects means that the data object is imported or found only in your project. You can copy data objects from the project to the Global objects so they are available for other projects.
Working with Global Objects

The suggested way to work with Code Tables and or Coordinate System is, when creating a new project, to already select each of them before pressing Create.

Targets are automatically copied to every new project. If required for a project, create a target and copy it to your project. It will be available for all subsequent new projects.

Antennas are automatically mapped during import of GNSS data to the project. When the GNSS Antenna is found in the Global Antenna list, then all antenna calibration definitions are copied into the project automatically.

☞ When creating a project or copying a global object from the backstage tools menu to the active project, any changes or edits made to this object in the project are not being updated to the global object automatically.

3.2 Understanding the User Interface

3.2.1 Getting Familiar with the User Interface

Getting familiar with the User Interface

Using the ribbon bar, there are two areas to be aware for - the Backstage and the working application window.

• The Backstage is term used for the area for managing project settings, program preferences and creating or defining global objects that can be used for a data project.
• Working in a project the data modules are tabs where user access specific functions for working with project data.

The Backstage  The Data Modules and Ribbons  The graphical 2D/3D View

The Navigator  The Inspector  The Status Bar
Undo, Redo and Delete

In the Quick Access bar there are three buttons:

• with the Undo button you can revert any preceding operation. Multiple Undo is possible.
• with the Redo button you can make undone operations re-done. Multiple Redo is possible.
• with the Delete button you can delete any selected item be that from the Navigator, the Inspector or the Graphical View.

3.2.2 Data Modules and Ribbons

Data Modules and Ribbons

The Data Modules organize common functionality into common logic groups and offer the tools to perform a specific data task. Each Data Module has its own tab in the main menu at the top. Module specific tools are available from the ribbon bar belonging to each data module.

For detailed information upon each module see:
Licensed Modules

Licensed modules only appear in the working frame if you have purchased them.

The Backstage

The File tab bundles all so-called Backstage functionality. Here you can configure global settings and perform global operations.

For detailed information upon the Backstage see:
Backstage (File tab)

3.2.3 Navigator

Navigator

The Navigator allows you to navigate through the project content. It shows the whole project content for searching for and locating single data items.

Search has got a filter effect. You can filter the points and other objects by their Id or date and time. All other points and objects will be hidden from view.

The project content is structured into three main parts:
In the **Library** all objects are grouped by the type of object they belong to and all points and objects are listed by their Id.

In the **Source** section all imported jobs are listed by date and time. All setups are grouped by the jobs they belong to. Inside each job all points are grouped by the setups they belong to and listed by their Id.

In the **Archive** section all reports and exported files are listed in chronological order by their creation date and time.

If you have closed the Navigator you can make it re-appear by pressing the **Navigator** button in the Status bar.

### Functions

**Showing/Hiding items:**
To hide points and other objects or even whole jobs from view in the graphical view click the icon. This way the graphical view can be reduced to just show the jobs and elements that you currently work on or that need revision.

**Recovering points/observations:**
Files/objects indicated by the icon have been deleted externally and cannot be accessed.

Points and/or observations deleted in the field can be restored by selecting **Recover** from the context menu.

### 3.2.4 Data Inspector

**Data Inspector**
The Data Inspector shows module specific project content grouped thematically for detailed investigation. It is designed to focus completely on one type of data object.

The availability of the modules specific tabs depends on which of the modules you have decided to purchase.

See also:
Licensed Modules
With the buttons on the left-hand side you can switch between sub-categories.

If you have closed the Inspector you can make it re-appear by pressing the Inspector button in the Status bar.

Functions

Drilling down:
To get one step further into your data click onto the arrow next to a group of data items.

Navigation to parent:
To navigate back to a higher category of data items, click onto the breadcrumbs.

Example:

Filtering:
To filter points and other objects by their Id or date and time, make use of the Search function.

To filter columns, click on the icon in the column header. To undo the filter effect, click the icon again and Clear your selection.

Editing:
To edit the properties of an item, click onto it and make your edits in the Property Grid.

Where ever the icon is available a separate tool for editing can be invoked.

Multi-Edit is possible for points and observations. For further information refer to the topics:
Observation Properties
Multi-Editing of Point Code Information

Recovering points/observations:
Points and/or observations deleted in the field can be restored by selecting Recover from the context menu.

**Selecting Columns/Changing Column Order:**
Right-click onto a column header or any item in the Inspector view and select Select columns... from the context menu.
Select the columns to be visible and change the column order if desired.
You can also change the column order by dragging and dropping the column header.

**Sorting by column heading:**
Click onto the header of a column to sort its items in an ascending or descending order.
By default, the items in the Inspector view will be sorted by the first column.

<table>
<thead>
<tr>
<th>3.2.5</th>
<th>Property Grid</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Property Grid</strong></td>
<td>The Property Grid shows the properties of a selected data item. Data items can be selected in the Graphical View, in the Navigator and in the Inspector. By default, the Property Grid is open and stays open unless you close it. It is filled dynamically depending on the selected data item.</td>
</tr>
<tr>
<td></td>
<td>☞ If multiple items are selected, select one from the drop-down list at the top to make its properties be displayed in the Property Grid.</td>
</tr>
</tbody>
</table>

**Functions**
All properties are arranged in sub-groups that can be collapsed or expanded.

All properties with a white background can be edited.

The ✍️ icon and the ✉️ icon indicate that these properties can be edited or recalculated in a fly-out or separate tool. Fly-outs have to be confirmed by OK or Cancel before you can continue working.

All changes in the properties have to be confirmed by pressing Apply at the bottom of the Property Grid.

☞ If you have closed the Properties window you can make it re-appear by pressing the Properties button in the Status bar.

3.2.6 Graphical View

Graphical View

The graphical view displays the project content graphically in 2D or 3D. It is the main representation of project content and is always visible in the background. It cannot be switched off or hidden.
Zooming/Panning/Rotating the view

When you open a project, the graphical view is zoomed to full extent. The whole project content is shown.

To zoom in to inspect the data in detail:
Scroll the mouse wheel back and forth to zoom out or in.
Alternatively press Ctrl + or Ctrl - on the keyboard.

When you have zoomed in and you want to shift the view to neighbouring areas (pan the view):
Press the mouse wheel and move the mouse into any direction until the displayed area suits your needs.
Alternatively press the right, left, up or down arrow on the keyboard.

To rotate the view:
Click into the view with the left mouse button and move the mouse.
The axis in the bottom left corner of the view follows your rotations and indicates the current view direction.

To lock zooming to the pivot point:
By default, the pivot point is identified by your mouse pointer. When you start zooming the view is zoomed into the area that your mouse points at. But you can also lock the pivot point to the centre of the graphical view marked by the little white cross.

Press the Lock the pivot point button at the bottom of the graphical view to lock the direction of view to its centre.
Alternatively, hold the ALT-key pressed while zooming.

**To zoom into the insides of an object:**

Switch the to 🗿 Perspective view and zoom until you break through the surface of the object. Once inside you can rotate the view to look at the insides of the object.

**Switching between Standard Views**

You can switch between the following standard view options:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| 🗿  | 2D Plane View:  
Select 2D Plane View to enforce a 2D view from the top down onto the data. The data will be displayed as in a map only showing the position information. You cannot rotate the view when it is set to 2D. |
| 🗿  | 3D:  
Select 3D to see your data including its position and height information. |
| 🗿  | 3D clamped:  
Select 3D clamped to enforce a projection of the data to the height level of the lowest point in your project. |
| 🗿  | Parallel:  
Select Parallel to enforce a parallel projection of the data in the 3D view. |
| 🗿  | Perspective:  
Select Perspective to allow for a perspective view. |

☞ Zooming into the insides of an object is only possible in perspective view.

☞ The overview window is only available when the view is set to parallel projection. When you switch to Perspective the overview window disappears.

Select how you want to look at the data, that means select your "camera" position. In the 3D view, you can freely rotate the view. But if you want to orientate the view such that you can look at your data exactly from, for example, the front or back or from the left or right then you have a choice here.

☞ The 2D view is set to always be a top-down view.

Select whether you want to see the entities shaded (with or without edges) or whether you want to see just the wire-frame.

Select the intensity of shading.

Select whether you want the coordinate grid to be shown or hidden.
Turning on Google Earth View Synchronisation

When you turn on the Google Earth view synchronisation, then Google Earth follows all zoom, pan and rotation operations you make in Leica Infinity.

Resetting the View

To reset the view to the initial camera position right-click into the background of the graphical view and select Zoom All from the background menu. Alternatively press Ctrl+Shift+R on the keyboard.

This resets the zoom status, which means that the view is zoomed to full extents. Any panning and/or rotation operation will be reset, too, so that you have a look at the data as if you had just opened the project.

Managing Layers

How your data is represented in the graphical view can be modified in the Layer Manager, which allows you to switch layers on and off, lock them so that they cannot be modified and change the color and style of their appearance. Read more about managing layers in the topic: Layer Manager

Hiding Elements from View

When the data structure of your project is very complex you can filter the view by switching elements or whole groups of elements off. This way the graphical view can be reduced to just show the jobs and elements that you currently work on or that need revision.

To switch elements on or off:

Click on the "eye" in the Navigator to hide points and objects or even whole jobs from view. When the "eye" is shown in the Navigator then the element or all elements in a job will be visible in the graphical view.

Selecting Elements

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single left mouse click onto an element</td>
<td>Selects the element</td>
</tr>
<tr>
<td>CTRL-key plus single left mouse clicks onto elements</td>
<td>Selects a series of elements</td>
</tr>
<tr>
<td>SHIFT-key plus single left mouse clicks into background</td>
<td>Draws a polygon and selects all elements inside</td>
</tr>
<tr>
<td>SHIFT-key plus left mouse button plus dragging the mouse</td>
<td>Draws window and selects all elements inside</td>
</tr>
<tr>
<td>SHIFT-key plus CTRL-key plus dragging window/drawing polygon</td>
<td>Selects all elements outside the window/polygon</td>
</tr>
</tbody>
</table>
The properties of the selected element will be loaded to and shown in the Property Grid.

In the graphical view selected elements change their color as specified in the Layer Manager.

**Centering Elements**

To centre the view on a selected element select an element in the Navigator or in the Inspector, right-click onto it and select **Center To** from the context menu.

The view shifts to show the selected element in the centre.

### 3.2.7 Layer Manager

**Layer Manager**

When you import data into a Leica Infinity project it will automatically be organized in layers. Each layer is defined by a name, its status and a pre-defined graphical representation, that is a pre-defined color, line style and shading style of the elements that belong to a layer. In the **Layer Manager** you can change the status (on/ off, locked/ unlocked) and the graphical settings.

To open the Layer Manager:

Click on in the Home ribbon or in the Leica Infinity Status Bar.

The Layer Manager can stay open next to working within Leica Infinity, be shifted to another screen or docked in a preferred window position within the Leica Infinity frame.
Survey data layers

All surveyed data is organized in layers. On the Survey Layers you will find all the Leica Infinity objects that are imported as field data from SmartWorx (DBX) jobs or HEXML files. Survey layers can be exported to *.dxf, *.dwg, *.xml or *.hexml files.

See also:
Leica Infinity Objects

Labels and Selection layers:

On these layers elements are grouped that label survey data entities like Point Ids and Point Code Ids, Line/Area Ids or Position and Height labels.

Labels can be switched on and off, but they cannot be locked or unlocked.

Survey Data layers:

On these layers the survey data is grouped by object type.

Thematic layers

All feature codes are organized in layers. On a Thematic Layer the thematic information of feature objects like points, lines or areas is grouped. Thematic layers can be exported to *.dxf or *.dwg.

Thematic layers can either be edited directly in the Code Manager or in the Layer Manager. You can also create new thematic layers from inside the Layer Manager. In both cases the code table is updated accordingly.

To create new layers in the Layer Manager:

Press the New layer button in the top right corner and define the new layer via in-line editing and selecting features from the drop-down list boxes in each column. The layer name can also be changed via in-line editing.

To delete selected layers:

Select one or more layers and press the Delete button to delete layers. The layer(s) will be deleted without any further warning message.

Reference layers

Under Reference layers you will find all the layers as defined in referenced files like imported *.dxf or *.dwg files or *.ifc files. For those layers you can also change the appearance, switch layers on or off or lock/unlock them, without having to modify the source files themselves.

See also:
Data Import

Settings

Switching layers on or off:

If the data in your project is organized in many different layers you can reduce the view to just the layers you are currently working on by switching others off:

Click onto the icon to switch a layer off, click onto the icon to switch a layer on.
Switched off layers will not be visible in the graphical view.

**Locking or unlocking layers:**
If you want to make sure that elements in a specific layer cannot be selected then you can lock that specific layer.
Click onto the 🗝️ icon to lock a layer, click onto the 🗖️ icon to unlock a layer.
The properties of data in locked layers cannot be edited.
☞ The graphical settings can always be changed for all layers, even if a layer is locked.

**Defining the graphical settings:**
To re-define the graphical appearance of a layer (e.g. the color of the point symbols or the line style of an area boundary) you can modify the line color, its width and style as well as shading color and style of area objects.

**Excluding layers from Export:**
Most of the layers can separately be excluded from export.
In the Export column click on the 🗕️ icon to exclude a layer from being exported.
To visualize the new status the icon will be crossed out: 🗕️.

### 3.2.8 BIM Explorer

**BIM Explorer**
Use the BIM Explorer to inspect the structure of *.ifc files and list its entities by types.

![BIM Explorer](image)

To open the BIM Explorer:
Click on 🗃️ BIM Explorer in the Status Bar.
☞ The BIM Explorer can stay open next to working within Leica Infinity, be shifted to another screen or docked in a preferred window position within the Leica Infinity frame.
Available functionality

Switching between Structure view and Types view:

View the elements/entities either by file structure or sorted by type.

Selecting elements/entities:

When you select an element in the BIM Explorer it will simultaneously be selected in the graphical view and its properties will be displayed in the property grid.

You can select single elements as well as whole entities.

Viewing/Hiding elements/entities:

Click on the eye to hide an element or a whole entity from view.

Deleting elements:

Selected elements can be deleted.

Searching for elements/entities:

Search for single elements or entities.

The Search functionality filters the elements. All other elements will be hidden from view.

3.2.9 Status Bar

The Status bar at the bottom of the Leica Infinity workspace indicates current settings.

Leica Exchange

When logged in to the Leica Exchange service there are three status icons that inform the user about the status or if new messages exist.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Not connected icon]</td>
<td>Not logged in. It is not possible to send or receive data using Leica Exchange. You will not be notified of incoming messages.</td>
</tr>
<tr>
<td>![Logged in as bank (Henson Kevin) icon]</td>
<td>Indicates being logged. It is possible to import and export data from the open project.</td>
</tr>
<tr>
<td>![Logged in as Henson Kevin icon]</td>
<td>New message(s) are available for download.</td>
</tr>
</tbody>
</table>

**Window status**

The status bar indicates whether the Navigator, the Inspector and/ or the Property Grid are visible or hidden.

Press the buttons to change the visibility status.

☞ You can also open the Layer Manager or the BIM Explorer from here.

**Unit settings**

The status bar indicates the units you have chosen for distances and angles. To change the units and the available decimal places in the current project open the drop-down lists:  

☞ You can also change the unit settings via Backstage > Info and Settings > Coordinates and Units.

**Coordinate System settings**

The status bar indicates the coordinate system which is currently used for displaying the project data. The selected coordinate system is called the Master.

To select another coordinate system open the drop-down list:

☞ You can also select a different master coordinate system via Backstage > Info & Settings > Coordinates & Units.

**Conditions:**

- If you import raw data coming with a coordinate system then this coordinate system will automatically be stored to the project and be made available in the drop-down list.  
  To make it be used select it from the list.

☞ If you want a coordinate system from the global Coordinate System management to become available for selection, then go to Backstage > Tools > Coordinate Systems and copy the required coordinate system to the current project.
• If you select **None** then the data of each job will be displayed using its own coordinate system.
• If you **export** project data to **DBX, LandXML or HEXML** always the **Master** coordinate system will be exported with your data. If **None** is used then your data will be exported without any coordinate system information.

☞ If you want to export **all** coordinate systems from the current project choose to export **Coordinate Systems** in the **Data Export** dialog.
All coordinate systems will be saved to the **same** TRFSET.DAT file.

### 3.2.10 Window behaviour

**Window behaviour**
The overall Leica Infinity user interface is designed such that the **Graphical 2D/ 3D View** will always be available in the background. The other three main windows (the Navigator, the Inspector and the Property Grid) can individually be made to be:

**Floating:**
Grab the window with a left mouse-click onto its title bar and drag it out of its place. It will be undocked from its place and become a floating window.

To dock it again, grab the floating window with a left mouse-click onto its title bar and drag it to one of the docking places that appear when you start moving the window. Drop it with the mouse pointer onto the desired docking area and the window will get docked in the frame of the opaque yellow area.

Illustration of docking places:

☞ To enlarge the available space for the Graphical View, floating windows can comfortably be moved to a second monitor.

**Hidden:**
Hide the window by either pressing ![icon] in its title bar or by pressing its button ![icon] in the Status bar. The button frame disappears to indicate that the window is hidden: ![icon]

To make the hidden window visible again press its button again in the Status bar.

### 3.2.11 Customizing colors

**Customizing colors**
Code and Layer colors can be customized.

In the **Code Manager** or in the **Layer Manager** click onto the **Line/Shading Color** to be customized and either select a color from the pre-defined **Theme** or **Standard** colors or open the **Customize Color** area to define a color.
You can choose between **RGB** (Red-Green-Blue) color definitions or **HSB** (Hue-Saturation-Brightness) from the combo-box.

**To customize a color:**

1. Drag the inner circle to the area of the desired color spectrum. You can also enter the Id of a specific color or its RGB/HSB parts if you know them.
2. Move the circle in the bar at the bottom to change the brightness.
3. Set the selected color by clicking onto the top square in the top left corner.

### 3.3 Understanding coordinate systems

#### 3.3.1 Working with coordinate systems

**Working with Coordinate Systems**

Each Infinity project can support many coordinate systems. These coordinate systems can be imported from data sources such as SmartWorx jobs or copied into the project from the Global objects list. Since multiple coordinate systems can exist in the project, the project has settings to define how the coordinate systems are used. The project can have a single coordinate system which is used to project all project data to the same grid reference frame. All WGS84 data will be projected to local grid values and all local grid values can be converted to WGS84. You see this when working with the project, from the status bar.

- Coordinate systems are global objects.

**Master Coordinate System**

The master coordinate system is what the project is defined to use.

If a coordinate system is chosen when creating a new project, then this is called the master coordinate system. This master is used to project all data to the common grid reference frame. All WGS84 data will be projected to local grid values and all local grid values can be converted to WGS84. You see this when working with the project, from the status bar.

- When you are exporting data to various formats, it is important to have a master coordinate system set for your project data so all the data is on the same reference frame.
Data Source Coordinate Systems

For many data sources, it is possible that they include their own coordinate system. Importing a SmartWorx job could have a coordinate system as used on the field instrument. You see this in the data source properties if a coordinate system is included.

It is possible to view each coordinate system as was used on the field sensors by choosing None in the status bar. This can be useful to identify potential problems between different data sources.

![Image of coordinate system options]

Using the Coordinate Systems

Master coordinate system is used

What you will see with project data when a master coordinate system is in use:

- WGS84 entered points will be convertible to local grid unless they fall outside the projection limits of the selected coordinate system.

Data source coordinate system used

What you will see with project data when no master coordinate system is in use and if no coordinate system is assigned to the data source:

- WGS84 entered points will not be convertible to local grid. They will not be displayed in the graphic view and will be indicated with this icon:

- Point Averaging results will only include the local grid values if available
  - when only WGS84 coordinates exist for that point id then the average will be computed in WGS84
  - when one or more local coordinates exist for that point id then the average only considers the local grid points
- Exporting data might not include the coordinates as expected

See also:
Coordinate System Properties

3.3.2 Coordinate Systems inside a Project

You can import one or more coordinate systems to your current project either together with SmartWorx DBX jobs or independently of raw data as Transformation Sets stored in TRFSET.dat files or from LandXML.

All imported coordinate systems will automatically:
• be stored to the project
• be available for selection in the Job Properties, the ASCII file Properties, the Project Settings (Info and Settings) and the Status Bar
• be listed in the Coordinate Systems tab of the Inspector

Job Coordinate Systems and ASCII/SKI ASCII file Coordinate Systems

In the Job Property Grid you can choose a different coordinate system to be attached to the source data of a job.

In the ASCII/SKI ASCII file Property Grid you can choose a coordinate system to be attached to the source data of an imported ASCII/SKI ASCII file.

All coordinate systems stored with the current project are available for selection.

1. In the Navigator go to the Source section and select the job/ASCII or SKI ASCII file to which you want to attach a different coordinate system.
2. In the Property Grid select a different coordinate system from the dropdown list.
☞ If you choose None no coordinate system will be used with the selected job/ASCII/SKI ASCII file.
☞ Directly after import ASCII/SKI ASCII files will always have Coordinate System None. Attach a coordinate system to be able to use individual coordinate systems with each set of imported raw data, be that jobs or ASCII files, in your project.

If you want to make the coordinate system of the selected job globally available under Backstage > Tools > Coordinate Systems:

Press the Export to global button.

Inspecting Coordinate Systems

In the Coordinate Systems tab of the Inspector all coordinate systems that are stored with the current project are listed.

You can:
• remove coordinate systems from the project.
  Select one or more than one coordinate system, right-click into the selection and select Delete from the context-menu.
  Alternatively, press the button in the very top left corner of the main window.
☞ You can only delete, i.e. remove coordinate systems which are not in use.
☞ Removed coordinate system will still be available in the global Coordinate System Management under Backstage > Tools > Coordinate Systems.
• export coordinate systems to the global Coordinate System Management under Backstage > Tools > Coordinate Systems. Select one or more than one coordinate system, right-click into the selection and select Export to Global from the context-menu.

• inspect the Properties for each coordinate system including Geoid and CSCS Models.

• see whether a coordinate system is In Use and/or in use as Master Coordinate Systems are In Use when they are attached to one of the jobs that have been imported to the project. A coordinate system is the Master when it is chosen either in the Info and Settings or from the Status bar to be used with all data in the project.

☞ The master coordinate system need not be in use with one of the jobs.
☞ If no Master is selected (i.e. None is chosen in the status bar) then the data of each job/ASCII file will be displayed using its own coordinate system.

Coordinate Systems can be modified in the Property Grid.

Exporting Coordinate Systems
If you export a project to DBX, LandXML or HEXML always the Master coordinate system will be exported with your data. If None is used then your data will be exported without any coordinate system information.

To export all coordinate systems from a project:
Choose to export Coordinate Systems in the Data Export dialog to export all coordinate systems that are available with the current project and saved them to the same TRFSET.DAT file.

See also:
Data Export

3.3.3 Coordinate System Properties

Coordinate System Properties
To view and edit the Coordinate System Properties:
Go to the Coordinate Systems tab of the Inspector and select a coordinate system from the list.

In the Property Grid:
• Press the **Export to Global** button if you want to make the selected coordinate system be globally available under Backstage > Tools > Coordinate Systems.

☞ The button is inactive if the selected coordinate system is already available under Backstage > Tools > Coordinate Systems.

• Press the ⚛ icon to get detailed information on the **Transformation**, **Ellipsoid** and **Projection** used with the coordinate system in a fly-out.

• Press the ✂ icon to get detailed information on the **Geoid Model** or the **CSCS Model** used with the coordinate system. **Import** a Geoid or CSCS Model if required or **select a different** one from the drop down-list.

☞ Only Geoid/CSCS Models that are **valid** for the selected coordinate system are available for selection. Their names can be modified if required.

• Leave the **Property Grid** with **Apply** to take over your changes.

**To import Geoid/CSCS Model:**

In the Geoid/CSCS Model fly-out:

1. Press the **button** to browse for and select a Geoid Field file (*.gem) or a CSCS Model (*.csc). Their names can be modified.
2. Leave the fly-out with **OK** to **add** the Geoid/CSCS Model to the drop-down list.
3. The newly imported model is selected automatically. Select **None** if you want no Geoid or CSCS Model to be used with the coordinate system.
4. Leave the fly-out with **OK** to apply your modifications. The **Inspector** view will be **updated** accordingly.

☞ Only Geoid/CSCS Models that are **valid** for the selected coordinate system can be imported.
4 The Data Modules

4.1 Home Module

4.1.1 Overview

Home

The Home module is the core data flow working module. The user will visualize, quality control, perform basic edits and generate reports from this module. Home bundles some general functionality for data handling and data creation.

Data:

- Import data.
- Export data.
- Create Reports on all Points in the project, on all Setups, Traverses and Surfaces.
- Inspect the project data in Google Earth.

Create New:

- Create new Points.
- Create new Stations.
- Create new Observations.

Manage Layers:

Define the settings for the graphical view in the Layer Manager.

Map Services:

- Turn on or off the Hexagon Imagery Program or other maps.
- Download data from a WFS - Web Feature Service.

Work with Images:

- Select an image and link it to a Point, Line or Area.
- Remove an image linked to a feature.
Clip a base map as a Georeference image stored to the project.

Select an image to ortho rectify.

Use COGO calculations:

Measure Point to Point.

Compute Point.

Shift, Rotate, Scale.

Coordinates:

Compute Project Coordinates.

Open the Coordinate System Manager.

### 4.1.2 Reports

Reports

An important part of any project is the documentation of the data import, field work and project processing results. Run and store the reports and be aware of all the reports from the Navigator Archive.

**To run a report:**

1. Select the object(s) that you wish to have the report of. You can also select the results of processing or adjustment runs or of single volume calculations.
   In some cases you can run reports on all the data of the project, such as Points, TPS setups, TPS and GNSS Observations.

2. Press the Reports button in the Home ribbon or select Report from the context menu.

Values exceeding limits are marked in bold red.

Go to the Backstage > Info and Settings to set the tolerances as required.

Each report can be sent to a printer directly or be exported as a PDF:

1. From the toolbar at the top of a report window select \( \text{Export Acrobat (PDF) file.} \)

2. Choose a location where the PDF shall be saved to.

At the same time the PDF is stored to the Project Archive in the Navigator.
• Right-click onto the PDF and select **Open** to open the PDF.
• Right-click onto the PDF and select **Open Containing Folder** to open the directory containing the PDF in the Windows Explorer.
• Right-click onto the PDF and select **Remove** to remove the file from the Archive without deleting it from disk.

**Reports on Data Sources**

After importing a Captivate / SmartWorx DBX job it’s possible to run a report to document the imported state of the data source. In some cases editing of the imported data is needed to fix various field errors or to shift the data from local to grid coordinates, and then you can run again the Data Source report to store the edited state of the data source.

1. Run report after import to document the field data as measured
2. After edits have been made run a second report to document the current or final state of the field data

### 4.1.3 Google Earth

**Google Earth**

Leica Infinity offers the possibility to view and inspect your project data in Google Earth.

☞ Make sure that you have successfully installed Google Earth on your PC.
☞ Make sure your project data has either WGS84 coordinates or a coordinate system attached.

**To open Google Earth from inside Leica Infinity:**

Go to the **Home** module and press the **Google Earth** button from inside the ribbon bar.

Google Earth is started and the data is displayed as a **Temporary Place**.
Under **Library** click the links to get information on the **properties** of single **points, lines, areas or surfaces** in a Google Earth flyout.
Under **Source** click the links to get information on the **properties** of single **data sources** in a Google Earth flyout.

By default you will see all **GNSS** and **TPS Observations** as well as the **Point Symbols** and **Point Ids**, each on a separate Layer:

To switch off a layer in Google Earth **deselect** it in the tree structure on the left.

**To synchronize Google Earth with Leica Infinity:**

Turn on the **Google Earth view synchronization.** Google Earth will **follow** then all zoom, pan and rotation operations you make in Leica Infinity.

### 4.1.4 Map Services

**Base Map**

It is possible to use a **Base Map** in your project. Using base maps is a nice way to help visualize, reference and relate your project data.
Requirements to use base maps in the project are:

- A coordinate system defined in the project
- At least one point in the local grid value available in the project.

With this defined position the Map service is able to provide map or image tiles, if they are available.

From the **Home** module, it is possible to turn on or off a **Base Map**. From the Ribbon Bar, you click the Map Service icon to enable or disable the base map.

**HxIP (Hexagon Imagery Program)**

By default, the **Hexagon Imagery Program - HxIP** - is included with an active CCP Infinity software maintenance contract.

The Base Map will be drawn below all project data, regardless of height values.

☞ HxIP is an image tile service provided by Hexagon Geosystems and offers cached background maps of up to 30 centimeter orthorectified imagery that is being updated on a regular basis. To learn more about this service, visit: https://hxgncontent.com/imagery

**WFS (Web Feature Service)**

The WFS service delivers data in various coordinate reference systems defined by EPSG codes. In Infinity we convert the data from the local defined WFS coordinate system to WGS84 coordinate system same as for WMS and WMTS tile images.

☞ To visualize the data in Infinity, it is necessary to create/download a coordinate system.

To download data from WFS, do the following:

1. Define a WFS in the Backstage. Refer to "Map Services".
2. To access the WFS within an open project, go to the Home module > Map Services and click the WFS icon. The Web Feature Service dialog opens.

The map is located around your project data by default. If the project is empty, the map is located around Heerbrugg, Switzerland by default.

3. In the Settings table you can select the Service and the Max. Nr. of Features.
   To select the Service, click the arrow of the Name field to open a drop-down list of available services.
   To select Max. Nr. of Features, click into the Max. Nr. of Features field and enter a number to limit the maximum number of features in one single download.
   ☞ By default, the Max. Nr. of Features is set to 10000.

4. To download the data, click the icon Download all or the icon Download current view.
   Download all: For downloading all features from the selected layer.
   Download current view: For downloading features from current map view only.
   ☞ It might happen that some services does not support the Download current view option. If no data can be downloaded, use the Download all option.

5. After starting the download, follow the download in the Status section.
   In the Status section you can view the progress, the amount of downloaded features and download errors.
   After the download, you can see the features in your project. For selected features, you can see single attributes. From the Navigator > Source, you can open an attribute table from context menu for all features.

It is possible to select an object and run Copy from CAD. Refer to "Copying from CAD".
4.1.5 Clip Base Map

When using a Base Map service it is possible to clip the base map and store it to the project as a Georeferenced image. When clipping the base map, the image or map that will be downloaded is what you will see as displayed in the graphical view.

Clip Base Map is only available when a Base Map is on.

To clip the base map:
1. Navigate to the map area you want to download.
2. Press the **Clip Base Map** icon from Ribbon Bar.
3. The **Clip Base Map** window opens.
4. Enter a name for the **Georeferenced** image you will download.
5. Choose the level of detail (if available depending on the service set as the active Base Map).
6. Click **Create**.

The download of data is depending on the service being clipped.

Base Map image services use tiles of images to cover the area of display. Downloading an image then is downloading tiles, the detail level of the tiles starts from the display in the graphical view. You can increase the level of detail for the image tiles to download. The detail level normally is indicated by a number between the range of 1 - 20 where 20 is the highest level of detail. Keep in mind that the more detail you want to download the larger the size of image tiles being downloaded. The maximum number of tiles possible to download is 1200, regardless of the level of detail.

4.1.6 Compute Project Coordinates

Allows you to apply an average combined scale factor and a shift in Easting and Northing in order to compute project coordinates from existing grid coordinates.

In the Home ribbon bar, click the **Compute Project Coordinates** button.

The Project Coordinates tool opens up next to the Property grid.

1. Select a method. Choose between:
   - **User entered**
     Enter manually the average combined scale factor, and a shift in Easting and Northing.
   - **Base Point**
     Click the **Edit** icon and select a Base Point from the flyout to make the system compute the average combined scale factor. The shifts in Easting and Northing can be entered manually.
   - **Selection**
     Makes the system compute the average combined scale factor based upon a selection of points. The shifts in Easting and Northing have to be entered manually.
2. Click **Apply** at the bottom of the Tool window.

Project coordinates are computed for all points that are either stored as local grid or can be converted to local grid with the help of the attached coordinate system.

☞ The project coordinate system has to have a map projection of type Transverse Mercator, UTM, Lambert two or Double Stereographic. Check the attached coordinate system in the Coordinate System Manager.

Inspect the results in the Inspector > Features tab under 🏠 Points. If not switched on already right-click on the column headers and select the columns **Project Easting** and **Project Northing** to be displayed in addition to the regular Easting and Northing columns.

☞ The project coordinates including scale values can be exported to an ASCII file using the ASCII export.

### 4.1.7 Data Import

#### 4.1.7.1 Data Import

**Data Import**  
Data can be imported to the current project from different sources. Based on the type of data you can define and apply specific settings and filters. The Import functionality is available either from inside the **Backstage** or from inside the **Home** module.

☞ It is only possible to import data into a project if the project is open in the application. Check if the **Import** menu is active. If not then open a project first either by creating a new project or by opening an existing project from inside the Backstage ➔ Project Manager.

☞ Imported data files are listed in the Navigator under **Source**. Select any file to view its properties in the Property Grid.

**To import data:**

1. Go to the **Backstage** and select **Import** from the menu on the left-hand side or go to the **Home** module and select **Import** from the ribbon bar.

In the **Import** dialog:

2. Select the **Type** of the source file to be imported.

3. Browse to the **Location** where the source file is stored. All source files of the selected file type that are available in the selected location are listed in the content area of the dialog under **Files**.

☞ Press the 🕵️‍♀️ **Show subfolders** button to list all files that are of the selected type but contained in sub-folders.

4. Select the **Source file(s)** to be imported.

☞ Only files of the same type can be multi-selected.

☞ Selecting a file and pressing CTRL-A selects all files that are of the same type.

5. Press the **Import** button.

**To import data by drag & drop:**
1. On your computing device: Open the file explorer and browse to the location where the file is stored.
2. In the Infinity software: Click the **Home** tab in the ribbon bar and activate **View** within an open project.
3. Go to the file explorer and drag and drop the file into the **View** area to import the file.

### Import Formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII</td>
<td>A <strong>template</strong> has to be defined. See also the topic on: Importing ASCII files</td>
</tr>
<tr>
<td>SKI ASCII</td>
<td>SKI ASCII files are written in a specific ASCII format to exchange information on baseline vectors. See also the topic on: Importing SKI ASCII files</td>
</tr>
<tr>
<td>Captivate/ Smart-Worx DBX</td>
<td>Imports all data belonging to a job measured in the field. Points that were deleted in the field will by default also be imported. Under <strong>Settings</strong> de-select this option if you do not want deleted points to be imported. <strong>Points that were deleted in the field can be recovered</strong> in the Navigator or in the Inspector.</td>
</tr>
<tr>
<td>GNSS Raw Data</td>
<td>*.MDB only – imports only the raw GNSS data from Captivate/SmartWorx jobs. RINEX 2.10, 2.11 and 3.02 supported. Hatanaka supported (i.e. RINEX observations files in a compressed format preferably used when observations are downloaded online from permanent reference station sites).</td>
</tr>
<tr>
<td>Level Data</td>
<td>Import *.LEV format level data from the DNA levels.</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>Imports coordinate systems information from TRFSET.DAT files.</td>
</tr>
<tr>
<td>XML</td>
<td>Supported are LandXml and HeXML files.</td>
</tr>
<tr>
<td>Scan Data</td>
<td>Point Clouds can be imported from: *.pts or *.ptx, both of which are ASCII based formats *.xyz, *.sdb, the Leica specific format *.las/ *.laz **Importing to <em>.las/ <em>.laz</em></em>: Data has to be in the local grid coordinate system. **Importing to <em>.las/ <em>.laz</em></em>: If the data includes classification, a point cloud group is created. Each classification is written as a point cloud that belongs to the point cloud group.</td>
</tr>
<tr>
<td>AutoCAD</td>
<td>Imports CAD data from *.dxf or *.dwg.</td>
</tr>
<tr>
<td>BIM</td>
<td>Import Building Information Modelling data from *.ifc or *.ifczip files. Data structure (structure, types, layers) will be preserved.</td>
</tr>
</tbody>
</table>
ESRI

Imports Points, Lines & Areas information from ESRI Shape files (*.shp).
☞ The attribute information from the (*.dbf) is imported as well and is listed in the Attribute table available from Data Source context menu.

Zeno Mobile

Import Zeno Mobile projects as zip files. The zip file contains shape files, GNSS observations, linked images and defined coordinate systems.

Observation Data GSI

Import *.GSI format for level data, points and TPS observations.

For TPS observations:
From the Import Settings table, you can select how the feature codes shall be processed during the import.
In the Interpret Features field, you can choose if feature coding will be interpreted as Thematic, Free or None.
Thematic: A point-related code will be created. You must decide on which point or points the code shall be related to.
Free: The result will be a time stamp code. Time stamp codes are not point-related.
None: Codes will be ignored. Points are created without codes.
Thematic codes may belong to either previous or following points. In the Apply Code to field you can decide on which points the feature code shall be applied to:
Previous point or Following point
All previous points until different code or All following points until different code is encountered while reading the raw data file.
All previous and following points is encountered while reading the raw data file.
☞ Codes registered as WI 71 are imported as thematical codes independent of the Coding import setting

Aibot Data

The Aibot data include image, GNSS and sensor information.

Navigation features in the Import dialog

Two special folders support better navigation between locations:
• Under ☐ Recent the last used locations are listed.
• Under ⭐ Favourites the locations are listed that you marked as a favourite by pressing the ☀ Set/Reset favourite folder button.
  Favourites can be removed from the list by selecting ⎪ Remove from the context menu.

To ⌘ Refresh the navigation pane, ⌘ Rename or ⌘ Delete a folder or to create a ⭐ New Directory:

Right-click onto the folder and select the desired function from the context menu.
It is also possible to **copy & paste** a location. Double-click on the bread-crumbs in the files pane to make the field become editable and copy the desired path to it.

### 4.1.7.2 Import ASCII data

**Importing ASCII files**

To import ASCII files into your project you have to make use of the ASCII Import. A template has to be defined to identify user-specific data structures which are typical of ASCII files.

☞ Without a suitable and correctly defined template it will not be possible to read the data structure in the ASCII file nor to import the data.

**To import ASCII data:**

1. Go to the **Backstage** and select **Import** from the menu on the left-hand side or go to the **Home** module and select **Import** from the ribbon bar.

In the **Import** dialog:

2. Select ASCII as the **Type** of source file to be imported.

3. Browse to the file to be imported and select the file.

4. Under **ASCII Settings** select an existing Template that fits the file format or select **New...** to define a new one. Confirm a newly defined template with OK.

5. Press the **Import** button.

**Defining an ASCII Import template**

![Import ASCII Template Editor](image)

**Settings:**

- **Separator:** /  
- **Value Separator:** =  
- **Preview:** x=3/y=2

**The Data Modules**
• Define at which row the import shall be started. If the ASCII files contains a header in row 1 then start the import at the row 2 (i.e. at the row that contains the first data set).
• Identify the Column Separator. Select 'Treat consecutive delimiters as one' if necessary. See below further information.
• Identify the Decimal Separators that are used in the ASCII file.
• Identify the correct Coordinate Format and Height Mode of the data to be imported.
• Select the Point Role that shall be assigned to the imported points.
• Identify the Linear Unit.
• If you intend to import Geodetic coordinates identify the Coordinate Format. See below for further information.

Attributes:
• Identify the Attribute and Value Separators that are used in the ASCII file.
• A preview shows you which structure is expected based upon your settings.
☞ Preview and ASCII file must correspond to each other.

Preview:
• Identify the data type in each column by selecting a type from the drop-down menus.
  To identify the column 'Point ID' is mandatory. All other data types can optionally be set.
☞ Columns of type 'Unused' are ignored during import.
☞ For the height only the previously selected mode will be available for selection.
☞ If a column only contains attribute values (without the attribute name) then select 'Attribute Value' from the drop-down menu.
  If the name is given in the file header then it will be taken from there.
  If the header is empty a default name will be assigned.

Treat consecutive delimiters as one
It may happen that your ASCII file looks like this:

```
1  309  549282.26  5248890.18  413.07
2  440315  548314.88  5247659.36  419.72
3  440402  550691.54  5247142.54  418.67
```

using two tabs following each other in the first row but only one as separator in the following rows. ASCII Import would interpret this as:

```
   Preview

<table>
<thead>
<tr>
<th></th>
<th>Unused</th>
<th>Unused</th>
<th>Unused</th>
<th>Unused</th>
<th>Unused</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>309</td>
<td>549282.26</td>
<td>5248890.18</td>
<td>413.07</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>440315</td>
<td>548314.88</td>
<td>5247659.36</td>
<td>419.72</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>440402</td>
<td>550691.54</td>
<td>5247142.54</td>
<td>418.67</td>
<td></td>
</tr>
</tbody>
</table>
```
making it impossible to identify the columns.

Select Treat consecutive delimiters as one to achieve a correct interpretation of the columns.

The resulting columns in the Preview will be in line and you will be able to identify each via its header.

**Geodetic Coordinate Formats**

If you intend to import Geodetic coordinates from a text file the coordinates have to be in one of the following formats:

**DD.DDDD**

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>47.156894112 N</td>
<td>9.249561234 W</td>
<td>474.7037</td>
</tr>
<tr>
<td>2</td>
<td>47.156894112 S</td>
<td>9.249561234 E</td>
<td>474.7037</td>
</tr>
<tr>
<td>3</td>
<td>47.156894112 N</td>
<td>9.249561234 E</td>
<td>474.7037</td>
</tr>
<tr>
<td>4</td>
<td>47.156894112 S</td>
<td>9.249561234 W</td>
<td>474.7037</td>
</tr>
</tbody>
</table>

or

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>47.156894112</td>
<td>-9.249561234</td>
<td>474.7037</td>
</tr>
<tr>
<td>2</td>
<td>-47.156894112</td>
<td>9.249561234</td>
<td>474.7037</td>
</tr>
<tr>
<td>3</td>
<td>47.156894112</td>
<td>9.249561234</td>
<td>474.7037</td>
</tr>
<tr>
<td>4</td>
<td>-47.156894112</td>
<td>-9.249561234</td>
<td>474.7037</td>
</tr>
</tbody>
</table>

with the "-" sign indicating West and South.

**DD MM SS**

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>47 24 31.72146 N</td>
<td>9 37 05.02956 W</td>
<td>474.7037</td>
</tr>
<tr>
<td>2</td>
<td>47 24 31.72146 S</td>
<td>9 37 05.02956 E</td>
<td>474.7037</td>
</tr>
<tr>
<td>3</td>
<td>47 24 31.72146 N</td>
<td>9 37 05.02956 E</td>
<td>474.7037</td>
</tr>
<tr>
<td>4</td>
<td>47 24 31.72146 S</td>
<td>9 37 05.02956 W</td>
<td>474.7037</td>
</tr>
</tbody>
</table>

or

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>47 24 31.72146</td>
<td>-9 37 05.02956</td>
<td>474.7037</td>
</tr>
<tr>
<td>2</td>
<td>-47 24 31.72146</td>
<td>9 37 05.02956</td>
<td>474.7037</td>
</tr>
<tr>
<td>3</td>
<td>47 24 31.72146</td>
<td>9 37 05.02956</td>
<td>474.7037</td>
</tr>
<tr>
<td>4</td>
<td>-47 24 31.72146</td>
<td>-9 37 05.02956</td>
<td>474.7037</td>
</tr>
</tbody>
</table>

with the "-" sign indicating West and South.

**DD.MMSS**

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>47.243172146 N</td>
<td>9.370502956 W</td>
<td>474.7037</td>
</tr>
<tr>
<td>2</td>
<td>47.243172146 S</td>
<td>9.370502956 E</td>
<td>474.7037</td>
</tr>
<tr>
<td>3</td>
<td>47.243172146 N</td>
<td>9.370502956 E</td>
<td>474.7037</td>
</tr>
<tr>
<td>4</td>
<td>47.243172146 S</td>
<td>9.370502956 W</td>
<td>474.7037</td>
</tr>
</tbody>
</table>

or

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>47.243172146</td>
<td>-9.370502956</td>
<td>474.7037</td>
</tr>
<tr>
<td>2</td>
<td>-47.243172146</td>
<td>9.370502956</td>
<td>474.7037</td>
</tr>
<tr>
<td>3</td>
<td>47.243172146</td>
<td>9.370502956</td>
<td>474.7037</td>
</tr>
<tr>
<td>4</td>
<td>-47.243172146</td>
<td>-9.370502956</td>
<td>474.7037</td>
</tr>
</tbody>
</table>

with the "-" sign indicating West and South.

---

**4.1.7.3 Importing SKI ASCII files**

The Data Modules
Importing SKI ASCII files

When you want to import post-processed GNSS baselines as observations into Leica Infinity, for example as input to an adjustments computation, then you can do so via the SKI ASCII Import.

SKI ASCII files are written in a specific ASCII format to exchange information on baseline vectors.

**In the Import dialog:**
1. Select SKI ASCII files (*.asc) as **file type**.
2. Browse to the location where the SKI ASCII file is stored and select the file to be imported.
3. Press the **Import** button.

**In the Leica Infinity project:**
4. Select a **coordinate system** to be used for displaying the imported GNSS observations.

SKI ASCII files that contain baseline vector information always hold this information in WGS84. But Leica Infinity only displays data that is either stored as local grid or can be converted to local grid. Thus a coordinate system is needed to convert the GNSS observations to local grid and make them visible in the graphical view. On how to assign a coordinate system to a project see the topic on: Coordinate Systems

4.1.7.4 Import Aibot Data

**Importing Aibot Data**

To import Aibot data:
1. Select the .uav file in the import dialog:

![Image Import Dialogue]

2. Specify the exact path where the images can be found at **Image Location**.
3. Choose whether to import images or not. If the **Import Images** checkbox is not flagged, images will be linked to the project from the import folder.
4. Press the **Import** button.
Once the Aibot file is imported, a Points group, an Image group and a GNSS Tracks group are automatically created. The Image group holds the flight object and the images acquired during the flight.

Depending on the type of Aibot license, at import you can have:

- Autonomous flight (no GNSS correction received during the flight)
- RTK flight (GNSS correction are received during the flight to get very accurate image positions)

The default name of the image group is the name of the flight.

The position of the images is updated automatically with respect to the flight track. No additional synchronisation is required. If the position of the RTK base station is updated either by manually updating the station coordinates or by processing it from another reference station, then the flight track is automatically updated. Therefore also the position of the images is updated.

If GNSS raw data have been logged, they can be post-processed in Infinity using a reference station. Once the processing results are stored, the flight track is automatically updated. Therefore also the position of the images is updated.

Information about the flight can be found in the Flight Report as well as the Data Source Report.

To create a Flight Report:
1. Select the image group that contains the Aibot data.
2. Select Flight Report from Reports in the Home ribbon bar OR use the context menu.

The Flight Report includes information about:
- The flight: Start and end time and number of events
- The sensor: Model, serial number and firmware version
- The GNSS track: Start and end time, length, receiver name and serial number, sampling rate, etc
- The GNSS intervals and the reference station (if any)
- The image group: Number of images, size, sensor and camera model
- The interior orientation of the camera

The image data from Aibot can be processed using the Imaging Point Clouds module.

### Data Export

#### Data Export

From your current project either all data can be exported or just a selection of objects our sources. You can choose from different file formats. When you
To export data:

1. Press the Export button in the ribbon bar. If elements are selected either graphically or in the Navigator or in the Inspector choose between exporting All or Selection from the drop-down menu.
2. In the Export dialog:
   - Select the Destination where the exported data shall be stored to.
3. Give the file to be exported a Name without extension.
   - The file extension is given automatically according to the selected file type.
4. Select the Type of the file to be exported.
5. Choose whether a sub-directory shall be created. If you tick the checkbox a sub-directory of the same name as the file will be created and the file will be written to it.
6. Press the Export button.

Export Formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII</td>
<td>A template has to be defined. See also the topic on: Exporting ASCII files</td>
</tr>
<tr>
<td>SmartWorx DBX</td>
<td>You can export Points and/or Lines and Areas and/or Surfaces as DTM and/or Alignments and/or Infrastructure and/or GEM files. For Points select the Roles to be exported. Choose between: Highest to export only the highest role for each point All to export all available roles for each point Selection to export only the selected roles. For Lines/Areas the points that define the line/area are automatically exported, too. For Alignments, you can select the export To Road Job, To Rail Job or To Tunnel Job.</td>
</tr>
<tr>
<td>ESRI - SHP</td>
<td>You can export Points and/or Lines &amp; Areas. For Points and for Lines &amp; Areas you can select various Additional Attributes. You can select the Dimension: 2D or 3D.</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>All coordinate systems available with the current project will be exported and saved to the same TRFSET.DAT file. If you export to DBX, LandXML or HEXML always the Master coordinate system will be exported with your data. If None is used then your data will be exported without any coordinate system information.</td>
</tr>
</tbody>
</table>
**XML**  
Supported are HeXml and LandXml.

You have the option to use an **XSL Stylesheet** to format the output. You can use the same stylesheets as available with **SmartWorx Viva** or define your own.

<table>
<thead>
<tr>
<th>KML/KMZ</th>
<th>All library objects are exported except for cloud points.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Images - JPG, PNG, TIFF</td>
<td>Images are exported in JPG, PNG and TIFF format.</td>
</tr>
<tr>
<td>Georeferenced Images - JPG, PNG, TIFF, GeoTIFF</td>
<td>Georeferenced images can be exported in JPG, PNG and TIFF format with the respective world file (JGW, PGW, TFW), and in GeoTIFF format. JPG and PNG format can be also used by onboard software.</td>
</tr>
<tr>
<td>Georeferenced DEM - TIFF, GeoTIFF</td>
<td>Surfaces are exported as raster in TIFF (with the respective TFW world file) and GeoTIFF format.</td>
</tr>
</tbody>
</table>
| GNSS raw data - RINEX | You can select the following **Export Settings:**  
**RINEX version**: Select whether you want to save files as Rinex files (version 2.11) or as Rinex files (version 3.02).  
**Separate files for different tracks**: Select the check-box if you wish to write a separate file for each track.  
The files are named according to the point ID, day of year and session number.  
**Satellite Systems**: Select the GNSS constellation to be exported. |
| Scan Data | Point Clouds can be exported to:  
*.e57  
*.las/ *.laz  
*.ply  
*.pts, which is an ASCII based format  
When exporting to *.las/ *.laz note that Leica Infinity does not support any classification of points. |
| AutoCAD | You can export your project data as well as BIM entities to *.dxf or *.dwg.  
There is no necessity to first create library objects from BIM entities. |
| Aibotix AiProFlight | Kinematic tracks can be exported for use onboard Aibotix AiProFlight devices. See also:  
Export to Aibotix AiProFlight |
| GeoMoS Now | For Points select the **Point Roles** to be exported.  
Choose between:  
**Highest** to export only the highest role for each point  
**All** to export all available roles for each point  
**Selection** to export only the selected roles. |

**Navigation features in the Export dialog**  
Two special folders support better navigation between locations:
• Under Recent the last used locations are listed.
• Under Favourites the locations are listed that you marked as a favourite by pressing the Set/Reset favourite folder button. Favourites can be removed from the list by selecting Remove from the context menu.

To Refresh the navigation pane, Rename or Delete a folder or to create a New Directory:
Right-click onto the folder and select the desired function from the context menu.

It is also possible to copy & paste a location. Double-click onto the breadcrumbs in the files pane to make the field become editable and copy the desired path to it.

4.1.8.2 Export ASCII Data

Exporting ASCII files
The ASCII Export allows you to extract point information from your project to an ASCII file. The export format has to be defined in a template. In the template you specify and store information like:

• a template name
• ASCII specific settings
• file content settings

To export data to an ASCII file:
1. Go to the Backstage and select Export from the menu on the left-hand side or go to the Home module and select Export from the ribbon bar.

In the Export dialog:
2. Select ASCII as the Type of source file to be exported.
3. Browse to a location where the exported file shall be written to (i.e. to the drive, folder).
4. Give the file a Name. You can choose a file extension from the drop-down list or give the name any file extension you want.
5. Choose whether a sub-directory shall be created. If you tick the checkbox a sub-directory of the same name as the file will be created and the file will be written to it.
6. Under Settings select an existing Template that fits the file format or select New... to define a new one. Confirm a newly defined template with OK.
7. Press the Export button.

Defining a new ASCII Export template
Settings:

- Select to Export Column Headers if desired.
- Select the Column Separator to be used in the exported ASCII file.
- Select the Point Roles to be exported. Choose between Highest to export only the highest role for each point, All to export all available roles for each point or Selection to export only the selected roles.
- Select the type of Coordinates to be exported. Only available coordinates or coordinates that can be derived from a transformation calculation will be exported.
- Select the Height Mode to be exported. Only the available height mode will be exported or the geoid separations have to be known.
- Set the Units for exported distances.
- If you intend to export Geodetic coordinates, identify the Coordinate Format. See below for further information.
- Choose the precision for Rounding.
- Select whether the exported data shall be sorted by Point Id, Date/Time or Feature.

Sort by Feature: It is possible to export ASCII data sorted by Feature to better support moving field collected data to third-party software.

If you select Sort by Date/Time, you can activate Export Free Codes by clicking the checkbox.

Free Codes are purely time-related information. They are recorded in between of measurements in the field. A time stamp is recorded with each Free Code allowing to export points and free codes in a chronological order to be used for third-party mapping software.

- Select the File Extension to specify the file type of the export file.
Special Code:

Define the output for the **Code Expression**, that sets how the code, attribute, code information and feature name is written in the ASCII export, including the **Field Separator**.

<table>
<thead>
<tr>
<th>Special Code</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Code Expression</td>
<td>[M][L]</td>
</tr>
<tr>
<td>Field Separator</td>
<td></td>
</tr>
</tbody>
</table>

To define the **Code Expression**, do the following:

1. In the **Export ASCII Template Editor**, select **Sort by Feature**.
2. In the **Code Expression** field, click the ![Edit icon](Image) to open the **Edit Code Expression** dialog.
3. In the **Edit Code Expression** dialog, define the code expression by selecting or entering the patterns to be part of the export.

☞ You can write special characters in between patterns, for example `[C]/[N]*[L]*[V1]`, then they get exported in all cases. You can write ONE special character BEFORE or AFTER the pattern, then the special character only gets exported, if the pattern itself exists, for example `*[C]/[N]*/[L]*/[V1]`.

**Attributes:**

- Select the Attribute and Value Separators that shall be used in the ASCII file.
- A preview shows you how the attribute column(s) will be structured in the ASCII file based upon your settings.

**Preview:**

- The Preview shows you how the data will be written to the ASCII file. Select the columns to be exported. Un-checked columns will not be exported.
  - Only data that is available according to the given ASCII Settings will be available for selection.
  - To change the sequence of columns in the ASCII file, shift them (by clicking and dragging them) in the Preview.
Geodetic Coordinate Formats
If you intend to export Geodetic coordinates to a text file, the coordinates can be exported in one of the following formats:

**DD.DDDD**

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>47.156894112</td>
<td>-9.249561234</td>
<td>474.7037</td>
</tr>
<tr>
<td>2</td>
<td>-47.156894112</td>
<td>9.249561234</td>
<td>474.7037</td>
</tr>
<tr>
<td>3</td>
<td>47.156894112</td>
<td>-9.249561234</td>
<td>474.7037</td>
</tr>
<tr>
<td>4</td>
<td>-47.156894112</td>
<td>9.249561234</td>
<td>474.7037</td>
</tr>
</tbody>
</table>

with the "-" sign indicating West and South.

**DD MM SS**

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>47 24 31.72146 N</td>
<td>9 37 05.02956 W</td>
<td>474.7037</td>
</tr>
<tr>
<td>2</td>
<td>47 24 31.72146 S</td>
<td>9 37 05.02956 E</td>
<td>474.7037</td>
</tr>
<tr>
<td>3</td>
<td>47 24 31.72146 N</td>
<td>9 37 05.02956 E</td>
<td>474.7037</td>
</tr>
<tr>
<td>4</td>
<td>47 24 31.72146 S</td>
<td>9 37 05.02956 W</td>
<td>474.7037</td>
</tr>
</tbody>
</table>

with the "-" sign indicating West and South.

**DD.MMSS**

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>47.243172146</td>
<td>-9.370502956</td>
<td>474.7037</td>
</tr>
<tr>
<td>2</td>
<td>-47.243172146</td>
<td>9.370502956</td>
<td>474.7037</td>
</tr>
<tr>
<td>3</td>
<td>47.243172146</td>
<td>-9.370502956</td>
<td>474.7037</td>
</tr>
<tr>
<td>4</td>
<td>-47.243172146</td>
<td>9.370502956</td>
<td>474.7037</td>
</tr>
</tbody>
</table>

with the "-" sign indicating West and South.

---

4.1.8.3 Export to Aibotix AiProFlight

UAV data coming from the Aibot can be processed by Leica Infinity. Process the track and then export an updated coordinate file that will be used to update the geotags of the images in the AiProFlight software.

**In Infinity:**

1. Select the track from the [Graphical view](#).
2. Select **Export to Aibotix AiProFlight** from the context menu.

![Image of Graphical view with Export to Aibotix AiProFlight option highlighted]

3. In the **Export dialog**, enter all necessary information.
4. Click **Export** to create a txt file which can be used in AiProFlight.

**In AiProFLight:**
1. Go to **Log Manager** tab.
2. Right click on the white tab and select **Import Log File**.
3. Select your log file. The log file is provided to you together with the flight data and the photos.

4. Select the imported log file. Right click and select **Geotag the selected log**.

5. A question might pop up in case the log file contains high precision GPS data:

   ![Image of the question dialog](image)

   **Question**
   
   High precision GPS Data available - would you like to use them?
   
   ![Yes and No buttons](image)

6. Select **Yes** to continue using high precision GPS data.
7. In the **Photo Selection** tab, select the folder that contains the photos of the specific flight. Import your photos.
8. In the **Coordinates** tab, import the output file from Infinity.

<table>
<thead>
<tr>
<th>Time</th>
<th>Date</th>
<th>Latitude</th>
<th>Longitude</th>
<th>Altitude</th>
<th>Accuracy</th>
</tr>
</thead>
<tbody>
<tr>
<td>9:00:00:00</td>
<td>04/02/2016</td>
<td>51.273048277</td>
<td>247.653</td>
<td>0.037</td>
<td></td>
</tr>
<tr>
<td>9:00:01:00</td>
<td>04/02/2016</td>
<td>51.273048407</td>
<td>247.653</td>
<td>0.038</td>
<td></td>
</tr>
<tr>
<td>9:00:02:00</td>
<td>04/02/2016</td>
<td>51.273048607</td>
<td>247.653</td>
<td>0.039</td>
<td></td>
</tr>
<tr>
<td>9:00:03:00</td>
<td>04/02/2016</td>
<td>51.273048807</td>
<td>247.653</td>
<td>0.040</td>
<td></td>
</tr>
<tr>
<td>9:00:04:00</td>
<td>04/02/2016</td>
<td>51.273049007</td>
<td>247.653</td>
<td>0.041</td>
<td></td>
</tr>
<tr>
<td>9:00:05:00</td>
<td>04/02/2016</td>
<td>51.273049207</td>
<td>247.653</td>
<td>0.042</td>
<td></td>
</tr>
<tr>
<td>9:00:06:00</td>
<td>04/02/2016</td>
<td>51.273049407</td>
<td>247.653</td>
<td>0.043</td>
<td></td>
</tr>
<tr>
<td>9:00:07:00</td>
<td>04/02/2016</td>
<td>51.273049607</td>
<td>247.653</td>
<td>0.044</td>
<td></td>
</tr>
</tbody>
</table>

9. Once the file is imported, activate **Use Coordinates from file**.

10. On how to update the image geotags and the steps that are necessary to do so, please, refer to the Aibot Help.

### 4.1.8.4 Export to Leica ConX

**Export to Leica ConX**

To export data to an iCON project:

1. In the Leica Infinity project select the data, for example the centre-line of a road, that shall be assigned to the iCON project.
2. Click on Export > Selection in the Home ribbon bar.
3. In the Export dialog click on Leica ConX in the tree view. A connection to the server will be established. Optionally select a unit.

File format HeXML will be chosen automatically. The file name will by default be taken from Leica Infinity project. You can give it a more useful name if you want.

4. Click on Export. The HeXML file will be written to the iCON project on the server and to the unit, if selected.

5. See the data being assigned to the iCON project in the Leica ConX project view. On how to open the Leica ConX project view see: The Leica ConX Service

The exported file will also be written to the Leica Infinity Archive under Exported Files.

4.1.9 Georeference Image

4.1.9.1 Overview

Georeference Image  Infinity supports the display of Georeferenced images. Using these images is a nice way to help visualize, reference and relate your project data.
Georeferenced images are shown as objects in the Library and can be set to visible or not visible. It's possible to use many Georeferenced images. An existing georeferenced image can be edited and updated with a new transformation.

Georeferenced Images are Global objects. You will find them from the Backstage, under Tools menu, the Georeferenced Images list.

Import
Images can be imported from PNG or JPG format to the project.
When the images include a matching world file PNG+PNW or JPG+JPW, then they are imported and translated as a Georeferenced image.
Otherwise it is possible to reference these images using the Georeference Image Wizard inside the project or from the Tools menu in the Backstage.

1. Locate the image(s) from the disk to import.
2. Define the Import Settings unit for the file(s).
3. Press Import.

Note: Georeferenced images from a project can be exported to be used in other projects.
From the properties, press the Export to Global button.

Export
Georeferenced images can be exported in JPG format with the matching JPW world file.
1. Select the image to export.
2. Choose Georeference Image.
3. Edit the suggested file name.
4. Define the world file units.
5. Navigate to the desired export location.
6. Press Export.

4.1.9.2 Georeference Image Properties

<table>
<thead>
<tr>
<th>Georeference Image Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Georeferenced image properties you can:</td>
</tr>
<tr>
<td>• change the name</td>
</tr>
<tr>
<td>• add a description</td>
</tr>
<tr>
<td>• view if the image has been linked to a project feature</td>
</tr>
<tr>
<td>• view the Transformation information</td>
</tr>
</tbody>
</table>

4.1.9.3 Georeference Image: Select Points

<table>
<thead>
<tr>
<th>Georeference Image: Select Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>To open the Georeference Image Wizard, select an image and:</td>
</tr>
<tr>
<td>• Select Georeference Image Context menu</td>
</tr>
<tr>
<td>• From the ribbon bar select Georeference Image icon</td>
</tr>
</tbody>
</table>
To Georeference an image ground control points are required. These points need to be in an Infinity project.

Note: Only points in Local Grid coordinate values will be shown as Available.

The first step of georeferencing an image is to select the **Ground Control Points** that will be used to mark on the image.

1. Select the project where the image control points are to be selected.
2. Choose the points to move to the Ground Control Points list by pressing ➡️ or 🔄 to select all points.
3. Press **Next** to continue to Match Points.

---

**4.1.9.4 Georeference Image: Match Points**

Next step is to **Match Points** from the list to the image.

There are two ways to define the picture pixel and the ground control point:

**Method 1**

Selecting the points manually from the list:

1. Select the point from the **Points** list
2. With the mouse navigate to the location in the image and with the left mouse click define this point position
3. Select a second point from the list
4. With the mouse navigate to the location in the image and with the left mouse click define this point position
5. Repeat until you have computed the residuals and you accept the results

**Method 2**

Place the mouse over the pixel of the image and with the right click select from the list the point to mark at this position.

1. With the mouse navigate to the location in the image to where the point should be marked
2. Right click with the mouse and from the context menu select the point that defines the pixel
3. Repeat until you have computed the residuals and you accept the results

Press Finish to complete the Georeference wizard.

The image will be stored in the **Inspector** and in the **Navigator**.

---

**4.1.10 COGO Calculations**

**4.1.10.1 Measure Point to Point**

Measure Point to Point is a COGO function and can be used to determine horizontal and vertical angle differences as well as horizontal and slope distance differences between two points in your project. The coordinate differences in Easting, Northing and Height will also be computed and displayed in the **Measure: Point to Point** window.

**To start the Measure Point to Point function:**

Press the **Measure Point to Point** button in the **Home** ribbon bar to open the **Measure: Point to Point** window and switch to the **Measure Point to Point** COGO mode.
The cursor changes to [Image] and you will be able to pick start and end point(s) graphically.

**Overall behaviour**
Apart from the changed appearance of the cursor in the Graphical view, a green line indicates that you are in the Measure Point to Point mode once you have selected a start point. When you press the Cancel button in the right bottom corner of the window:
- the cursor returns to its standard appearance
- the green line disappears
- the Cancel button becomes a Measure button

You can leave the Measure Point to Point window open next to the Properties window and by pressing the Measure button, you can always pick up the COGO calculation again. By default, the Measure Point to Point window is docked to the Properties window and opened in its own tab. When you close the Measure Point to Point window, the Properties window remains.

**Input options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td></td>
<td>There are two input modes of determining angles and distances between two points. You can switch the mode without having to re-invoke the function.</td>
</tr>
</tbody>
</table>
| Radial  |        | In the Radial mode you can select a central point from which angles and distances to other points shall be determined in a star-like manner around the selected point. Press the Finish button to:  
• complete a measuring loop  
• stop the COGO function  
• return to the standard mode |
| Sequential |        | In the Sequential mode you can select a start point and an end point for your calculations and after that another start and another end point. Press the Finish button in the right bottom corner of the window to:  
• stop the COGO function  
• return to the standard mode  
☞ In the Sequential mode a measuring loop is automatically finished when the end point has been selected. In the Radial mode the measuring loop will be kept open (graphically this is visualized by the green line sticking to the cursor) until you manually select to finish it. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distance type</td>
<td>The type of distances displayed in the results.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Grid</td>
<td>Distances are calculated as the trigonometric distance between the position of two points. The distance field is <strong>Horizontal distance</strong>.</td>
</tr>
<tr>
<td></td>
<td>Ground</td>
<td>Distances are horizontal distances between two points at the mean elevation parallel to the ellipsoid of the active coordinate system. The distance field is <strong>Horizontal distance (ground)</strong>.</td>
</tr>
<tr>
<td></td>
<td>Ellipsoid</td>
<td>Distances are reduced to the ellipsoid. They are calculated as the shortest distance between the two points on the ellipsoid. A scale factor is applied. The distance field is <strong>Horizontal distance (ellipsoid)</strong>.</td>
</tr>
</tbody>
</table>

☞ In the attached coordinate system, a projection, an ellipsoid and a transformation have to be defined to calculate grid, ground and ellipsoid coordinates.

How to measure Point to Point?

When you are in the **Measure Point to Point** mode and the cursor appears as

1. In the Graphical View, click on the start point from which you want to determine angles and distances to one or more end points. The Point Id will automatically be entered into the **1st Point** field at the top of the window.

2. Click on the **end** point. The Point ID will automatically be entered into the **2nd Point** field at the top of the window.

☞ If there exists more than one point role for the selected points, pick the required one from the point selection menu that automatically appears if for a point more than one point role is available.

☞ Click the **button in the 1st Point/2nd Point** fields to select the start and end points for the calculation non-graphically from a flyout.
3. Inspect the results in the **Measure: Point to Point** window. The Results are listed one below the other. Each Results section can be collapsed or closed individually.

### Create a report

You can create a report of the measured points by clicking the **Report** button at the bottom of the **Measure Point to Point** window.

The **Report Manager** opens and shows the generated report.

---

#### 4.1.10.2 Compute Point

**Compute Point**

Compute Point is one of the Cogo functions and can be used:

- to determine point positions relative to existing geometry objects, like base points and offset points
- to determine point positions by intersection or segmentation of existing geometry objects
- to determine point positions by defining a direction and distance from a known point

The following methods are supported:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Method</th>
<th>Illustration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Bearing Bearing" /></td>
<td>Bearing Bearing</td>
<td><img src="image2" alt="Illustration" /></td>
<td>Calculates the intersection point between two selected points using defined bearings.</td>
</tr>
<tr>
<td><img src="image3" alt="Bearing Distance" /></td>
<td>Bearing Distance</td>
<td><img src="image4" alt="Illustration" /></td>
<td>Calculates the intersection points between two selected points using a defined bearing from one point and a defined distance from the other.</td>
</tr>
<tr>
<td><img src="image5" alt="Distance Distance" /></td>
<td>Distance Distance</td>
<td><img src="image6" alt="Illustration" /></td>
<td>Calculates the intersection points between two selected points using defined distances.</td>
</tr>
<tr>
<td><img src="image7" alt="Point in Direction" /></td>
<td>Point in Direction</td>
<td><img src="image8" alt="Illustration" /></td>
<td>Calculates a point using a defined direction and distance from a known point.</td>
</tr>
<tr>
<td>Icon</td>
<td>Method</td>
<td>Illustration</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Two Observations</td>
<td><img src="image2.png" alt="Illustration" /></td>
<td>Calculates the intersection point between two selected TPS observations.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Line Base Point</td>
<td><img src="image4.png" alt="Illustration" /></td>
<td>Calculates the position of a base point on a defined line where the offset to a defined point is perpendicular to the line.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>Line Intersection</td>
<td><img src="image6.png" alt="Illustration" /></td>
<td>Calculates the intersection point between two defined lines.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon" /></td>
<td>Line Offset Point</td>
<td><img src="image8.png" alt="Illustration" /></td>
<td>Calculates the position of an offset point using an entered distance along and a perpendicular offset from a defined line.</td>
</tr>
<tr>
<td><img src="image9.png" alt="Icon" /></td>
<td>Line Segmentation</td>
<td><img src="image10.png" alt="Illustration" /></td>
<td>Splits a line into multiple segments. The segment length is derived from either a given number of segments or a specified segment length.</td>
</tr>
<tr>
<td><img src="image11.png" alt="Icon" /></td>
<td>Arc Base Point</td>
<td><img src="image12.png" alt="Illustration" /></td>
<td>Calculates the position of a base point on a defined arc where the offset to a defined point is perpendicular to the arc.</td>
</tr>
<tr>
<td>Icon</td>
<td>Method</td>
<td>Illustration</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Arc Offset Point" /></td>
<td>Arc Offset Point</td>
<td>Calculates the position of an offset point using an entered distance along and a perpendicular offset from a defined arc.</td>
<td></td>
</tr>
<tr>
<td><img src="image2.png" alt="Arc Segmentation" /></td>
<td>Arc Segmentation</td>
<td>Splits an arc into multiple segments. The segment length is derived from either a required number of segments or a specified segment length.</td>
<td></td>
</tr>
</tbody>
</table>

How to compute points in Leica Infinity?

To compute points in Leica Infinity:

1. Go to COGO > Compute Point in the Home ribbon bar and select a method from the drop-down menu. The "Compute Point" Property Grid opens up next to the regular Property Grid.
   - You can still change the method here.
   - For some methods, it is necessary to select how the geometry shall be defined. Select a Definition/Mode from the drop-down box.

2. Select the points and/or observations based on which the computation shall be performed. You can only select existing Leica Infinity objects as input to the computation. Objects can also be selected graphically in the graphical View. To select observations, TPS Observations have to visible in the graphical View. See also: Layer Manager
   - If you cancel the operation or if you have already run a computation and want to run another, then press Measure at the bottom of the Property Grid to activate point selection again in the graphical View.

3. Depending on the calculation method, you may need or want to define azimuths, distances or offsets. Enter the values or press the icon to calculate the values.
   - For methods "Bearing Bearing", "Bearing Distance" and "Distance Distance" the values can also be derived from selecting points graphically for computation.
4. Select the Height at which the computed points shall be calculated. You have the choice between:
   
   **None**
   
   No height will be computed.
   
   **Max**
   
   The point will be computed at the same height as the point with the maximum height, that has been used for computation.
   
   **Min**
   
   The point will be computed at the same height as the point with the minimum height, that has been used for computation.
   
   **Average**
   
   The point will be computed at an average height of all points that have been used for computation.
   
5. Check the box for **Show report**, when you need a report of the COGO computation.
   
6. The Result of the computation will be shown in the Property Grid once all necessary input is available. In the Results panel you can change the Point Role and Coding information of the computed point.
   
   ☞ If more than one point results from the computation (for example in the case of “Distance Distance” computations) select which of the points shall be saved.
   
7. Press Create to save the computed points as objects to the project database. If selected before, the COGO report will open automatically.
8. Computed COGO points are selectable. A flyout displays the method and values used to compute the COGO point. In the properties, click the \( \text{3} \) in Local Position.

4.1.10.3 GNSS Hidden Points

**GNSS Hidden Points**

Hidden Points are points that cannot be directly accessed with the GS. For instance, if a point physically cannot be reached or because no satellites can be tracked in the point to be measured due to obstructions.

The hidden points can be measured in the field using Leica Captivate, Leica SmartWorx or Leica Viva.

Infinity supports importing, editing and updating these points.

The lines between the points which are used for the calculation are visualised on the Hidden Point Survey layer.

**Importing GNSS Hidden Points**

The following methods are supported:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Method</th>
<th>Illustration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Bearing Icon" /></td>
<td>Bearing Bearing</td>
<td><img src="image" alt="Bearing Illustration" /></td>
<td>Calculates the intersection point between two selected points using defined bearings.</td>
</tr>
<tr>
<td>Icon</td>
<td>Method</td>
<td>Illustration</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>------------------------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Distance Distance Icon" /></td>
<td>Distance Distance</td>
<td><img src="image" alt="Distance Distance Illustration" /></td>
<td>Calculates the intersection points between two selected points using defined distances.</td>
</tr>
<tr>
<td><img src="image" alt="Point in Direction Icon" /></td>
<td>Point in Direction</td>
<td><img src="image" alt="Point in Direction Illustration" /></td>
<td>Calculates a point using a defined direction and distance from a known point.</td>
</tr>
<tr>
<td><img src="image" alt="Line Offset Point Icon" /></td>
<td>Line Offset Point</td>
<td><img src="image" alt="Line Offset Point Illustration" /></td>
<td>Calculates the position of an offset point using an entered distance along and a perpendicular offset from a defined line.</td>
</tr>
</tbody>
</table>

Hidden points are included in the COGO report and in the Data Source report.

**Editing GNSS Hidden Points**

1. Select a computed hidden point.
2. In **Local Position**, select 🖋️.
   
   A flyout displays the method and values used to compute the point.
   
   The parameters available in the flyout are the same available in the COGO report for that specific point.

3. Change the values.

   New coordinates of the hidden point are computed as soon as some values are changed. The new coordinates are shown in the flyout.
4. Press OK.
☞ The Property Grid is updated and new coordinates are stored.

Updating GNSS Hidden Points
The coordinates of a hidden point are automatically re-computed when the coordinates of a point which has been previously used in hidden point measurements are changed.

4.1.10.4 Shift, Rotate, Scale
Shift, Rotate, Scale is a COGO function and can be used to match a set of preliminary points with a set of Control points.

You can also shift, rotate, scale entities coming from a BIM file
☞ All BIM entities contained in a file will be transformed even if only a single element has been selected.
The BIM entities used as common points, must be copied to the Leica Infinity library first. This can be done by using New Point option or Copy from CAD.
See also:
How to create new points from CAD entities?
How to Copy from CAD?

To start the Shift, Rotate, Scale wizard:
1. Select the entity to be transformed in the graphical view or in the Inspector.
   Setups can also be selected in the Source section of the Navigator.
2. Go to the Home ribbon and press Shift, Rotate, Scale in the COGO group.

In the Shift Rotate Scale Wizard:
1. Select the method.
   You can enter the parameters for shift, rotation and scale manually or make Leica Infinity compute them using common points.

When you choose 'Enter manually or compute separately' you will have to:
2. Enter the Shift in Easting, Northing and Height. Press the button to compute the shift:
   Under 'From' select a point in the preliminary system. Under 'To' select the Control point in the target system.
3. Enter the Rotation angle. Press the button to compute the rotation angle.
   Under 'From' select a pair of points in the preliminary system. Under 'To' select the same pair of Control points in the target system.
   Press the to select a point as the origin for the rotation. This can be either in the preliminary system or in the target system.
4. Enter the Scale Factor. Press the button to compute the scale using points or known distances. Under 'From' select a pair of points in the preliminary system. Under 'To' select the same pair of Control points in the target system.

5. Press Next to inspect the results.

6. Press Finish to perform the operation.

When you choose the transformation parameters will be computed automatically in the background using the common point.

2. Select whether you want to compute a Rotation and a Scale using common points or None.

3. Press Next to match points.

4. Under System A select the preliminary measured points. Under System B select the corresponding control points.

5. Press to match the pair of points. It will be listed in the view below.

☞ If you match two pairs of points height residuals are calculated. If you match three or more pairs residuals are calculated for position and height. Errors are distributed.

☞ To delete a mismatched pair press:

6. Press Next to inspect the results.

7. Press Finish to perform the operation.

By default, a report will be run and opened when you press Finish. You can Save and/or Print the report from within the report window.

Saved reports are written as PDFs to the Archive. You can re-open them from there.

☞ Unsaved Shift, Rotate, Scale reports are lost when you close them.

4.2 Processing

4.2.1 TPS-Processing

4.2.1.1 Overview

TPS-Processing The Processing Module allows you to:

Create **new points**. New points can also be created in the Home module.

Create a **new station** on any point in your project. New stations can also be created in the Home module. Stations for which new observations have been entered will be identified as Setups in the TPS tab of the Inspector.

Create **new observations** on any station in your project. New observations can also be created in the Home module.

Create **new traverses**. Only Setups can serve as points in a traverse.
Create **new sets of angles** on any setup in the project.

You can also:
- edit Setups, see also: Edit Setup Wizard
- edit Traverses, see also: Sets of Angles Wizard
- edit Sets of Angles, see also: Traverse wizard

from inside the **TPS** tab in the Inspector.

### 4.2.1.2 New Point

In Leica Infinity you can also create Points **manually**. By default, manually created points get the point role **User-entered**.

**Creating points**

1. Press the New Point button in the ribbon bar of the Home module or the TPS-Processing module.
2. New points have to be defined in the **Point Properties** window. Enter an **Id for the new point**.
3. Choose whether the new point shall get the **Point Role User-entered** or whether it shall become a **Control point**.
   
   You can always create **Control points** from existing points from inside the **Point Properties**, too, by pressing the Create Control button next to the current point role.
4. Enter coordinates either **Local** or **WGS84**. If you have a coordinate system attached to the project, then the coordinates will automatically be available in both systems.
5. Optionally, enter the **Local Position Quality** and select a **Code**. Codes can only be selected if a Code Table is defined within or has been assigned to the project before.
6. Press the **Create** button to create the point.

The new point will automatically be added to the Survey Layer **Points**. See also:

Layer Manager

### 4.2.1.3 New Station, New Observation

In Leica Infinity you can also create stations manually. When you define **Observations** on a manually created station, the station will become a **Setup with orientation Unknown**.
Creating a TPS Station

1. Press the **New Station** button in the ribbon bar of the Home module or the TPS-Processing module.
2. The new station has to be defined in the Property Grid: in the **Station** section select the **Position Source**. Press the icon on the right to search for and select a point from the fly-out list.
3. Optionally, change the **coordinates** and/ or attach a **code**.
4. Press the **Create** button to create the station.

When you create a new station its **orientation** is *unknown*. It does not have any observations attached to it yet.

**The new, manually entered station will be added to:**
- the **Points** section in the Navigator > Library.
- the **Points** section of the Inspector > Points, Lines & Areas tab.

Creating observations on a new, manually entered station

1. Press the **New observation** button in the ribbon bar of the Home module or the TPS Processing module.
2. New observations have to be defined in the Property Grid: enter an **Id for the new point** that is about to be defined by the new observation.
3. Select the **Station Id from** which the new observation aims at the new point. Press the icon on the right to search for and select a station from the fly-out list.
4. Enter the observation details: horizontal angle (Hz raw), vertical angle (V), slope distance (SD) as well as the target height and type. Optionally, you can also enter offsets, if necessary, atmospheric and geometric corrections (ppm values) and codes.
5. Press the **Create** button to create the observation.
6. Repeat steps 1 to 5 till you have entered all observations for a station.

**Results:**
You will see that:
- with creating the first observation on a newly defined station its point role changes to be a **TPS Setup** with a still **unknown** orientation.

**The new, manually created Setup will be added to:**
- the Navigator as **Manually entered** in the **Source** section.
- the Inspector as a **Setup** in the **TPS** tab.

---

**4.2.1.4 Observation Properties**

**Observation Properties**

In the Property Grid you can change the properties for single observations. You can:
• edit the Target Point Id
• Press the button and select a different Station Id
• edit the Target Height and select a different Target Type
• edit the Target Offsets
• press the button to re-calculate the Atmospheric and/or Geometric PPM
• select a different Target Point Code from the drop-down list
• set how the Local Position Quality shall be defined (choose between Standard Deviations and Coordinate Quality)

☞ To re-calculate a Setup with another orientation method and using different setup observations make use of the Edit Setup Wizard. To invoke the wizard from inside the Properties window press the Open Setup Wizard button in the Orientation section.

Multi-edit
To edit the properties for one or more observations:
1. Select the observations to be edited either from inside the Source section of the Navigator or from inside the TPS tab or the Adjustments tab of the Inspector.
   In the TPS tab of the Inspector drill into Setups by clicking the little arrow . Drill further into a Station to see all connected observations and select the observations to be edited.
   In the Adjustments tab of the Inspector go to the Observations section and select the observations to be edited.
2. Right-click into the selection and select the Edit operation you want to perform from the context menu.

You can select more than one observation at a time. The Edit operation will be executed for all selected observations/ target points.

4.2.1.5 Setup Properties

Some Setup properties can be edited in the Property Grid.

Depending on the setup method you can:
1. press the button and select a different Station Source
2. edit the Instrument Height
3. edit the Station Coordinates
4. edit or press the button to compute an Azimuth
5. press the button and select a different Target Point
6. edit the Target Height
7. If a Station Scale has been applied, press the button to remove the Station Scale from all observations to which it has been applied before

☞ To re-calculate the Setup with another orientation method and using different setup observations make use of the Edit Setup Wizard. To invoke the wizard from inside the Properties window press the Open Setup Wizard button in the Orientation section.
When TPS Setups are **edited** in Leica Infinity then all scan data connected to that setup will be shifted and/or rotated accordingly.

## 4.2.1.6 Setup methods

<table>
<thead>
<tr>
<th>Setup methods</th>
<th>There are several methods how a setup can be calculated. These are:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Set Orientation:</strong></td>
<td>Instrument was set up on a known point and oriented to a known azimuth.</td>
</tr>
<tr>
<td><strong>Known Backsight:</strong></td>
<td>Instrument was set up on a known point and oriented to a known backsight point.</td>
</tr>
<tr>
<td><strong>Reection/ Resection Helmert:</strong></td>
<td>Instrument was set up on an unknown point. Station coordinates and the orientation were calculated by measuring to known target points.</td>
</tr>
</tbody>
</table>
Multiple Backsights:
Instrument was set up on a known point. The Orientation and/or height were calculated by measuring to known target points.

Local Resection:
Station coordinates and Orientation were derived from measuring to two points which define a local coordinate system.

Height Transfer:
Instrument was set up on a known point. The height was calculated by measuring to known target points.

4.2.1.7 Edit Station Setup

4.2.1.7.1 Overview
The Edit Setup Wizard allows you to recalculate setups defined in a project. It automatically detects the setup method that has been used in the field and suggests a Station Point Source.

See also:
Setup methods

To edit setups:
Select the setup to be edited either from the Source section of the Navigator or from inside the TPS tab of the Inspector.
In the Navigator, right-click on the setup to be edited and select Open Setup Wizard... from the context menu.
In the Inspector, drill down into the Setup Applications, select the setup to be edited and press the icon.

Once selected you can also press the Open Setup Wizard button in the Orientation section of the Setup Property Grid.

The Edit Setup Wizard starts with:

Edit Setup Wizard: Station and Method.

Refer to the tutorial “How to manage TPS setups and data edits”: https://leica-geosystems.com/-/media/6d5180b3d45d4102ace367b9dc6309ad.ashx

Tutorial data can be downloaded in the Localisation Tool.

4.2.1.7.2 Edit Setup Wizard: Station and Method

A common use for the Edit Setup wizard is to update station coordinates and/or the orientation.

1. Check whether the setup method itself can be left as set in the field data or whether it needs to be changed.
2. For Orientation methods that use a known station point, check the source of your station point.
3. Press the icon to select another station source from the flyout list and OK to confirm your selection.
4. Adapt the Instrument Height if necessary.
5. Press Next to proceed with:

Edit Setup Wizard: Setup Observations

Orientation methods using known station points are:

- Set Orientation
- Known/ Multiple Backsight(s)
- Height Transfer

Stations to be calculated in a Resection are always set up on unknown points. For Resections the Station ID can be changed but you cannot select a different station source. You can only choose to re-calculate the resection by using different target points in the next wizard step.

4.2.1.7.3 Edit Setup Wizard: Setup Observations
1. On the selected station point select the observations that shall be used for re-calculating the orientation.
   For method Set orientation:
   Select an observation that shall serve as the Known Orientation. All measurements on this station point will be re-calculated with reference to the selected orientation.
   For method Known/ Multiple Backsight:
   Select a point/ points that shall serve as a Known/ Multiple Backsight Point(s). The orientation to the selected point(s) will be taken for re-calculation.
   For method Resection/ Resection Helmert:
   Select the observations to points that shall serve as targets in the Resection calculation.
   For method Local Resection:
   Select the observations to two points that shall define the line to which your station shall be oriented.
   For method Height Transfer:
   Select the observation(s) to known target points from which the height shall be transferred to the Station point.

2. Press Next to proceed with:
   Edit Setup Wizard: Compute Setup

It is important to differentiate between the selection of target points and the selection of observations to the target points. The target points will be identified in step 3. In this step of the wizard (step 2) you choose the observation information. If there exists, for example resulting from a Sets of Angles calculation, more than one observation to a point, select only the one observation to be used. In the case of a Sets of Angles existing on a station point this would be the reduced measurement to the target point.
• the Adjustment Method: Least Squares or Robust
• whether Easting, Northing, Height and Orientation shall be calculated or just the position and the orientation or just the station coordinates.
• whether a Scale shall be computed

If you decide to compute the scale factor then you can decide further down under Station Point whether the scale shall be Applied to all observations that have possibly been measured on the station point of the resection.

☞ To remove the scale press the button under Station Scale in the Setup Properties window.

In the Station Point section you can review:
• the Azimuth calculated with respect to the chosen target point(s) and observation(s)
• the calculated Orientation correction
• the Station coordinates

For Resections the standard deviations for the Azimuth and the Station coordinates are given as well.

In the Tolerances section:
3. Define the limits for how much the measured target point position and height are allowed to differ from the target point position and height after re-calculation.
4. For Resections also define an orientation limit, i.e. a limit for how much the Hz observations to each target point are allowed to differ from the calculated values.
5. Decide whether you want to run a tolerances check for the position and/or height and/or orientation of the target points using the given limits.

When you decide to check whether the target points calculated from the re-computed station point lie within the defined tolerances you will see that outliers are marked by and the Δ values are written in red in the Target Info content view.

6. Exclude outliers from use in the setup computation by double-clicking slowly onto a target point’s Use field and selecting None or use just Position or just Height from the drop-down list. All computation results will be re-calculated and shown to you instantly.
7. Press Finish.

Before the computation results are taken over into your project you will get a warning message that the coordinates and orientation of the re-calculated setup will be changed by the given Δ values.
8. Press OK to update the setup in your project.
**Traverse wizard**

The Traverse Wizard allows you to build up a traverse from the setups defined in a project. You can also edit existing traverses. It automatically detects which setups are connected by back- and foresights and suggests a sequence once you have selected the start point.

It also detects the Traverse technique from the selected combination of setups and suggests the start and end point as well as the initial backsight and final foresight.

Not all kinds of traverses are defined by the classic setup of a start and an end point and an initial backsight and final foresight.

**To create a new traverse:**
Go to the Processing module and select New Traverse from the ribbon bar.

The New Traverse Wizard starts with:
Traverse Wizard: Extract Traverse
Go through the wizard to create a new traverse.

**To edit an existing traverse:**
Select the traverse to be edited either from the Library section of the Navigator or from inside the TPS tab of the Inspector.
In the Navigator, right-click on the traverse to be edited and select Open Traverse Wizard... from the context menu.
In the Inspector, drill down into the Traverse Applications, select the traverse to be edited and press the icon.
Once selected you can also press the Open Traverse Wizard button in the Results section of the Traverse Property Grid.

The Edit Traverse Wizard starts with:
Traverse Wizard: Extract Traverse
Go through the wizard to edit an existing traverse.

Refer to the tutorial "How to process a traverse":
https://leica-geosystems.com/-/media/d70cbaceb3ea49988bbdf75a92ac0ef3.ashx
Tutorial data can be downloaded in the Localisation Tool.
1. Identify the new traverse by a unique Id (name).

2. Choose the traverse start point from the available setups and add it to the new traverse. The next possible setups in the traverse will be detected automatically and suggested for selection.

3. If the next setup in the traverse can be identified uniquely just press add again to add the next point.
   If there is a choice select the next traverse point manually and press add.

4. Repeat step 3 until the traverse is complete.

5. Under Traverse Technique check that the start and end point coordinates are identified correctly. If Control coordinates are available these should be taken. If there is a choice for the initial backsight and/or the final foresight, then choose the correct coordinates to be used.

6. Optional: If reduced measurements are available for one or more of the traverse points from the Sets of Angles application and you want the reduced measurements to be taken for the traverse calculation then check this option at the bottom of the wizard page.

7. Press Next to proceed with:
   Traverse Wizard: Observation Review

---

4.2.1.8.3

Traverse Wizard: Observation Review

1. Review the angle observations and measured distances. If you decide to use tolerances outliers will be marked by:
   You can adjust the tolerances to your needs either for the current computation run in the same wizard page or globally under Info and Settings > Traverse Processing Parameters.
   See also:
   Traverse Processing Parameters

2. You can de-select single observations which you do not want to take part in the computation. But at least one backsight and one foresight observation must remain on each setup, otherwise the traverse gets broken up and cannot be calculated. The Next button becomes inactive.

3. Press Next to proceed with:
   Traverse Wizard: Processing Parameters

---

4.2.1.8.4

Traverse Wizard: Processing Parameters

Configure the traverse processing parameters for the current processing run.
   On how to configure the default parameters refer to the topic:
   Traverse Processing Parameters.
1. Select the **Method** by which the traverse shall be adjusted. By default the Compass Rule will be selected.

2. Define the **Standard Errors per Angle** and **Distance** that shall be used as the coefficients to calculate the Max. Angular and the Max. Length Errors. By default these values will be set to 15" and 0.01m.

3. Depending on the required level of accuracy adapt the **Min. 2D Accuracy**, i.e. the min. required position accuracy. By default this value is set to be 1/10‘000.

4. Define the **max. allowed Height Error per Traverse Point**. By default this value is set to be 0.01m.

5. Depending on the required level of accuracy adapt the **Min. 1D Accuracy**, i.e. the min. required height accuracy. By default this value is set to be 1/10‘000.

6. Define the **max. allowed Station Difference before and after Adjustment**. By default these values will be set to be 0.01m for Easting, Northing and Height.

7. Press **Next** to proceed with:
   Traverse Wizard: Calculate Traverse

   If you deselect any of the tolerance checks or the max. station difference check then these checks will not be applied in the traverse calculation. By default all checks will be switched on.

---

### 4.2.1.8.5 Traverse Wizard: Calculate Traverse

**Traverse Wizard: Calculate Traverse**

Before the traverse is calculated or re-calculated you will be shown its **Accuracy before Adjustment**.

You will see:

- its computed **Total Length**
- its computed **1D and 2D Accuracies**. If the tolerance values defined in step 3 are exceeded a warning ⌛ will be issued.
- its **Length** and **Direction of Error**. This corresponds to the vector resulting from the computed length and cross errors.
- its computed **Start Azimuth**. You can force a different value to be taken when you select **Use Start Azimuth** and enter a different azimuth value. By default this setting is switched off.
- its computed **Scale**.
- its computed **Coordinate Misclosures**. In the components where the **max. allowed Station Differences** as defined in Step 3 are exceeded a warning ⌛ will be issued.
- its computed **End Azimuth**. You can force a different value to be taken when you select **Use End Azimuth** and enter a different azimuth value. By default this setting is switched off.

**Select a method for misclosure distribution:**

**Angular Misclosure:**

1. The **max. allowed Angular Error**, as computed according to the number of stations and the standard error per angle defined in step 3, is compared with the calculated angular error. If the max. allowed error is exceeded a warning ⌛ will be issued.

2. Choose the method how the angular misclosure shall be distributed.
If you select **Equally** the angular misclosure will be divided by the number of traverse angles and the same correction will be applied to each setup.

- If you select **By Distance** the angular misclosure will be distributed with respect to the length of the traverse legs. The shorter a traverse leg is, the bigger the correction will be.
- If you select **No Distribution** the angular misclosure will not be distributed to the traverse angles.

**Length Misclosure:**

1. The **max. allowed Length Error**, as computed according to the total traverse length and the standard error per distance defined in step 3, is compared with the calculated length error. If the max. allowed error is exceeded a warning will be issued.

**Height Misclosure:**

1. The **max. allowed Height Error per Traverse Point**, as defined in step 3, is compared with the calculated height error. If the max. allowed error is exceeded a warning will be issued.

2. Choose the method how the height misclosure shall be distributed.
   - If you select **Equally** the height misclosure will be divided by the number of stations and the same correction will be applied to each station height.
   - If you select **By Distance** the height misclosure will be distributed with respect to the length of the traverse legs. The longer a traverse leg is, the bigger the correction will be.
   - If you select **No Distribution** the height misclosure will not be distributed to the station heights.

3. Press **Next** to proceed with:
   Traverse Wizard: Traverse Result

---

**4.2.1.8.6 Traverse Wizard: Traverse Result**

Before you take over the computation results to your project, the calculation results will be listed.

**You will see:**

- the total **traverse length**
- the **number of stations** included
- the achieved **1D and 2D accuracy**
- the **calculated scale**

Select **Apply scale to observations** you wish to apply the scale factor resulting from the traverse computation to all setups that make up the traverse. For each setup all observations will be scaled by this value.

- the kind of error distribution (**balancing**) you have chosen for **angles** and **height**
- the **adjusted** results calculated for the traverse point coordinates using the **Control** coordinates at the start (and the end) of the traverse plus the Δ values in position and height relative to the coordinates resulting internally from the measurements.

How big the Δ values are depends on how you choose to distribute the errors in Step 4: Calculate Traverse.
To take over the results and update the traverse point coordinates in your project:

Press Finish.

The Traverse points will get the Adjusted coordinates added as another Point role.

☞ The Adjusted coordinates should be taken as target coordinates when re-calculating setups on sideshot points of the traverse.

4.2.1.8.7 Traverse Processing Parameters

In the Backstage under Info and Settings you can define the Traverse processing parameters that shall be used by default when a new traverse is calculated in Leica Infinity.

See also:
Info and Settings

Default Traverse Adjustment Parameters

Adjustment Method

Choose the method how the coordinate misclosure (Easting, Northing) shall be distributed.

• If you select Compass Rule the coordinate misclosure will be distributed with respect to the length of the traverse legs. The Compass Rule assumes that the biggest error comes from the longest traverse observations. This method is suitable when the precision of the angles and distances are approximately equal.

• If you select Transit Rule the coordinate misclosure will be distributed with respect to the coordinate changes in Easting and Northing. Use this method if the angles were measured with a higher precision than the distances.

• If you select No Adjustment the coordinate misclosures will not be distributed to the station coordinates.

• If you select 2D Helmert the traverse will be adjusted by a 2D Helmert transformation. Shift, Rotation and Scale factor will be computed and applied to the traverse.

☞ The Compass Rule is also known as the Bowditch method.

☞ Control coordinates have to be stored for the Start and End Point in the traverse if you wish to calculate and distribute the coordinate misclosure by either the Compass Rule or the Transit Rule.

Angle Balance

Choose the method how the angular misclosure shall be distributed.

• If you select Equally the angular misclosure will be divided by the number of traverse angles and the same correction will be applied to each setup.

• If you select By Distance the angular misclosure will be distributed with respect to the length of the traverse legs. The shorter a traverse leg is, the bigger the correction will be.

• If you select No Distribution the angular misclosure will not be distributed to the traverse angles.
Height Balance
Choose the method how the height misclosure shall be distributed.
• If you select **Equally** the height misclosure will be divided by the number of stations and the same correction will be applied to each station height.
• If you select **By Distance** the height misclosure will be distributed with respect to the length of the traverse legs. The longer a traverse leg is, the bigger the correction will be.
• If you select **No Distribution** the height misclosure will not be distributed to the station heights.

Apply scale to observations
Select this setting, if you wish to apply the scale factor resulting from the traverse computation to all setups that make up the traverse. For each setup all observations will be scaled by this value.
☞ When you re-compute the same traverse then the scale will be 1.0 or very close.
☞ To remove the scale press the button under **Station Scale** in the **Traverse Properties** window.
If you delete the traverse the scale will also be deleted from the setups and observations to which it has been applied.

Tolerance Checks in Traverse Wizard

**Traverse Data Review**

**Residuals Hz/ V**
Specify a limit for the value that the residuals of your angular observations are allowed to take. When the residuals exceed this limit then the observations will be marked by ⚠ in the **Observation Review** of the **New Traverse** wizard.

**Residuals Slope Distance**
Specify a limit for the value that the residuals of your slope distance measurements are allowed to take. When the residuals exceed this limit then the measurements will be marked by ⚠ in the **Observation Review** of the **New Traverse** wizard.

**Distance Difference**
Specify a limit for the difference that shall be allowed between distances measured as a foresight and a backsight between two traverse stations.

**Use max. 2D error**

**Max. Angular Error:**
The tolerance for the Angular Error is defined as $F = k \times \sqrt{n}$, with $k$ being the constant value that you have to enter as the **Standard Error per Angle** (the default value is 15") and $n$ being the number of traverse points (angles). If the calculated Angular Error exceeds the **Max. Angular Error**, the **Angular Misclosure** will be marked by ⚠ in the **Calculate Traverse** step of the **Traverse Wizard**.

**Max. Length Error:**
The tolerance for the Length Error is defined as $F = k \times \sqrt{L}$, with $k$ being the constant value that you have to enter as the **Standard Error per Dis-
Distance (the default value is 0.010m) and \( L \) being the total length of the traverse. If the calculated Length Error exceeds the Max. Length Error, the Length Misclosure will be marked by \( \) in the Calculate Traverse step of the Traverse Wizard.

☞ If you choose to adjust the traverse by a 2D Helmert transformation it is not necessary to define a max. length error and a max. cross error. The corresponding functionality will not be available. The scale factor is automatically applied as part of the transformation.

Min. 2D Accuracy:
The accuracy in position is achieved by dividing the calculated length of error by the total traverse length, with the Length of Error being the length of the vector resulting from taking the length and the cross error into account. The minimum position accuracy that should be achieved is defined as 1 divided by a user-defined value. By default this value is set to be 10’000. If the achieved accuracy is bigger than the defined fraction value then the Min. 2D Accuracy will be marked by \( \) as exceeded.

Use max. 1D error

Max. Height Error per Traverse Point:
Define the tolerance for the Height Misclosure. If the calculated Height Misclosure divided by the number of stations exceeds the Max. Height Error per Station, the Height Misclosure will be marked by \( \) in the Calculate Traverse step of the Traverse Wizard.

Min. 1D Accuracy:
The accuracy in height is achieved by dividing the calculated height error by the total traverse length. The minimum height accuracy that should be achieved is defined as 1 divided by a user-defined value. By default this value is set to be 10’000. If the achieved accuracy is bigger than the defined fraction value then the Min. 1D Accuracy will be marked by \( \) as exceeded.

Station Difference before and after Adjustment

Use station difference

Max. Station Difference before and after Adjustment:
Define the maximum difference that shall be allowed between measured and adjusted station coordinates. If the adjusted station coordinates differ by more than the defined values from the measured coordinates then the Coordinate Misclosure will be marked by \( \) in the Calculate Traverse step of the Traverse Wizard.

☞ If you deselect any of the tolerance checks or the max. station difference check then these checks will by default not be applied in the New Traverse Wizard. But you can always select or deselect single checks while calculating a traverse in the wizard independent of the default settings.
The *Sets of Angles Wizard* reduces a sequence of TPS observations from a common TPS setup. The result also includes a reduced observation available to use for Traverse application.

The sets of angles are reduced to the first target, which can be different than the backsight target of the selected station setup. The reduction to the station setup results in an orientation correction applied from the backsight to the first target used in the sets of angles. Only one orientation correction can exist per station setup.

**To create new sets of angles:**
Go to the Processing module and select New Sets from the ribbon bar.

The *New Sets of Angles Wizard* starts with:
Sets of Angles Wizard: Select Setup and Points
Go through the wizard to create a new sets of angles.

**To edit existing sets of angles:**
Select the sets of angles to be edited from inside the TPS tab of the Inspector. Drill down into the Sets of Angles Applications, select the station on which the sets to be edited is defined and press the icon.

Once selected you can also press the Open Sets of Angles Wizard button in the Results section of the Sets of Angles Property Grid.

The *Edit Sets of Angles Wizard* starts with:
Sets of Angles Wizard: Select Setup and Points
Go through the wizard to edit an existing sets of angles.

**Sets of Angles Wizard: Select Setup and Points**
1. On the left hand side select the Setup upon which the measurements have been taken that shall be used for the sets of angles computation.
2. Choose whether you want to compute the maximum number of sets or the maximum number of points.
When you choose to compute the **maximum number of sets** then the maximum possible number of sets that have been measured on the selected setup for either Face I only or for Face I & II will be detected but only those points will be offered for selection as available targets which have been measured in all sets. Points that have been skipped in one of the sets will not be offered for selection. Thus, the calculation method is called **without skipped points**.

When you choose to compute the **maximum number of points** then all points that have been measured on the selected setup for either Face I only or for Face I & II will be detected and offered for selection as available targets independent of how many sets can subsequently maximum be computed on the basis of the current selection. Sets that have been measured excluding one or more of the selected target points are incomplete and thus ignored. The calculation method is called **without incomplete sets**.

3. Select either **observation type** Face I & II or just Face I.

4. Select **Available Targets** and press the ➡ button to add all related measurements to the right hand side.

5. Press **Next** to proceed with:
   Sets of Angles Wizard: Sets Review

---

**4.2.1.9.3**

**Sets of Angles Wizard: Sets Review**

In the **Sets Review** all used target points are listed.

1. Review the angle observations and measured distances for each target point.

   When in step 2 you chose to compute the maximum number of points without using incomplete sets, all those instances of a point will be unavailable for selection that are part of incomplete sets.

2. Depending on the **Tolerance** settings outliers will be marked by 📀. You can adjust the tolerances to your needs either for the current computation run in the same wizard page or globally under **Info and Settings > Averaging and Reduction**.

   The tolerance settings can also be changed for single targets once the Sets of Angles computation is completed. To do so click the ➡ button in the **Observation** section of the **Sets of Angles Target Properties** window. The tolerances shown correspond to those last used but can be changed for single targets if required.

3. Exclude outliers from the computation by de-selecting them.
When you de-select a target point from one of the sets then the set will become incomplete and thus be de-activated for all points. At least one set has to remain active to be able to compute reduced measurements.

4. Press **Next** to proceed with:
   Sets of Angles Wizard: Sets of Angles Results

---

**4.2.1.9.4**

**Sets of Angles Wizard: Sets of Angles Results**

In the **Errors** section the resulting standard deviations are listed for:

- a single Hz direction in a single set
- a single V angle in a single set
- a single slope distance in a single set

and for

- the reduced Hz direction
- the reduced vertical angle
- the reduced slope distance

with the standard deviations for the reduced observations being the standard deviation for a single observation divided by the square root of the number of sets.

In the **Targets** section each target point is listed with

- its reduced values for Hz, V, slope and horizontal distances
- its local grid coordinates resulting from the sets of angles computation
- the standard deviation calculated from the correction values for each point in all sets.

---

**4.2.1.10**

**Reduce Foresights**

**4.2.1.10.1**

**Reduce Foresights Wizard**

**Overview**

The **Reduce Foresights** Wizard reduces a sequence of TPS observations from a common TPS setup.

Each foresights application is using the Station Setup backsight target point as the starting reference to compute the foresight targets. This is different to the Sets of Angles application which references the first target to reference the reduced angles.

The reduced foresight(s) also result with a reduced observation.

Reduced Foresights reduced measurements are not available to use for **Traverse** application.

Delete the Reduce Foresights applications from the Inspector -> Processing -> TPS application list and then create a traverse.

**To create new reduced foresight:**

Go to the **Processing** module and select **Foresights** from the ribbon bar.

The **Wizard** starts with:

Reduce Foresights Wizard: Select Setup and Points

Finish the wizard to create a new reduced foresight app that you can run a report on.
To edit existing reduced foresights:
Select the target to be edited from inside the TPS tab of the Inspector. Drill down into the Foresights Applications, select the station on which the sets to be edited is defined and press the icon.

Once selected you can also press the Open Reduced Foresights Wizard button in the Results section of the Foresights Property Grid.

The Edit Reduced Foresights Wizard starts with:
Reduce Foresights Wizard: Select Setup and Points
Go through the wizard to edit an existing foresights.

4.2.1.10.2
Reduce Foresights Wizard: Select Setup and Points

1. On the left hand side select the Setup upon which the measurements have been taken that shall be used for the foresights computation.
2. Select either observation type Face I & II or just Face I.
3. Select Available Foresights and press the button to add all related measurements to the right hand side.
4. Press Next to proceed with:
Reduce Foresights Wizard: Foresights Review

4.2.1.10.3
Reduce Foresights Wizard: Foresights Review

In the Foresights Review all used target points are listed.

1. Review the angle observations and measured distances for each target point.
   
   When in step 2 you chose to compute the maximum number of points without using incomplete sets, all those instances of a point will be unavailable for selection that are part of incomplete sets.

2. Depending on the Tolerance settings outliers will be marked by . You can adjust the tolerances to your needs either for the current computation run in the same wizard page or globally under Info and Settings > Averaging and Reduction.

   The tolerance settings can also be changed for single targets once the Foresights computation is completed. To do so click the button in the Observation section of the Foresights Target Properties window. The tolerances shown correspond to those last used but can be changed for single targets if required.

3. Exclude outliers from the computation by de-selecting them.
   
   When you de-select a target point from one of the sets then the set will become incomplete and thus be de-activated for all points. At least one set has to remain active to be able to compute reduced measurements.
4. Press **Next** to proceed with:
Reduce Foresights Wizard: Results

### 4.2.10.4 Reduce Foresights Wizard: Results

**In the Errors section** the resulting standard deviations are listed for:
- a single Hz direction in a single set
- a single V angle in a single set
- a single slope distance in a single set

and for
- the reduced Hz direction
- the reduced vertical angle
- the reduced slope distance

with the standard deviations for the reduced observations being the standard deviation for a single observation divided by the square root of the number of sets.

**In the Targets section** each target point is listed with
- its reduced values for Hz, V, slope and horizontal distances
- its local grid coordinates resulting from the foresights computation
- the standard deviation calculated from the correction values for each point in all sets.

### 4.2.11 Update Stations

#### 4.2.11.1 Overview

The Update Stations Wizard enables you to recalculate multiple setups when new coordinates are available for your stations and target points.

For setup method Unknown, Local Resection, Height Transfer, Orient to Object and Adjusted Traverse the Update Stations is not available. All computations are run with the current individual setup settings.

To update stations, go to the **Processing** tab and select **Update Stations** from the ribbon bar.

The **Update Stations** wizard opens.

#### 4.2.11.2 Update Stations Wizard: Select Stations

**In the Select Stations** tab, all available or selected stations are displayed on the left side.

☞ By default, stations are sorted by time and date. You can use filters and search to find required stations.

1. Click the **button** to add across selected stations or click the **button** to add all stations.
2. Click the **button** to remove a selected station from the list of setups. Click the **button** to remove all stations from the list of setups.
3. Click **Next** to process to Update Stations Wizard: **Review & Update Stations**.
**Update Stations Wizard: Review & Update Stations**

The **Review & Update Stations** tab shows computed setups with the highest class for the station and targets available in the project.

1. Review suggested point source for stations.

2. Review suggested point source for targets by pressing the Expander icon next to the station.

3. Click the Edit icon to select different point sources for the computation.

4. Disable the **Update** checkbox if the station should not be updated.

5. Select the **Apply scale to observations** checkbox to apply pre-computed scale to the observations.

6. By default, a report runs and opens when you click **Finish**. Deselect the **Show Report** checkbox to hide the report.

7. Click **Finish** to start the operation.

---

**4.2.2 GNSS-Processing**

**4.2.2.1 Overview**

GNSS Post Processing considers the three influences of baseline processing to arrive at the most reliable and accurate coordinates. These three influences are:

- Defining what data the processing engine should consider.
- Selecting the antenna calibration set to minimize errors in the position solution.
- Setting the processing strategy to be applied to the data.

The user can define the baseline to process in two ways:

- Manually: setting the **Reference** and **Rover** station.
- Automatically: letting the application find the possible baselines combination, according to some constrains defined in the **Auto Settings**.

In both configurations, the graphical view helps the user to visualize (to have a preview) the possible baselines through the "GNSS Suggested baselines" layer.

The data processing and the automatic baselines selection are defined by the following Project settings:

**Data Settings:**

Let the user filter or set which data is sent to the processing engine. This can be:
Choosing which constellations the processing should include to the elevation angle of observation data.

- The ephemeris type or even the observation rate.
- A key data setting is the antenna calibration set, that is considered during processing. Ensuring that both the reference and the rover stations are referring to the same calibration model of determining POC and PCV values ensures minimising the physical error sources to achieve the most reliable solution.

**Processing Strategy:**

Allows the user to set parameters to influence the baseline computation based on:

- The length of baseline.
- Common observation times.
- The atmospheric influences.

**Advanced Settings:**

Let the user to tune the processing through specific settings, such as the frequency to use in the computation.

It is recommended to leave these settings at system default in order that the processing engine determines the highest reliability of the solution.

**Auto Settings:**

The automatic processing settings define the logic to identify intelligently pairs of reference and rover stations, building up all possible combination of baselines.

The rules to create a baseline take into consideration the baselines duration (amount of time of simultaneous measurement at reference and rover station) and the baseline length.

The baseline processing order is defined according to the points role, for example if Control Points are available, they will be used as starting point for the baselines automatic processing, and the automatic processing settings defined from the user.

Refer to the tutorials "How to process GNSS baselines":
https://leica-geosystems.com/-/media/c614b534942141c8952e7fa8973bc7e2.ashx
"Advanced GNSS Processing":
https://leica-geosystems.com/-/media/539597242bfa46b99d1366acaе90d133.ashx
"Ambiguity Statistics Interpretation":
https://leica-geosystems.com/-/media/41ee41837f7442bfa42d4b746ed088c0.ashx
Tutorial data can be downloaded in the Localisation Tool.

### 4.2.2.2 How to post-process GNSS data?

<table>
<thead>
<tr>
<th>How to post-process GNSS data?</th>
<th>Setting up your project</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting up your project to post-process GNSS data. Import data to a project and adapt the processing parameters if necessary.</td>
<td></td>
</tr>
</tbody>
</table>
1. Import the GNSS raw data to your project.
   See also:
   New Project
   Data Import
   GNSS raw data is only supported in the DBX (SmartWorx) or RINEX format.

2. Import and select a local grid coordinate system.
   Leica Infinity can process pure WGS84 data, but it can only display local grid coordinates in the graphical View. This is the reason why you cannot view the points. The Navigator shows you the following icon: 🔭. Once you have selected a coordinate system the icon in the Navigator changes to 🔬 and you can see the points in the graphical View. On how to import or define a coordinate system see: Coordinate Systems On how to select a coordinate system within a project see: Coordinate Systems inside a Project

3. Adapt the processing parameters. In the main menu, go to the Processing tab. Its ribbon bar offers you all GNSS relevant functionality. Click 🔖 to open the Data settings dialog. See also: Settings: Data
   Click 🔍 to open the Processing Strategy dialog. See also: Settings: Strategy
   You can also define the Data settings and the Processing Strategy through the Backstage > Info & Settings > Data Processing > GNSS.

   Click 🔎 to open the GNSS Manager. For further details on different processing strategies, refer to "GNSS Manager".

**Manual processing**
To post-process the imported raw data manually, proceed as follows. You will see that directly after import the role of each point is Navigated. When you have successfully processed the data, it is GNSS Post-Processed.

1. Go to the Inspector GNSS tab.
   Choose the 🔁 Intervals to display the list of all imported intervals. Click on Start Time in the header to sort the intervals by time. Click on the ⏯ button next to the Search field to see a graphical representation.

2. Be sure to have assigned the correct point roles that you will use as reference. To assign as Control, right-click on the interval and select Assign Control Point.
3. Specify the \textit{Reference} and the \textit{Rover} intervals. To do so right-click on an interval in the Inspector and select either \textit{Reference} or \textit{Rover} from the context menu.

After setting your reference and rover station, the enabled baselines are listed in the GNSS > Inspector > Enabled Suggested Baselines. If there is a coordinate system attached to the project, the manually enabled baselines are also visible in the graphical View (prior to processing). The line colour of the manually enabled baseline is taken from the \textit{GNSS Observation} layer. Line width and line style of the manually enabled baselines are taken from the \textit{GNSS Suggested Baseline} layer.

You can also enable a baseline by selecting it from the graphical View (\textit{GNSS Suggested Baseline} layer) and setting the direction from the context menu. After this action, the interval view is updated to reflect the changes.
Intervals multi-selection is possible.
Reference Station data can also be downloaded from the Internet.
See also: GNSS Manager

4. When you have selected a reference and all its rover intervals click in the ribbon bar to process the data.

Short-cut functionality is available here to quickly change the Antenna Calibration Set before starting the processing run.

5. Highlight the rover and its intervals again in the Inspector and select Reset from the context menu to remove the Reference and Rover flags.
Specify the next reference and its rovers.
Click the Processing button again in the ribbon bar.

6. Repeat step 4 until all baselines are processed.

7. In the Inspector, the Results tab has become active. Drill into each processing run by clicking the little arrow right next to it and inspect the results for each baseline.

Click on in the Ribbon bar to generate a report on the currently selected element. You can generate reports on single baselines, single tracks as well as on whole processing runs.
8. Select the results to be stored and click on 
 in the Ribbon bar. You can store single baselines, single tracks as well as whole processing runs.

☞ When you store Points that have been computed with respect to two or more different reference stations, then the point average is computed regardless of the solution type. This means that if a Phase Fixed solution and a Code solution shall be averaged then the average will be computed in any case and it will be left to the user to decide whether the Code solution shall be ignored or not. When you store Tracks that have been computed with respect to two or more different reference stations, then the track average is computed with respect to the solution type. This means that if a Phase Fixed solution and a Code solution shall be averaged then automatically the Phase Fixed solution will be taken into account while the Code solution is ignored.

☞ Only stored results are displayed in the graphical View.

Automatic processing
To find the possible baselines automatically and post-process the imported raw data, proceed as follows.

1. Go to the Inspector GNSS tab.
2. Be sure to have assigned the correct point roles for your control stations. To assign as Control, right-click on the interval and select Assign Control Point.
3. Highlight all the intervals you want to consider for the baselines creation. Set the intervals to automatic from the GNSS ribbon bar or from the interval context menu.

After setting your intervals to **Automatic**, the enabled possible baselines are listed in the GNSS > Inspector > Enabled Suggested Baselines. If there is a coordinate system attached to the project, automatically enabled baselines are also visible in the graphical View (prior to processing). The direction of the baseline is not always known prior to the processing, but it is determined once that the automatic algorithm is started.

The line colour of the automatically enabled baseline is blue by default. Line width and line style of the automatically enabled baselines are taken from the **GNSS Suggested Baseline** layer.
You can also enable a baseline by selecting it from the graphical View (GNSS Suggested Baseline layer) and selecting Automatic.

Manual processing and automatic processing can also be used together. In such a setting, the manual processing has the priority to the automatic processing in the baselines computation order. Moreover, results of manually selected baselines can be used to feed the automatic processing.

For example, in the following setting, the baseline AVAL -> DJO is computed first. Therefore the coordinates of DJO have been established and can be used to solve the baselines DICO -> DOCX.
A lonely interval set to reference (without rover), or a lonely interval set to rover (without reference) is not combinable with an interval set to automatic. In the setting below, no processing is performed.

Processing
To launch the processing, click on the Process or Process & Analyse button in the GNSS Ribbon bar.

The processing options work as follow:

• Process
  Run the GNSS data processing and show in the results basic data quality information, such as Satellite tracking, DOP, Ambiguity Statistics. Additional data analysis products (observations residuals, position residuals) are not available in the results, in order to reduce the processing time. Choose this option to process a large amount of data.

• Process & Analyse
  Run the GNSS data processing and output additional products to analyse the results. By default, Infinity outputs Observation Residuals (for all kinds of datasets) and Position Residual (for static dataset). The behaviour of the button can be modified from the GNSS Advanced Settings. Choose this option to make a complete and deep data analysis.

4.2.2.3 GNSS Analysis Tools

The GNSS post processing module offers tools to investigate the details of the processing results.

To visualise the charts within the application:

1. Open the GNSS processing results from Inspector > GNSS > Results.
2. Open the Results Analysis Viewer, by clicking on the button situated on the top right of the GNSS Inspector.

3. The GNSS > Inspector > Results is split into two parts.
   - **Bottom part**: Contains the processing results.
   - **Upper part**: Contains charts with information about: Tracking (with used/rejected satellites and used/rejected observations per epoch), SV Position, Ambiguity Statistics and Observations Residuals.
   You can navigate within the charts by selecting the Chart Menu at the top of the plots.

### Position Residuals Charts
Position residuals come from the kinematic processing of static data.
The charts are available by:
- Choosing the **Process & Analyse** option
- Setting **Process & Analyse Output** to Position Residuals or Observation and Position Residual in the GNSS advanced settings. See Settings: Advanced.
Position residuals are computed with respect to:

- **Static solution**: The coordinates of the computed point (from the static processing) are taken as reference to compute the residuals.
- **First epoch**: The coordinates at the first epoch of the kinematic processing are taken as reference to compute the residuals.
- **Previous epoch**: The residuals at each epoch \( t \) are computed with respect to the solution of the kinematic processing at the previous epoch \( t-1 \).

In the Inspector > GNSS > Results > Static as Kinematic tab, the statistics over the position residuals are available.

The Position residuals plot and statistics, can be used to evaluate the internal reliability of the dataset and of the static solution. Residuals with a small dispersion around the zero, are indicator of good reliability.
Position residuals can help to identify possible issues in the solution, and at the same time could suggest a possible workaround. If you realise that part of the residuals are particularly noisy, it is suggested to exclude that range of data from the processing, by applying an exclusion window. In the example below (the chart represents the Position residuals from previous epoch), it is suggested to manually exclude from the processing the first and the last part of the dataset.

![Diagrams and charts showing position residuals and data points](image-url)
The Positions Residuals plot can also be used to identify displacement of the antenna. The picture below shows residuals of an antenna subjected to vibration.

By selecting **Open** in a new window from the Inspector > GNSS > Results > Advanced, different type of plot can be opened and compared in a new window.

---

### 4.2.2.4 RINEX Import Settings

**RINEX Import Settings**

**Merge intervals:**
The Merge intervals functionality is normally used when importing data from permanent reference stations. If more than one GPS interval is contained in the data then this function will merge any observation intervals that conform to the following conditions:

- The gap between any two consecutive intervals is less than 30 minutes.
- The Point Ids are identical for consecutive intervals.
- The Antenna Type is identical for consecutive intervals.

Reference Station data can also be downloaded from the Internet.
See also:
GNSS Manager

Connect intervals to mixed tracks:
Check this box if you import RINEX data measured as kinematic tracks with static intervals (Mixed Track (MXD)).

### 4.2.2.5 Settings: Data

**Settings: Data**

Here the user will select the settings that apply to the data used for GNSS post-processing.

**Cut-off angle:**
The system default is 10°.
Increase the cut-off angle to avoid the noisier low elevation satellites. This would be used if there may be problems in solving of ambiguities to arrive at a Phase Fixed solution.

**Sampling Rate:**
The system default is to ‘use all’ recorded data.
Increase the sampling rate to use only sub-sets of all recorded data.
Decrease the sampling rate when using long observation times to reduce the processing time.

**Used Satellites:**
The system default is to ‘use all’ available satellites.
Choose ‘Manual selection’ and click on the icon to deselect unhealthy satellites.

Inactive satellites are disabled by default.

To completely enable/disable entire constellations go to Info and Settings > Data Processing > GNSS and select/deselect the Satellite Systems in the Data section.

**Ephemeris Type:**
The system default is to use ‘Broadcast’ ephemeris.
In order to use ‘Precise’ ephemeris import the required NOAA/NGS *.sp3 to the project.
See also:
GNSS Manager

The date of the *.sp3 file must correspond to the date of the data to be processed, else Leica Infinity switches back to ‘Broadcast’ automatically.
Download the required *.sp3 file from ftp://cddis.gsfc.nasa.gov/pub/gps/products/mgex/

Antenna Calibration Set:
The system default is Leica Relative.
Additional calibration sets for non-Leica antennas are offered for selection but can also be downloaded from http://www.ngs.noaa.gov/ANTCAL/. You can do so via the GNSS Manager.

See also:
GNSS Manager

4.2.2.6 Settings: Strategy

Solution Type:
Set the solution type the processing engine should output:
- The system default and recommended setting is ‘Phase Fixed’ where processing will attempt to fix the ambiguities.
- The computed solution can also be a Widelane fixed solution, which is the equivalent of the xRTK solution on Captivate/Smart-Worx Viva RTK rovers and applies mainly with difficult data and on typically short (<50km) baselines.
- For baselines where the Phase Fixed solution is not reliable, the solution type will revert to a Float solution automatically.
- Select ‘Float’ when you process very long baselines and have long observation times. The system will not try to solve the ambiguities.
- If in the Data Settings you have chosen to process a single frequency solution then the system will process ‘L1 only’, ‘B1 only’ or ‘E1 only’ Float solutions.
- Select ‘Code’ in order to compute a code only solution when lower accuracy results are sufficient.

Solution Optimization:
Set how the processing engine considers the tropospheric and ionospheric biases.
- The system default and recommended setting is ‘Automatic’ which allows the processing engine to determine when to compute a linear combination and which makes it automatically use the best combination of frequencies.
- The input data is evaluated during the processing and considers the effects of the ionosphere. When the processing engine determines the reliability of the solution is higher when using a linear combination then this is automatically considered for the solution.
- For the GPS constellation, the system can compute an iono-free solution over three frequencies (if L1, L2 and L5 are all available). To change the frequencies to use, go to the Advanced Settings.
Set this to ‘Iono Minimized’ to force the processing engine to always attempt a linear combination solution.

For baselines longer than 15km (system default, can be changed in the Advanced Settings) or with a very noisy ionosphere, the system automatically computes a linear combination iono-free solution.

Set this to ‘None’ when you do not want the processing to consider a linear combination for the solution.

When set to 'None', the processing engine will use the selected Ionospheric model to apply during processing.

☞ Trop. Model:
The system default and recommended setting is VMF with GPT2.
For long baselines or baselines with a large difference in height select Computed. Variations of the tropospheric zenith delay between reference and rover will be calculated from epoch to epoch.

☞ Iono Model:
The system default and recommended setting is Automatic.

If you have at least 45min. of static or rapid-static dual-frequency data collected on the reference station then the system will choose Computed. The computed model will suit your observations best. If less than 45 minutes of data are available, then it will automatically switch to None.

Only choose 'None' when you can be sure that ionospheric activity will be low.

You can also use a Global/Regional Model if available. Ionospheric files can be imported via the GNSS Manager. If you select this option but no such file is available, then the system will switch to use "None" automatically.

4.2.2.7 Settings: Advanced

Frequency:
The system default is Automatic.
All available frequencies will be used, i.e. if available Leica Infinity makes use of triple frequencies.

The system will use the selected frequencies only for the constellations enabled in the Info and Settings > Data Processing > GNSS, i.e. to use Galileo E5a E5b E5ab, Galileo must be manually activated. Select Galileo in the Data section under Satellite Systems.

If multi frequency is not available the system will automatically process a single frequency solution. For users having the Single Frequency Processing option, only ‘L1/B1/E1’ is used by default.

Frequency to use in Iono Minimized:
This setting is active only if you have set Solution Optimization to ‘Iono Minimized’ in the Strategy Settings.
The system default is Automatic. Leica Infinity will find the best combination of frequencies to use in the iono-free computation.

To exclude L2/B2 (GPS, Glonass and Beidou) or L5 (GPS) from the iono-free linear combination, select the corresponding options.

☞ For GPS, a triple frequency iono-free solution can be computed.

**Min. Distance for Iono Minimized:**
By default an iono minimized solution will only be attempted for baselines longer than 15km.

Adapt the value to force the system to compute an iono minimized solution even for shorter baselines.

☞ If in the Settings: Strategy Solution Optimization is set to 'Iono Minimized' then the processing engine will always attempt a linear combination solution independent of the baseline length.

**Possible Ambiguities Fix up to:**
The system default is 300km.

Defines the maximum length of a baseline for which the system shall try to resolve ambiguities. For baselines above the limit a float solution will be computed.

If you want to ensure a higher accuracy and reliability you can enter a lower value.

**Min. Duration for Float Solution (static):**
The system default is 5 min.

Defines the time below which the computation of a float solution for static intervals shall not be allowed, because for short observation intervals a float solution may not be accurate enough. In case ambiguities cannot be resolved the processing engine will compute a code-only solution for intervals below the limit.

**Allow Widelane fix:**
By default this setting is active.

It allows for the computed solution possibly being a Widelane fixed solution, which is the equivalent of the xRTK solution on Captivate/SmartWorx Viva RTK rovers and applies mainly with difficult data and on typically short (<50km) baselines.

**Process & Analyse Output**
Establish the type of output for the Process & Analyse mode. The analysis products are shown in the GNSS results Analysis Viewer.

Observation Residuals can be used to analyse the noise of the solution on the observations domain.

Position Residuals help to analyse the noise of the static solution on the positions domain. The position residuals are derived by processing static data in kinematic mode.

Choose **None** to remove the analysis mode option from the GNSS processing ribbon bar.

Choose **Observation & Position Residuals** to make a complete and deep data analysis.
4.2.2.8 Settings: Automatic Processing

The Automatic processing settings define the logic Infinity uses to:

1. Identify the possible baselines and draw it in the graphical view prior to processing, through the **GNSS Suggested Baselines** layer.
2. Fix the rules to decide which baselines should be processed and in which order.

**Suggested Baseline Strategy**

These parameters are considered to identify the possible baselines. If the **GNSS Suggested Baselines** layer is on, the possible baselines are automatically shown in the graphical view after importing raw data.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Min. Baseline Duration</strong></td>
<td>This sets the minimum amount of time over which simultaneous measurements must be taken at two stations before Infinity try to show the preview and process the baseline between those two stations.</td>
</tr>
<tr>
<td><strong>Max. Baseline Length</strong></td>
<td>Sets the maximum length of baselines up to which Infinity shows the baselines in the preview and process.</td>
</tr>
<tr>
<td><strong>Re-Compute already computed Baselines</strong></td>
<td>If this option is checked, baselines that have been calculated and stored previously are proposed again as Suggested Baselines and sent to the processing.</td>
</tr>
<tr>
<td><strong>Compute Baselines between Control Points</strong></td>
<td>If this option is checked, baselines between Control points role will also be processed. This may be interesting if the Control points are not kept absolutely fixed in a subsequent adjustment.</td>
</tr>
</tbody>
</table>

**Auto Processing Strategy**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Baseline Processing</strong></td>
<td><strong>All</strong>: Infinity processes all possible combinations of baselines that conform to the automatic processing parameters. <strong>Independent sets</strong>: Infinity only processes a set of independent baselines. Between n points which are measured at the same time only n-1 independent baselines exist.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Priority to Baseline with        | **Shorter Slope Distance:** The shortest baseline from the first reference point is computed first. Infinity then decides which is the next shortest baseline. This may be from the first point or from the point that was last computed. This line is processed next and then the process is repeated. This is also dependent on the other automatic processing parameters.  
**Longer Duration:** The baseline with the longest common observation time is computed first. Similarly, to the distance method, Infinity then decides which point has the next longest common observation time and processes that line. The process continues like that. This is also dependent on the other automatic processing parameters. |
| Session by Session               | If this option is checked, Infinity computes all possible baselines from the reference that has been identified according to the selected seeding strategy before proceeding with the next reference. The point with the longest interval is selected as the first reference.                                             |
| Allow to use Float solution as Reference | Allow points whose solution is float to be used as reference points for further processing.                                                                                                                     |

### General

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Intervals to Auto at Import</td>
<td>If this option is checked, Infinity will set all the intervals to <strong>Automatic</strong> immediately after data import. This setting is suggested in case the user measured a GNSS network with many sessions of reference and rover, and the user wants to process all the possible baselines in a one go. If this option is checked, the user should only import all the data and press <strong>Process</strong>.</td>
</tr>
</tbody>
</table>

---

**4.2.2.9 GNSS Inspector**

**GNSS Inspector**

**GNSS Observations:**

Inspect GNSS Observations All 🗂️ or by Station 🗂️️. These functions become active when results are stored.

Reports available via the Home ribbon > Reports.

**GNSS Tracks:**

The GNSS tracks 🗂️ tab lists all tracks in the project.
When processing Kinematic data from two or more reference stations, a reduced kinematic track is computed. Drill into a track to inspect details and visualize the contributors to the tracks.

In the example below, when you drill into the track Flight 1, the computed tracks with respect to the reference stations FFMJ and EUSK are listed, together with the averaged track.

The reduced track and the contributors are also available in the navigator library, for quick access and management of the tracks.

**Working with GNSS Intervals:**
Right-click on an interval or a selection of intervals and select Download from the context menu to manually or automatically download data that matches the date/time of the interval(s) from permanent reference stations.

See also:
GNSS Manager

Click on the button next to the Search field to see a graphical representation.

Functions:
- Via ribbon or via context menu select Reference and Rovers for post-processing.
- Zoom in/out using the mouse wheel or slider at the bottom of the graphical view.

When Interval (static) shows the expander icon: 55° 15'
• View details of the interval: Click the arrow to open details on each satellite in the satellite view:
  • The default view shows satellites grouped by constellation type and includes display of cycle slips.
  • Choose the \( \text{SNR} \) to display the SNR values: Red or Orange data is poor data.
  • Choose \( \text{Elevation} \) to view the elevation of the satellite.
• Windowing: Add or remove exclusion windows:
  Normally, the whole observation period of a track is used for processing. However, the user may wish to process only a subset of the observations taken on a site. Observation windows for individual observation intervals to be included or excluded can be selected. Individual satellites can be windowed using Satellite Windows. Exclude a whole satellite via right click.
  • press Shift and drag mouse on Satellite from left to right to “create” exclusion window
  • press Shift and drag mouse on windowed Satellite from right to left to “remove” exclusion window.
  • press ‘Clear All Windows’ button in the ribbon to remove all windows from all intervals
To precisely set a window to the nearest second, it is possible to manually enter windows. Select ‘Edit Exclusion window’ from the context menu on an Interval. This function is only available if a window exists.

<table>
<thead>
<tr>
<th>10:00</th>
<th>10:00</th>
</tr>
</thead>
<tbody>
<tr>
<td>402</td>
<td>55° 15'</td>
</tr>
<tr>
<td>G04</td>
<td>36° 30'</td>
</tr>
<tr>
<td>G05</td>
<td>55° 15'</td>
</tr>
</tbody>
</table>

GNSS Results:
Drill into a result and click onto the button next to the Search field to see a graphical representation of the results for single baselines.
See also:
How to post-process GNSS data?

4.2.2.10 GNSS Manager

The GNSS Manager holds all GNSS-related information such as antenna calibration sets, precise ephemeris and iono models. It also contains reference station download and satellite availability prediction tools.

To start the GNSS Manager click on in the GNSS Processing ribbon bar or in the Leica Infinity title bar.

Antennas/ Calibration Sets
Here all the antennas considered in the project are listed, grouped by calibration set.

By default, Leica, Geo ++ and NGS calibration set come with the installation package. Leica and Geo++ consist of only Leica antennas; NGS contains Leica and third parties antennas. The antenna manager allows to get information about the properties of the antennas.
Select the antenna and open the Info fly-out to display the antenna PCV and offset parameters.

☞ Refer to the tutorial "How to manage an Antenna Calibration Set": https://leica-geosystems.com/-/media/a633447d1f3f4afc8c7abf4a1685be6a.ashx
Tutorial data can be downloaded in the Localisation Tool.

Import Antennas (ANTEX format)/ Calibration Sets:
These files are available from various agencies including the IGS (International GNSS Service) or NGS (National Geodetic Survey) and contain a list of antenna types by manufacturer with their respective off-sets and eccentricities.

☞ When processing baselines with third-party GNSS sensors it is suggested to use the NGS calibration set . If the antenna is not in the selected calibration set, then a null antenna is used for both receivers of that baseline.

☞ Antennas can be copied to the Antenna Management via the 'Copy to global' function.

Add a new Antenna:
1. Enter the antenna details in the 'Add antenna' property grid. You can manually enter the antenna offsets and eccentricities if needed.
2. Press Create.

The new antenna will be added to the calibration set that you have selected in the properties and marked as user-defined.

Create a new Calibration Set:
Allows you to create user-defined calibration sets in order to combine antennas of different agencies into one list and use them for processing.
The antennas must be all of either absolute or relative type.
1. In the tab Antennas/ Calibration sets select at least one antenna to make the button become active.
2. Click the New Calibration Set button or right-click into the selection and select Add to Calibration Set > New Calibration Set from the context menu.
3. Enter the details in the 'New Calibration Set' property grid.
4. Press Create.

The new calibration set will be added and marked as user-defined.

Add to Calibration Set:
1. In the tab Antennas/ Calibration sets select at least one antenna to make the button become active.
2. Click the Add To Calibration Set button or right-click into the selection and select ‘Add To’ from the context menu.

☞ You can only add antennas to user-defined calibration sets.
You cannot add more than one antenna with the same name (but with different calibration values) to the same user-defined calibration set.

☞ An antenna from an Absolute calibration set cannot be added to a Relative calibration set (and vice-versa).

The antenna will be added to the selected calibration set and marked as user-defined.

Delete antennas/ calibration sets:
☞ Only user-defined or imported antennas/ calibration sets can be deleted.

See also:
Antennas

Download GNSS Reference Station Data
☞ Refer to the tutorial "How to download reference data":
https://leica-geosystems.com/-/media/817c1f0ca2634823b2da45a5359cefec.ashx
Tutorial data can be downloaded in the Localisation Tool.

Make use of the Internet Download function to download and import static GNSS data from continuously operating reference stations.

Stations made available by the following providers are found automatically.
• SOPAC:
  http://sopac.ucsd.edu/
• NGS (NAFTA list of CORS stations):
  http://www.ngs.noaa.gov/CORS/
• UNAVCO:
• RGP:
  http://rgp.ign.fr/

SmartNet Stations are found when you are logged in to the SmartNet Service.
See also:
HxGN SmartNet

All available stations are shown in a map view:

The list is filtered by the radius of the circle:
Click onto the border of the circle and drag it to shrink or enlarge its radius and find more or less stations.
Click into the circle and shift it to find stations in another region.
☞ By default, the circle is located with a radius of 300km around your project data.
If the project is empty the circle will by default be located with a radius of 300km around Heerbrugg, Switzerland.
If you have selected sites as favourites, the circle will by default be located with a radius of 300km around your favourites.

Download Reference Station Data from the Internet:
1. Select the stations you want to make use of and click on Data > Download in the ribbon bar.
Alternatively, right-click onto a station and select Download from the context menu.

Next to the Property Grid a Download tab opens up.

2. Enter a specific date and time for which you want to download data.
By default, the files suggested for download will be within the time frame of your project data.
☞ If one or more intervals are selected in the GNSS Inspector, the download takes the date/time based on your selection.
Else the date /time is taken based on all available data.

3. Choose another download directory if you want.
By default, the download directory will be your Downloads directory or the project folder if available.
4. Choose whether you want to download Precise Ephemeris and Navigation File simultaneously.
5. Press the Start button at the bottom of the tab to initiate the download.
6. Follow the download progress in the Status section.
7. In case of errors check the availability of the files to be downloaded. Availability can comfortably be checked by clicking the hyperlink on the file name.
8. When download is complete, the data will automatically be imported to your project.

Intervals will automatically be merged on import.

See also:
RINEX Import Settings
Precise Ephemeris will be added to the list in the Precise Ephemeris tab.

☞ Leica Infinity offers a shortcut to access Internet Download. You can also press the Download button in the GNSS Processing ribbon bar or select one or more intervals in the GNSS Inspector and choose Download from the context menu. In both cases the GNSS Manager opens in the Reference Stations tab.

**Update Reference Stations:**
To update the list of Reference Stations, click on Data > Update in the ribbon bar.

**New Reference Station:**
1. To add a new reference station, click on Reference Stations > New in the ribbon bar.
2. In the Property Grid enter the Station Info and the WGS84 Position of the station.
3. To define the Connection, press the Edit button:
4. In the 'Edit URL' flyout enter the ftp address. For example: ftp://rgpdata.ensg.ign.fr/pub/data/%yyyy/%ddd/data_30/amb2%ddd0.%yyd.Z with %yyyy being the placeholder for a 4-digit year and %ddd being the placeholder for a day of the year.

The URL Preview will always refer to the current day of the year, but it is just for illustration to show you that you entered path and file name correctly.

5. Confirm the address by pressing OK.

6. Back in the Property Grid enter your User Name and Password if this is needed to establish a connection.

7. Press Create to create the new, manually entered reference station.

Add to Favourites:
To mark a selection of reference stations as favourites, click on Reference Stations > Add to Favourites in the ribbon bar. In the Inspector view the station(s) will be marked by an asterisk: ★

Alternatively, right-click on a station and select 'Add to Favourites' from the context menu.

Satellite Availability
Satellite Availability allows you to plan your GNSS field work. It provides you with graphical and numerical information on the satellite constellation for any location (Site) at a given time.

Refer to the tutorial "How to predict satellite availability for a site":
https://leica-geosystems.com/-/media/599ca3a5148d41bb8821e3d02d1a674a.ashx
Tutorial data can be downloaded in the Localisation Tool.
1. Right-click in the map view where you want to create a new site and select "New Site" from the context menu. The "New Site" property grid opens up next to the regular Property Grid. The coordinates are derived from the map. You can also click on "New Site" in the ribbon bar, enter the coordinates in the property grid and press "Create" to create the new site.

2. Give the site a name and press "Create" in the property grid. The site will be added to the map view and to the list of sites in the Navigator.

3. Select the site and choose "New Prediction" either from the context menu or from the Satellite Availability ribbon bar. The "New Prediction" property grid opens up next to the regular Property Grid.

4. Under "Settings" select a start and an end date for the prediction.

5. Choose Almanac > Automatic to automatically download and import an almanac file when you press "Create". You can also import an almanac manually and select it from the drop-down list. Supported almanac file formats are *.mdb, *.yum and *.alm.

6. Under "General" select "Show Report" if you want a report on the prediction. Saved reports are listed under "Reports" in the Satellite Availability Navigator and can be opened again from there as a PDF.

7. Press "Create" at the bottom of the property grid. Details of the new prediction will be shown underneath the map view. You will get a skyplot plus information on:
   - the satellite vehicles count
   - the satellite vehicles visibility
   - the DOPs
   - the elevation values
   - the azimuths

Manage Precise Ephemeris

Import Precise Ephemeris:
Precise ephemeris files must be in the following format:
- NGS/NOAA SP3-P (Position) format.
  The SP3-P format is an internationally accepted standard ASCII format for
  precise ephemeris.

There are several services that provide precise ephemeris data, e.g.:
- IGN Global Data Center
- IGS International GPS Service for Geodynamics

**Download Precise Ephemeris from the Internet:**
Alternatively, you can make use of the Internet Download function to download
and import precise ephemeris data. Downloaded data will be imported auto-
matically.

1. Go to the Precise Ephemeris tab.
2. In the ribbon press the Download button.
   Next to the Property Grid a Download tab opens up.
3. Select the date and time that fits your data.
4. Choose another download directory if you want.
   By default, the download directory will be your Downloads directory
   or the project folder if available.
5. Press the Start button at the bottom of the tab to initiate the down-
   load.
6. Follow the download progress in the Status section.
7. In case of errors check the availability of the files to be downloaded.
   Availability can comfortably be checked by clicking the hyperlink on
   the file name.
8. When Download is complete the data will automatically be imported
   and listed in the Precise Ephemeris tab.

☞ Leica Infinity offers a shortcut to access Internet Download.
You can also press the Download button in the GNSS Processing rib-
bon bar. The GNSS Manager opens in the Reference Stations tab.

**Manage Ionospheric Models**

**Import Ionospheric Models:**
Ionospheric model files must be in the *.ion format.

There are several services that provide ionospheric models, e.g.:
- AIUB (Astronomical Institute University of Bern)
- IGS International GPS Service for Geodynamics

**Download Ionospheric Models from the Internet:**
The daily ionospheric files from the University of Bern can be downloaded
from: ftb.unibe.ch/aiub/CODE

To download and import the files automatically proceed as follows:

   %yyyy/COD%www%d.ION.Zwith %www being the placeholder for
   a 4-digit GPS week and %d being the placeholder for the day of the
   week (Sunday = 0, Monday = 1 etc).
   On how to add a new reference station see above under "Manage
   Reference Stations".
2. Once defined select the station and click on Data > Download in the ribbon bar any time you need ionospheric files for a specific day.

3. In the Download tab define the period for which you want to download data and press the Start button at the bottom of the tab to initiate the download.

4. When download is complete the data will automatically be imported to your project. The ionospheric models will be added to the list in the Ionospheric Models tab.

### 4.2.3 Level-Processing

#### 4.2.3.1 Overview

**Level Processing** Level Processing is a purchased option. With this functionality the user can edit and process the level lines but also has the ability to perform 1D Network Adjustments in support of Level networks.

- **Adjust Level Line** opens the Level Line processing dialog to adjust the heights for the line.
- **Join** lets the user connect two or more level lines to a single level line. The lines are added by order of selection.
- **Split** lets the user divide a level line to two individual lines. This is important when considering level loops are not participating in a least squares adjustment.
- **Height Observation** is used to enter observed height difference between two points.
- **Add to Library Points** is used for adding turning points to be used for other project data.
- **Remove Adjustment** will reset the heights of the level line.

**Editing Level Lines**
The height of a level line start or end target can be edited.

Refer to the tutorial "How to process level data":
https://leica-geosystems.com/-/media/e1114ca40fda4640a2afc19292063ea8.ashx

"Working with level lines":
https://leica-geosystems.com/-/media/0e8524eb85c40ab926ee63b1cc226.ashx

Tutorial data can be downloaded in the Localisation Tool.

#### 4.2.3.2 Split Level Line
Split Level Line

In some cases its required to split a level line. When considering the data for Network Adjustments, a Level line which starts and ends on the same point must be split to be at least two lines.

To Split a level line, select the turning point from the booking sheet or the level line profile view:
1. From the ribbon bar choose the Split button.
2. From the right click context menu choose Split.

Join Level Line

In some cases its required to join level lines.

To join a level line, select the lines to be joined.
1. From the ribbon bar choose the Join button.
2. From the right click context menu choose Join.

Multiple lines can be joined at the same time. The lines are joined by order of selection, with the second and subsequent lines added in selected order.

Remember, when considering the height observations for Network Adjustments, a Level line which starts and ends on the same point must be split to be at least two lines.

Height Observation

A user can manually enter a Level height difference observation from the Level Processing ribbon bar Height Observation.

The user entered Height Observation is displayed from the Source under the Manually entered. node.

The Height difference together with its Absolute Standard Deviation, Relative Standard Deviation can be used for Network Adjustments.

Remove Adjustment

For any level line that has been processed, it is possible to remove the height adjustment that was applied to the turning points.

Select the level line and with context menu or ribbon bar select Remove Adjustment.

Level Line Data

Importing Level Data

All users have the ability to import level data, edit the starting height and create reports in a booking sheet format.

Importing Level Data

The Leica Infinity projects support levelled heights data, which can be imported from GSI, LEV or HeXML data formats.
All Level jobs imported to a project are listed from Source in the Navigator. Each job will indicate the level line data or level measurements that was imported by that job. Each job can hold many level lines or measurements.

**Level lines**

If the level data includes position and height information, then the level line will be displayed in the graphical View.

From the **Level** tab/ **Level lines** subtab of the Inspector, you will find all data from Level group. From the Level group, the user can view the list of all level line data. Each level line can be drilled in to, which displays the level data in a booking sheet format.

**Level measurements**

From the **Level** tab/ **Measurements** subtab of the Inspector, you will find all measurements. Measurements are listed by imported jobs. Drill in to display measurement booking sheet.

**Level Data in a Project**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Unprocessed Level Line" /></td>
<td>Unprocessed Level Line</td>
</tr>
<tr>
<td><img src="image" alt="Processed Level Line" /></td>
<td>Processed Level Line</td>
</tr>
<tr>
<td><img src="image" alt="User Entered start point" /></td>
<td>User Entered start point - indicates the starting height of the level line as entered on a level</td>
</tr>
<tr>
<td><img src="image" alt="Control Point start point" /></td>
<td>Control Point start point - indicates the user selected a fixed control point as the height to start the level line</td>
</tr>
<tr>
<td><img src="image" alt="Level Measured" /></td>
<td>Level Measured - these are the turning points of the level line or level measurements. By default, these points are not displayed in the points list. To convert a turning point or measurements to be available in the project, you need to convert that point to a library point.</td>
</tr>
</tbody>
</table>

**4.2.3.6.2 Level Lines**

**Level Lines**

Level data can be imported to a project. Its possible for the user to edit the name of a Level Line, as well the starting height.

Reports in a booking sheet format can be made for the Level Lines.

**Level Line List**

<table>
<thead>
<tr>
<th>Level Line variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level Line Id</td>
<td>Identification of the line(s) contained in a job.</td>
</tr>
<tr>
<td>Level Line variable</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Method</td>
<td>Observation method used with a line. The available methods are:</td>
</tr>
<tr>
<td></td>
<td>BF: BS-FS</td>
</tr>
<tr>
<td></td>
<td>BFFB: BS-FS-FS-BS</td>
</tr>
<tr>
<td></td>
<td>BBFF: BS-BS-FS-FS</td>
</tr>
<tr>
<td></td>
<td>BFBF: BS-FS-BS-FS</td>
</tr>
<tr>
<td></td>
<td>aBF: alternating BS-FS</td>
</tr>
<tr>
<td></td>
<td>aBFFB: alternating BS-FS-FS-BS</td>
</tr>
<tr>
<td></td>
<td>aBBFF: alternating BS-BS-FS-FS</td>
</tr>
<tr>
<td></td>
<td>aBFBF: alternating BS-FS-BS-FS</td>
</tr>
<tr>
<td>Staff One/Two Id</td>
<td>Identification of the two staffs that have been used for measuring the level line.</td>
</tr>
<tr>
<td>Start Point</td>
<td>The point id for the first measured point of the level line.</td>
</tr>
<tr>
<td>End Point</td>
<td>The point id for the last measured point of the level line.</td>
</tr>
<tr>
<td>Stations</td>
<td>Number of stations used in the level line</td>
</tr>
<tr>
<td>Observations</td>
<td>Total number of observations used in the level line</td>
</tr>
<tr>
<td>Delta Height</td>
<td>The height difference between start and end height</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the level line</td>
</tr>
<tr>
<td>ProcessingMethod</td>
<td>When the line has been processed, which error distribution method was used</td>
</tr>
<tr>
<td>Misclosure</td>
<td>The calculated height misclosure</td>
</tr>
<tr>
<td>Height Error / Point</td>
<td>The height misclosure devided by the number of stations</td>
</tr>
<tr>
<td>Total Dist Balance</td>
<td>Total distance balance considering all stations</td>
</tr>
<tr>
<td>Total Station Diff</td>
<td>Indicates the sum of all station differences as computed at each station in the level line.</td>
</tr>
</tbody>
</table>

### 4.2.3.6.3 Level Line Details

**Level Line Details**

The Level Lines are shown from the Inspector in a booking sheet format.

**Level Line Details**

<table>
<thead>
<tr>
<th>Level Line details</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point Id</td>
<td>The measured point id.</td>
</tr>
<tr>
<td>Type</td>
<td>The Type indicates what sort of data the Booking Sheet line refers to - Backsight, Intermediate or Fore-sight measurements.</td>
</tr>
<tr>
<td>BS</td>
<td>The Backsight staff reading. Depending on the observation method you have one or two backsights for one instrument setup. The starting BS measurement for a Level Line is always a Library point and can be edited.</td>
</tr>
<tr>
<td>Level Line details</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>IS</td>
<td>Intermediate staff readings. These are the points not part of the level line where a height value should be measured. Intermediate points are staff setups which are not part of the line but included in the line processing. The IS measurements are always Library points and can be renamed.</td>
</tr>
<tr>
<td>FS</td>
<td>Intermediate staff readings. These are the points not part of the level line where a height value should be measured. Intermediate points are staff setups which are not part of the line but included in the line processing. The IS measurements are always Library points and can be renamed.</td>
</tr>
<tr>
<td>Rise</td>
<td>When the BS - FS is positive</td>
</tr>
<tr>
<td>Fall</td>
<td>When the BS - FS is negative</td>
</tr>
<tr>
<td>Hz Dist</td>
<td>Distance between the level instrument and staff 1/2. Ideally the distances should be the same to cancel errors due to curvature and refraction.</td>
</tr>
<tr>
<td>Azimuth</td>
<td>For some XML imported level data there can exist preliminary coordinates and azimuth directions from the level stations to the BS-FS.</td>
</tr>
<tr>
<td>Easting</td>
<td>If the Easting has been recorded it can be displayed in the booking sheet.</td>
</tr>
<tr>
<td>Northing</td>
<td>If the Northing has been recorded it can be displayed in the booking sheet.</td>
</tr>
<tr>
<td>Height</td>
<td>The height of a point as calculated in relation to the Start Height. Control heights are fixed, while measured heights are updated when a level line is processed.</td>
</tr>
<tr>
<td>SD</td>
<td>This column shows the Standard Deviation of an observation recorded in repeat single, mean, mean+s or median measure mode. To edit one or more Standard Deviations highlight one or more staff reading and select Edit Standard Deviations... from the context menu.</td>
</tr>
<tr>
<td>Mean SD</td>
<td>The Mean Standard Deviation is the Mean of all the Standard Deviations calculated in the level line up to that point. It can be used for finding the average variation in the measurements, rather than the variation for each observation.</td>
</tr>
<tr>
<td>Measurements</td>
<td>Is the number of measurements taken by the instrument for that observation. This is displayed for measurement modes repeat single, mean, mean+s and median.</td>
</tr>
<tr>
<td>Spread</td>
<td>The spread is the difference between the highest and lowest observations in repeat single, mean, mean+s or median measure modes.</td>
</tr>
<tr>
<td>Level Line details</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Mode</td>
<td>The measure mode indicates how the observations were taken. Most levels have single, repeat single, mean, mean+s and median measure modes.</td>
</tr>
<tr>
<td>Diff BS1-BS2</td>
<td>For BF sequence measurements the difference between the first and second backsights is recorded. Ideally the difference should be 0.</td>
</tr>
<tr>
<td>Diff FS1-FS2</td>
<td>For BF sequence measurements the difference between the first and second foresights is recorded. Ideally the difference should be 0.</td>
</tr>
<tr>
<td>Station Diff</td>
<td>The station difference is used for BFFB (and aBFFB) sequence measurements. It is the sum of the differences in the backsights and foresights.</td>
</tr>
<tr>
<td>Total Station Diff</td>
<td>The Total Station Difference is a running total of the Station Differences for every station in the level line up until that point.</td>
</tr>
<tr>
<td>Dist Balance</td>
<td>The Distance Balance is the difference between the distance to the backsight point and the foresight point.</td>
</tr>
<tr>
<td>Total Dist Balance</td>
<td>The Total Station Difference is a running total of the Station Differences for every station in the level line up until that point.</td>
</tr>
<tr>
<td>Earth Curv Corr</td>
<td>Indicates whether the Earth Curvature Correction has been applied to the observations.</td>
</tr>
<tr>
<td>Expansion Coeffec-</td>
<td>The expansion coefficient is the a value used when applying staff corrections during line processing. This value varies depending on the type of staff used.</td>
</tr>
<tr>
<td>tient</td>
<td>Calibration Temperature</td>
</tr>
<tr>
<td>Temperature</td>
<td>The temperature during measurement is the T value in the formula. Enter the actual temperature determined while you were observing the level line to be processed.</td>
</tr>
</tbody>
</table>

4.2.3.6.4 Level Line Graph View

The Level Line view is a graphical representation of the data given in the booking sheet. The profile of the selected level line is visualized, i.e. the rises and falls resulting from calculated point heights. Since the distances between the instrument setups and the staff setups are known a proportionally correct overview on the line structure may be provided.

From within the Inspector the Level Lines list has by default the graph view.

To view the graph view of a level line when drilled in to a line, use the Level Line graph toggle at the top right view:
Navigating

You can zoom in / out and pan in the graph view. The mouse uses the same settings as when working in the main graphical display.

Selecting and viewing heights

Using the mouse you can hover and or select a turning point from the display.

<table>
<thead>
<tr>
<th>Measurement details</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point ID</td>
<td>The measured point ID.</td>
</tr>
<tr>
<td>Type</td>
<td>For the level measurements the Type is always Measure Only.</td>
</tr>
<tr>
<td>IS</td>
<td>Intermediate staff readings.</td>
</tr>
<tr>
<td>HZ Dist</td>
<td>Distance between the level instrument and staff.</td>
</tr>
</tbody>
</table>
4.2.3.6.6 Using Turning Points

The start, end and all IS Intermediate Sideshots are by default Library Points.

Create Library Point

For any Turning Point that you wish to use in the project, such as for the height of a TPS station, do the following:

1. Locate and select the point to view the data in the Property Grid
2. Press the Create Library Point icon, in the Point Id field
3. Press Apply

Now you will see the Point id can be edited - if you need, you can rename the point to use with other project data.

When converting a Turning Point to a Library Point and you edit the Point Id to be an existing Point in the project, this Level Measured will become part of the Point Averaging of the point.

4.2.3.6.7 Edit Level Standard Deviations

With each level staff reading a standard deviation is stored and can be displayed in the Booking sheet. Editing the standard deviation will modify the standard deviation of the levelled point height and the standard deviation of the height difference observation of the total level line.

To modify the standard deviation of level staff readings:

Highlight one or more lines in the Booking Sheet indicating level height readings and select Edit Standard Deviations... from the context menu. Enter the value that shall be applied to the selected staff readings and press OK. The
standard deviations for the point height and for the total level line will be updated.

### 4.2.3.7 Adjust Level Line

#### 4.2.3.7.1 Process Level Line Overview

The calculation of level lines is done in a Process Level Line window, that lets the user set and verify the results before storing to the project.

To open the Process Level Line wizard select **Adjust Level Line**:

1. From the ribbon bar Processing tab.
2. Right click from the mouse context menu.
3. Press the button from the Level Line **Properties**.

#### 4.2.3.7.2 Settings

This page shows the user the basic line information including a profile view.

The first step to process a level line is to:

1. Set the Process Method for how the height misclosure will be distributed to the turning points.
2. Set if its needed to use Staff Corrections.
3. Define the line tolerances you wish to flag the data for the quality control.

#### 4.2.3.7.3 Calculate

This page shows the entire line in a booking sheet format.

The second step to process a level line is to:

1. Define the start and / or end heights by selecting the Point Ids from the project data.
2. Press the button from the Level Line starting Point Id to choose the starting height.
3. Press the button from the Level Line ending Point Id to choose the ending height, if required. Scroll to the bottom of the line to do this.

When using an ending height, then the **Level Line Misclosure** and **Height Error / Point** will be shown on this page.

Press **Next** to continue to view and verify the results.

#### 4.2.3.7.4 Store Results

This page shows the user the detail level line information including a list of the new computed heights that will be stored when finishing the Processing.

The last step to process a level line is to confirm the results are within expectations and review the data before storing.
4.3 Surfaces

4.3.1 Overview

Surfaces that have been created on the instrument can be imported into Leica Infinity together with the measured raw data. Surfaces can be managed in the Surfaces module.

The surface module allows you to:
• create new surfaces by triangulation
• calculate volumes on the basis of existing surfaces

In Leica Infinity the surfaces computation is performed using the 3DReshaper kernel licensed to LEICA Geosystems AG by Technodigit SARL, 69400 Gleize, France. For detailed information refer to: www.3dreshaper.com.

Creating new surfaces

1. Select the entities from which you want to create a surface either graphically or from inside the Inspector or the Navigator.

Surfaces can be created from Points or Point Clouds or Point Cloud Groups.

☞ There are two ways how you can select entities graphically. Either press Shift and drag a rectangle with your mouse to enclose a selection of entities or press CTRL and draw a polygon (polygon selection). You cannot pick disconnected elements.

2. Press the New Surface button in the Surfaces ribbon bar. The surface type created is indicated in the ribbon icon.

☞ You can also create an empty surface and add points or point clouds to it later on.

The new surface will be created and added to:
• the Surfaces section in the Library of the Navigator. If the Surfaces sub-section does not yet exist, it will be created.
• the Surfaces section in the Surfaces tab of the Inspector.

☞ Surfaces are always created with a default name. To change the name, click onto a surface in the Navigator or in the Inspector and adapt its name in the Property Grid.

☞ To see only the surface’s triangles in the graphical View, you can switch off the underlying point cloud group(s) via the “eye” in the Navigator.
Adding and removing points or point clouds to or from a surface

To add or remove points or point clouds to or from a surface:

1. In the Inspector go to the **Features** tab and select the points or the point clouds or point cloud groups to be added to or removed from a surface.
   In the Navigator points can be selected from the **Library** section, point clouds can be selected from inside the **Source** section or from the **Library** section if they belong to a point cloud group.
   Alternatively, you can also select points or point clouds in the graphical View.

2. Press the **Add to** button in the **Surfaces** ribbon bar and select a surface from the drop down list or select **Add to Surface...** from the context menu.
   or:

   Press the **Remove from** button in the **Surfaces** ribbon bar and select a surface from the drop down list or select **Remove from...** from the context menu.

   Points can also be removed from inside the **Surfaces** tab of the Inspector. Drill down into the surface from which one or more points shall be removed and further down into **Points**. Select the points to be removed.

   Only points identified by point Id (so-called **Library points**) can be selected to be added or removed from a surface. Cloud points are by default not identified by any point Id and can thus only be selected to be added or removed from a surface individually if either library point have been created from them before or when they belong to a line or area. You can select a sub-set of cloud points, though, graphically and add or remove it to or from a surface.

Adding and removing lines/ areas to or from a surface

In Leica Infinity you can add lines as breaklines and areas as exclusion areas or to an existing surface. A single area can also be added as a boundary, with the effect that the border of the area becomes the new boundary of the surface.

Any line/ area in your project, for example a line defining the sideline of a road or the top of a ridge or an area defining the contours of a building, can be added to a surface as a breakline, exclusion area or boundary.

This will force the triangulation of your terrain model to be rebuilt by taking the line/ area into account. The line/ border lines of an area become(s) triangle edges. As a result, there will not be any incorrect interpolation across the resulting breakline, exclusion area or boundary.

To add a line / area to a surface:
1. Right-click onto the line/ area to be added to the surface either in the graphical View or in the Navigator or in the Inspector.

2. For **lines** select 📌 Add to Surface as Breakline from the context menu. For areas select either 📌 Add to Surface as Exclusion or 📌 Add to Surface as Boundary from the context menu. If there exists more than one surface in your project, select the surface to which the line/ area shall be added.

Alternatively, go to the **Surfaces** module and press the 📌 Add to button in the ribbon bar to select a surface from the drop down list. For areas decide whether to add the area as **Exclusion** or **Boundary**.

☞ It is possible to add only one outer boundary to an existing surface.
☞ It is not possible to add different objects at the same time to a surface.

**To remove a line/ area from a surface:**

1. Right-click onto the line/ area to be removed from the surface either in the graphical View or in the Navigator or in the Inspector.

2. Select 📌 Remove from... from the context menu. If the line/ area has been added to more than one surface, select the surface(s) from which the line/ area shall be removed.

Alternatively, go to the **Surfaces** module and press the 📌 Remove from button in the ribbon bar to select a surface from the drop down list.

### 4.3.2 Surfaces Types

**Surfaces Types**

In Infinity a user can create surfaces from point sources. Working with point cloud data, the results of surfaces can be directly effected by the properties of the point cloud data - point density and the location from where scan measurements are made from can result in holes and effects where the surface routine cannot determine the above or below surface of the triangles to be computed. To best manage the situation of cloud point properties, Infinity offers three triangulation methods to better allow the user to determine which method provides the best results.

The three surface types are:

- **Refined**
- **Regular**
- **Interpolated**

The Surfaces methods are based on the 3DReshaper engine. There are many parameters that are already considered and defined with the three methods that Infinity uses.

**Refined**

Use this method:

- For clean point cloud data that is consistent in density.
- Uses the meshing parameters and then refines the mesh to generate the most details.

This surface method is created with following steps:
Determine initial mesh
• Minimum triangle size (Regular sampling) example used 0.08m
  • Consider if this is set to zero, this uses all the points.
• Maximum triangle size (Hole Detection) example used 3.0m
  • Sets the size for which the maximum triangle is created to fill gaps
  • A hole remains when the points are not geometrically consistent (e.g. the surface does not know which direction it should follow, change of direction is high)

Hole Filling
• Not adding new points, or curvature filling

Refine the mesh
• Takes the points of the cloud and compares to existing mesh
• Fit the mesh adding triangles where the deviation is greater than 0.01m
• Remove points that are too far from the mesh

Remove spikes

Regular
Use this method:
• For clean scan data but where point density is less consistent e.g. long distance between near and far cloud points.
• Uses the meshing parameters Min / Max triangle size, and will appear most evenly
• This surface can be edited in the Properties – user can change the min / max values and apply.

This surface method is created with following steps:

Determine initial mesh
• Minimum triangle size (Regular sampling) example used 0.08m
  • Consider if this is set to zero, this uses all the points.
• Maximum triangle size (Hole Detection) example used 3.0m
  • Sets the size for which the maximum triangle is created to fill gaps
  • A hole remains when the points are not geometrically consistent (e.g. the surface does not know which direction it should follow, change of direction is high)

Hole Filling
• Not adding new points, or curvature filling

Remove spikes

Interpolated
Use this method:
• For scan data that is noisy and not consistent.

This surface method automatically calculates the meshing parameters to interpolate a best surface.

☞ This is the same method that was used in Infinity v1.1. Projects with surfaces from the previous version can be used in Infinity v1.2. As well a user can generate the same surface as was possible already before.
4.3.3 Surface Properties

Surface Properties

In the **Surface Properties** you can:

- change the name (Id) of the selected surface
- assign the surface to a different **Layer**
- change the **Styling** independent of the overall layer style

In the **Details** section you are informed about:

- the total **Number of Triangles**, **Triangulation Points** and **Triangle Edges**
- the total number of **Breaklines** and **Exclusion Areas** that have been added to the selected surface
- the height of the topmost triangulation point (**Max. Height**) and the height of the lowest triangulation point (**Min. Height**)
- the sum of all triangle areas (**Area**)
- the area covered by a surface projected to the ground plane (**Area 2D**)
- the perimeter as defined by the outer boundary of the selected surface (**Perimeter**)
- the perimeter as projected to the ground plane (**Perimeter 2D**)

4.3.4 Surface Contours

Surface Contours

It's possible to create contours for a selected surface.

- Select a surface
- From the ribbon bar select Contour
- From the Create Contour window edit the settings to define the contour display.

Create Contour

When creating a set of contours for a surface the following settings need to be considered:

**Surface**

- Displays the selected surface including the height details.

**Contours**

Set the values to determine the drawing of the contour:

- **Minor Interval** defines the distance between minor contours that are to be drawn.
- **Major Frequency** defines when the major contour is drawn. Usually this setting would be set at 5 or 10.

With a Minor Interval of 10 and a Major Frequency of 5 the contours will draw every 10 meters but at every 50 meters a major contour line is drawn.

**Contour Styling**

- Define the line style and colour settings.

**Exporting Contours**

Contours can be exported to DXF/DWG and to XML.

Set the export flag in Layer manager to determine if the contours are written to the DXF/DWG file.
4.3.5 Volume calculations

For calculating volumes a **reference surface**, a **ground surface** and, depending on the selected calculation method, an **intersecting plane** have to be defined.

**Reference surfaces:**
A reference surface is the surface of the stockpile/ cavity for which a volume shall be calculated. Cavities are negative stockpiles.

☞ If you have selected a surface before in the Inspector or from inside the Library section of the Navigator then the selected surface will automatically be taken as the reference surface for which you want to calculate the volume.

**Ground surfaces:**
A ground surface for simple stockpile computations is the surface at the bottom of the selected stockpile which is created by triangulation among the points which define the outer boundary of the stockpile. For **cavities** the ground surface is the surface covering the cavity. It is computed in the same way as for stockpiles. If you choose to compute a **Surface to Surface** volume then the ground surface is the second selected surface (i.e. the surface that you select under **To Surface** in the **Surface to Surface** method, for further information on this method read below).

**Intersecting planes:**
To define an intersecting plane for a volume calculation choose a point from your current project or define a height through which a **horizontal** plane shall be calculated for intersecting the surface. Volumes will be calculated above and below the intersecting plane.

**Stockpile**
1. Press the Stockpile button in the Surfaces ribbon bar. An additional window opens called Volumes: Stockpile.
2. In the Input section press the button to select the Reference Surface for the calculation.
3. Press the Calculate button at the bottom of the Volumes: Stockpile window to compute the Stockpile Volume. The result will be shown to you in a Results section.

**To Point**
1. Press the To Point button in the Surfaces ribbon bar. An additional window opens called Volumes: Surface to Point.
2. In the Input section press the button to select the Reference Surface for the calculation.
3. In the From Point section select a point in your project that shall serve as the reference point for calculating the intersecting horizontal plane.
4. Press the Calculate button at the bottom of the Volumes: Surface to Point window to compute the volume above and below the height of the selected reference point. The result will be shown to you in a Results section.

**To Height**
1. Press the button in the Surfaces ribbon bar. An additional window opens called Volumes: Surface to Height.

2. In the Input section press the button to select the Reference Surface for the calculation.

3. In the Height section enter a height that shall serve as the reference height for calculating the intersecting horizontal plane.

4. Press the Calculate button at the bottom of the Volumes: Surface to Height window to compute the volume above and below the selected height. The result will be shown to you in a Results section.

Surface to Surface

1. Press the button in the Surfaces ribbon bar. An additional window opens called Volumes: Surface to Surface.

2. In the Input section press the button to select the Reference Surface for the calculation.

3. In the To Surface section press the button to select a surface from your current project that shall serve as the ground surface for the calculation.

4. Press the Calculate button at the bottom of the Volumes: Surface to Surface window to compute the volume between the selected surfaces. The result will be shown to you in a Results section.

For all four methods you can:

Select different Input data and execute another volume calculation within the same Volumes window. The result will be added on top of the result(s) computed before. Each Results section can be collapsed or closed individually.

Press the Report button at the bottom of the Volumes window to generate a report on the Results.

4.3.6 Cut Fill Maps

Cut Fill Maps is a Surfaces function that allows the user to compare a measured surface to a design surface, called reference surface in Leica Infinity. Height differences are colour-coded and shown in a so-called Cut Fill Map. The Cut Fill Map is saved to the database as a Leica Infinity Object. By default, it shows in blue volumes that need to be “cut” to reach the level of the reference surface. Volumes that need to be “filled” are indicated in red.

Sample of a road design:
How to calculate a Cut Fill Map?

1. Go to the Surfaces module and select "Cut Fill Map" from the Surfaces ribbon bar. The "New Cut Fill Map" property grid opens up next to the regular Property Grid.

2. Select a Reference (design) Surface and a Measured Surface as Input to the cut/ fill calculation. You can also first select a reference (design) and a measured surface in the Navigator or the Features Inspector and then select "New Cut Fill Map" from the context menu. In this case the property grid opens up and reference and design surface will already be selected. The surface you select first will be identified as the reference surface. The second surface you select will automatically be identified as the measured surface.

3. Under Settings select whether you want to compute only "Height differences" or height differences with respect to given "Tolerance" values. If you select "Tolerances" specify the upper and lower tolerance values, too and define a "Min. Segment Distance". Via the Segment Distance value you can simplify the Tolerance Lines. The Tolerance Lines indicate the areas in the map where material has to be cut or filled. These lines can be exported for stake-out, but if they are too detailed the controller might not be able to handle them.
4. Under **Styling** define which colours shall be used for indicating cut/fill areas.
By default, blue will be used for volumes that need to be "cut", red will be used for volumes that need to be "filled".

Default values for Settings and Styling can be defined in the Surfaces Parameters.
Select "Parameters" from the Surfaces ribbon bar to open the dialog.

To reset Settings and Styling to the factory defaults go to the Backstage (File tab) > Info and Settings > Surfaces and Contours and press the Defaults button.

5. Under **Material factors** you can enter factors by which the cut/fill volumes shall be multiplied. The material factors are used to better estimate the volume of material to move.

6. Press "Create" at the bottom of the property grid to create the new Cut/Fill Map.

"Cut Fill Results" and "Tolerance Results", if tolerances have been used for the calculation, will be added as properties of the cut/fill map to the Property Grid and the Features Inspector.

**Inspecting Cut Fill Results**

* In the Property Grid press the button to see a histogram of the calculation results.
• In order to generate a report on one or more cut/fill maps, select the maps in the Navigator or the Inspector and either press Reports > Cut Fill Map Report from the Home ribbon bar or right-click and select Cut Fill Map Report from the context menu.

• In order to focus the graphical View on just showing the Cut Fill Map make other objects invisible by pressing the symbol in the Navigator.

• In the Layer Manager you can select different colours for the so-called “Tolerance Lines Upper” and “Tolerance Lines Lower” to enhance their visibility in the graphical View. You can also adapt the line width or change the line style. If you switch off the Cut Fill Map itself, you can focus on the Tolerance Lines in the graphical View.

Workflow
A typical workflow making use of "Cut Fill Maps" would be:
1. Measure, for example, a road that is being built based on a given design.
2. Import the measured data and the design surface from CAD to Leica Infinity.
3. Calculate the surface resulting from the measurements.
4. Compare the surface to the design by calculating a Cut Fill Map. Here the user can make use of tolerances by entering the values. The Cut Fill Map will only show areas and volumes to be cut or filled that are beyond the entered tolerance values. The areas where material needs to be moved are indicated by contour lines called "Tolerance Lines Lower" and "Tolerance Lines Upper". These contour lines can be exported to DXF.
5. Use the exported upper and lower Tolerance Lines for stake-out of the out-of-tolerance areas in the field.
Illustration showing Tolerance Lines Upper and Lower where material still needs to be moved to reach the design surface:

The styling of the Tolerance Lines has been modified in the Layer Manager to enhance their visibility against the Cut Fill Map itself.
To use the lines for stake-out in the field make use of a **Min. Segment Distance** to simplify the lines:

4.3.7 **Trim Triangles**

**Trim Triangles**

It is possible to remove the triangles at the outer border of a surface.

Removing triangles will not create holes.

**How to trim triangles:**
1. Select at least one triangle at the outer border of a surface. All existing selection shortcuts are available.

2. Click Trim Triangles, either from the ribbon bar or from the context menu.

See also:
Graphical View

4.4 Point Clouds

4.4.1 Overview

Point Clouds

When a job contains point cloud data, that is imported into Leica Infinity, this special kind of data can be managed in the **Point Clouds** module.

If you scanned buildings, industrial plants or other huge objects you probably had to take your point clouds on several stations all around the object and it becomes necessary to **group** the single point clouds as belonging together, defining one object. Especially, when you scanned more than one object in a job and when you had to scan from several stations around each object, it becomes necessary to group the scan data. The grouped data also gives you a solid basis for future surface calculations.

Creating new point cloud groups

**To group point clouds into a point cloud group:**

1. In the Inspector, go to the **Features** tab and open the **Point Clouds** section.
2. Select the point clouds to be grouped and press the **New Point Cloud Group** button in the **Point Clouds** ribbon bar.

The new point cloud group will be created and added to:

- the **Point Cloud Groups** section in the **Library** of the Navigator. If the Point Cloud Groups sub-section does not yet exist, it will be created. For each point cloud group, the single scans belonging to it are listed.
- the **Point Cloud Groups** section in the **Features** tab of the Inspector.

Point Cloud groups are always created with a default name. To change the name, click onto a point cloud group in the Navigator or in the Inspector and adapt its name in the Property Grid.

You can also create an empty point cloud group and add single point clouds to it later on.

Adding and removing point clouds from a point cloud group

**To add point clouds to a point cloud group:**
1. In the Inspector, go to the **Features** tab and open the **Point Clouds** section.
2. Select the point cloud to be added to a point cloud group and press the **Add to** button in the **Point Clouds** ribbon bar.

or:
1. In the **Source** section of the Navigator, go to the station setup containing the point cloud to be added.
2. Select the point cloud and press the **Add to** button in the **Point Clouds** ribbon bar.

☞ If there is more than one point cloud group available in your project, select one from the drop-down list.

**To remove point clouds from a point cloud group:**
1. In the Inspector, go to the **Features** tab and open the **Point Clouds** section.
2. Click on the arrow next to **Point Cloud Groups** to open the category.
3. Click on the arrow next to the point cloud group from which one or more point clouds shall be removed.
4. Select the point cloud(s) to be removed and press the **Remove from** button in the **Point Clouds** ribbon bar.

or:
1. In the **Library** section of the Navigator, go to **Point Cloud Groups** and expand the tree for the point cloud group from which one or more point clouds shall be removed.
2. Select the point cloud(s) to be removed and press the **Remove from** button in the **Point Clouds** ribbon bar.

**Cleaning points**

If your point clouds contain random points, i.e. points that have accidentally been taken while scanning a main object, then these random points can be identified by Leica Infinity and cleaned from the point cloud data in your project. As a consequence, you will only see the relevant point cloud data in the graphical View.

**To clean points:**
1. Select a point cloud or a point cloud group either in the Inspector or in the Navigator.
2. Press the **Clean Points** button in the ribbon bar to clean accidentally taken points from your point cloud data.

In the Property Grid of the point cloud and /or the point cloud group, you will see that the total number of points decreases to just count the relevant points.
Deleting points

To delete cloud points:
In the graphical View, select the cloud points to be deleted.

Press the Delete button to delete the selected cloud points.

 Colouring Modes
Select between:
• RGB colouring (natural colours).
• Intensity.
• SNR (Signal-to-Noise Ratio).
• Single Color.

For Intensity and SNR you can select a Color Scale from the drop down list. By default, MultiHue is set.

For Single Color representations you can select whether the representation shall be By Layer (default) or by a user-selected colour.

For all Colouring Modes the last used settings will be remembered when you open another project. Just press the button to use the same settings again. The icon indicates which settings have last been used. By default, the project data will be displayed in RGB mode.

Filtering Points

To reduce the point density in the graphical View:

Press the Filter button in the ribbon bar and select a percentage to which the point density shall be reduced from the drop-down menu.

The last used setting will be remembered when you open another project. Just press the button again to filter the points using the same percentage. The icon indicates which percentage has last been used. By default, the project data will be displayed with 100%.

4.4.2 Point Cloud Properties

In the Point Cloud Properties you can:

- Edit the Point Cloud Id and enter a description.
- Select a Coloring Mode from the drop-down list:
  for Intensity and SNR choose a colour palette, for Single Color choose a colour or decide on the layer colour.
- Press the button and select a different Position Source.
- Press the button and select a Panorama image to be assigned to the point cloud.

☞ You can only assign panoramas that have been taken on the same station as the point cloud.

You are informed about:
4.4.3 Clipping

Clipping allows the user to hide the cloud points with defined clipping objects like Plane, Slice or Box. Clipping does not delete the points. Multiple clips are permitted. Use zooming, rotating and panning when creating a clip for better data visualisation in 2D or 3D.

Once a clip has been created, you can remove the clipping and restore the visibility of all point cloud data by selecting the Reset Clips button in the ribbon bar.

Plane
Plane hides points beyond a single plane.

A single plane can be created along a specified axis or defined by three points.

To hide points by plane:
1. Press the Clip button in the ribbon bar and select Plane from the dropdown menu.
   An additional window opens called Clip.
2. Select Single point or Three points method to create the plane.
   For the Single point method define the Easting, Northing or Height axis for the plane orientation.
3. To create the plane with the Single point method, a temporary plane representing the clip will appear in the graphical view and follow the cursor. Click once to position the plane. Points on one side of the plane are hidden from the view.
   Use Invert view to change the points visibility between plane sides.
4. To create the plane with the Three points method, select three points in the graphical view to define and orientate the plane.
   Points on one side of the plane are hidden from view.
   Use Invert view to change the points visibility between plane sides.
5. You can move the plane along the current axis by selecting the red indicator and holding the left mouse button.
6. Press Create to save the current clip.

Slice
Slice hides points outside of two parallel planes.

Two parallel planes can be created along a specified axis or defined by three points plane and slice width.

To hide points outside of a slice:
1. Press the **Clip** button in the ribbon bar and select **Slice** from the drop-down menu. An additional window opens called Clip.

2. Select **Single point** or **Three points** method to create the Slice.
   For the Single point method define the Easting, Northing or Height axis for the slice orientation.

3. To create the slice with the **Single point** method, a temporary plane representing the clip will appear in the graphical view and follow the cursor.
   Click once to position the first plane.
   Now the second temporary plane will follow the cursor.
   Click again to position the second plane.
   Points outside of the slice are hidden from view.

4. To create the slice with the **Three points** method, select three points in the graphical view to define the first plane.
   Now the second temporary plane will follow the cursor.
   Click again to position the second plane.
   Points outside of the slice are hidden from view.

5. You can resize the slice by selecting the red indicator and holding the left mouse button or change the slice width in the Clip window.
   To move the slice, hold down the CTRL key and left-click the mouse at the same time.

6. Press **Create** to save the current clip.

---

**Box**

Box hides points outside a 3D box.

**To hide points outside of a box:**

1. Press the **Clip** button in the ribbon bar and select **Box** from the drop-down menu.
   An additional window opens called Clip.

2. Define the Easting, Northing or Height axis or None.

3. Select a point in the graphical view to represent the first corner of the desired 3D limit box.
   A temporary line will be attached to the cursor.

4. Select a second point representing the opposite corner of the desired limit box.
   The resulting rectangle is projected onto the work plane.

5. Select a third point to determine the last box dimension.
   Points outside the boundaries of the box are hidden from the view.

6. You can resize the box by selecting the red indicators and holding the left mouse button or by changing dimensions in the Clip window.
   To move the box, hold down the CTRL key and left-click the mouse at the same time.
   You can rotate the box by selecting the purple indicators and left-click the mouse.

7. Press **Create** to save the current clip.

☞ If all points are hidden after applying the box clip, it is likely that the limit box is defined in an incorrect position. In this case, use **Cancel** and try again.
4.5 Imaging

4.5.1 Overview

Imaging

Leica Infinity supports the import of images to a project from SmartWorx and Captivate jobs and general images. It is also possible to import GeoReferenced images to display as background maps.

Link or unlink images to or from points, lines or areas.

Create Image groups that allow you to compute points from the grouped images. These image groups only support images taken with Leica TPS instruments that include the Imaging option.

Images are also displayed in Property Grid of the object(s) they are linked to. If you select an object to which one or more images are linked then the thumbnail(s) of these image are displayed in the Properties.

Inspecting images

From the Inspector Imaging tab, there are two groups to help you work with images.

- **Image Groups** - showing user created sets of images taken from Leica TPS stations where you can select common targets in the images which to compute a 3D point.
- **Images** - sorting the images by type or to what the image is related to.
- **Geo Referenced Images** - images fixed in position.

Display options

It is possible to switch between a detailed list of images and a thumbnail strip of images. You can view the selected image in a resizable Image viewer that is part of the Inspector.

To switch between a detailed list of images and a thumbnail strip of images:
• Press the Show Thumbnails icon to see a strip of thumbnails in the context view.
• Press the Show Details icon to switch to displaying a list of detailed information on the image properties.

If you select an image in the Content view from the strip of thumbnails or from the detailed list of images it can be seen in the Image Viewer window.

To open/ close the Image Viewer:
1. Select an image in the Content view.
2. Press the Open Image Viewer icon to see the image in a separate window.
   The image fits to the window size.
3. To close the image viewer, press the Close Image Viewer icon.

You can shift the separator between the Content view and the Image viewer to change the size of the display.

Linking/ Unlinking of images
Images can manually be linked to or unlinked from points or lines or areas. They cannot manually be linked to or unlinked from point clouds.

To link images to an object:
1. In the Imaging tab of the Inspector, select any image that is not linked to the object yet.
2. Press the Link button in the Images ribbon bar and select from the drop-down menu whether you want the image(s) to be linked to a Point or to a Line or Area.
3. In the Link image window select the object to which you want to link the image(s). You can also go and search for an object.
4. Press the Link button to link the image and leave the dialog with OK.

To unlink an image from an object:
1. Select an image
2. Press the Unlink button in the Images ribbon bar.

☞ An image can be linked to more than one object and an object can have more than one image linked to it.

Deleting images
To delete images:
1. In the Imaging tab of the Inspector, select the image(s) to be deleted.
2. Right-click into the selection and select Delete from the context menu or press the button in the very top left corner of the main window.

4.5.2 Image Properties

Image Properties
In the Image Properties you are informed about:
• the Name of the image
• any optionally entered Description. Enter another description if necessary.
• the Date and Time when the image was taken
• the type of Camera that the image was taken with
• the Id of the Station on which the image was taken
• the Id(s) of the object which the image is linked to

The image itself is displayed as a thumbnail, too.

4.5.3 Image Groups

Image Groups
The Image Group is an object that is stored to the project and must be used for working with images to create image points.
☞ It is important to know, that points computed from Image groups are bounded to that image group. If the Image group is deleted, the image points will also be deleted.

Creating new image groups
To group images into an image group:
1. In the Inspector go to the Imaging tab and open the Images section.
2. Select the images to be grouped and press the New Image Group button in the Imaging ribbon bar. Or use the mouse right click context menu.

The new image group will be created and added to:
• the Image Groups section in the Library of the Navigator. If the Image Groups sub-section does not yet exist, it will be created. For each image group the TPS stations with images belonging to it are listed.
• the Image Groups section in the Imaging tab of the Inspector.
☞ Image groups are always created with a default name. To change the name click onto an image group in the Navigator or in the Inspector and adapt its name in the Property Grid.
☞ You can also create an empty image group and add single images to it later on.

Adding and removing images from an image group
To add images to an image group:
1. In the Inspector go to the Imaging tab and open the Images section.
2. Select the image to be added to an image group and press the Add to button in the Imaging ribbon bar.
☞ If there is more than one Image Group available in your project, select one from the drop-down list.

To remove images from an image group:
1. In the Inspector go to the Imaging tab and open the Images section.
2. Click onto the arrow next to the image group from which one or more images shall be removed.
3. Select the images to be removed and press the Remove from button in the Images ribbon bar.
4.5.4 Image Viewer

The **Image Viewer** is used to view the Image Group and to select and compute points from images.

- The user can define maximum 4 TPS stations to be viewed at one time.
- Each TPS station view will list the images that were taken from that station.

**Open Image Viewer**

**To open the image viewer:**

Press the **New Point** button in the **Imaging** ribbon bar and choose the Image Group you wish to measure points in.

or

From the **Library** select the image group and from the mouse right click context menu select **New Point**.

or

Selecting the image group and form the mouse right click context menu select **Open Viewer**.

A new window will open in the main display window and look like this:

![Image Viewer Window]

From the ribbon bar you can set how many stations are to be displayed.

- Single
- Split vertically
- Quarter
- View
Image Points

If your project contains two or more TPS stations with either panorama images or overview images and these images cover the same object, it's possible to compute points from these images. By selecting a common target from an image, the forward intersection from each TPS station will arrive at the intersection point. This intersection point is computed in 3D. These points from images are stored to the Library Points list and have the point role Computed.

To create points from images, there are only a couple of steps:
1. Create the image group.
2. Open image viewer.
3. Select the target(s).

☞ It's important to know, that points computed from image groups are bounded to that image group. If the image group is deleted, the image points will also be deleted.

Compute Image Points

To compute image points:

Press the **New Point** button in the **Imaging** ribbon bar and choose the Image Group you wish to measure points in.

Or from the **Library** select the image group and select **New Point** from the mouse right click context menu.

The New Point property grid is opened and the image viewer displays the stations and images that are part of the image group.

1. The mouse cursor is in the selection mode. Use the mouse to zoom in or out and to pan in the images to identify the target.
2. Each image will be marked with the pixel selection.
3. Once the target has been selected in two or more images the projected point is shown.
4. Press Create to store the point to the project.

Image Point Settings

The computation of image points is following the same principle as with point averaging. The user sets a tolerance threshold for which the computed 3D point quality is acceptable and when the results are within this tolerance a position is computed. When the 3D accuracy is outside of that tolerance, then no point is computed.

Set the image point accuracy from the **Info & Settings > Points & Angles** options page.
4.5.6 Point Clouds from Images

4.5.6.1 Overview

Overview

Leica Infinity Point Clouds from Images provides a solution utilising images to create quality 3D content. With Infinity v3.0, photos need to be taken from the NADIR position and include geotags in the exif information. Most UAS/UAV devices provide such data.

The Point Clouds from Images module utilises images to:
• Create Dense Point Clouds.
• Create Digital Surface Models (DSM) and Orthophotos.

The Dense Point Clouds can be used to:
• Create surfaces, contours and compute volumes.
• Draw Features (Lines, Splines, Areas).
• Measure distances between objects.

The Digital Surface Models are used to create orthophotos but can also be used to compare between different models.

Orthophotos can be used as background maps in Infinity. They can also be exported to onboard software, to Leica ConX as well as to third party software.

Working with Images

The processing works from an Image Group which is the container to keep the image data organised.

The main goal of image processing is to arrive at a point cloud and an orthophoto. The procedure to process the data comprises of three steps. Working from an image group the user will:
2. Create Dense Point Cloud. Dense point cloud filtering (optional).
3. Create DSM & Orthophoto.

These steps are what we call tasks and these tasks are shown in the application. There are two approaches to processing image data:
1. Process each task manually, step by step. This allows the user control each step and verify results.
2. Choose the end data result, such as Dense Point Cloud, and all individual tasks are computed automatically.

Manually processing by steps:

Each step is related to the next step. Only if the previous step has been stored, can the next step be started. This is the most flexible method to allow the user to analyse and evaluate the quality of the output. The quality of the output will affect the output of the next step. Refer to "Workflow" for further information.

Once stored, the output of each step (Sparse Point Cloud, Dense Point Cloud, DSM and Orthophoto) will be available in the View and the numerical results in the Inspector.

When choosing the end results as the goal, such as importing the image data and wanting to derive an Orthophoto, choosing DSM & Orthophoto will process the data in such a way to arrive at the orthophoto. Each step is processed and stored automatically.

The user can view the progress of the tasks from the Inspector as well as by the dedicated Task Manager.
Imaging Inspector

From the **Inspector › Imaging** tab, you can access **Imaging Results**. The view is split in two panes, the **Results** pane and the **Task** pane:

The **Task Manager** is launched from the quick access tool bar icon. Here you can see all tasks processed, in progress or to be processed when using a worker host machine.

Once the processing task is completed, it appears in the **Results** pane.

Once the user starts a processing task, it runs in the background. The user can continue working with Infinity or even change projects and submit another task to the queue, that starts as soon as the previous task ends. The user can view progress of each task in the **Task Manager**. If the task is completed in the meantime, the result will be moved to the **Results** pane, for the user to store.

Processing tasks create an asset directory on the machine where the processing takes place. This directory can be found at:

*C:\Users\[USER]\AppData\Local\Leica Geosystems\Infinity\mvs\assets\*

**Image Acquisition Suggestions**

In order to get a good quality result, it is of main importance to acquire the dataset to be processed correctly. A poor quality dataset may lead to poor results or even to failed processes. Infinity is able to handle metric cameras, non-metric cameras and to process nadiral geotagged images captured by UAS or any similar platform.

The following guidelines are recommended for a good outcome:
• Use digital cameras with a fixed lens, or keep it fixed throughout the acquiring phase.
• Use focal lengths between 20 mm and 80 mm (in 35 mm equivalent).
• Capture images at a good resolution: 10 megapixel or more.
• Use 70%-80% forward overlap and 65%-80% side overlap.
• Avoid blurry images.
• Avoid low textured, moving or reflective objects.
• Avoid regions with shadows.
• Do not manipulate original images, for example crop or rotate them.
• Use Control points to improve the orientation.
• Use Check points to assess results accuracy.

☞ Fisheye, ultra-wide and macro lenses as well as hyperspectral images are currently not supported.
☞ Corrections for the rolling shutter effect are currently not supported.

4.5.6.2 Image Processing Settings

Image Processing Settings

Default settings are intended to be the most suitable solution in the more common cases. Nevertheless, for achieving a better final accuracy or for dealing with specific acquisitions, they have to be often tuned accordingly.

The following settings are available for the image processing:
Store results immediately after computing
The results will be stored without any manual intervention from the user.

Processing Resolution
The processing resolution is the image resolution, that is used for all the processing steps:
- **Full** resolution uses the original image size for the processing.
- **Half** resolution uses the images downscaled from the original size by a factor of 4.
- **Quarter** resolution uses the images downscaled from the original size by a factor of 16.
- **Eighth** resolution uses the images downscaled from the original size by a factor of 64.
This setting has to be chosen as a trade-off between the final desired quality and the processing time, considering the original image resolution as well. A full resolution process produces more accurate results, exploiting all the information contained in the acquired images, although requiring more time for generating the results.

**Orientation**

**Camera Pose Accuracy**
This parameter is used to weight properly the GNSS information of the acquired images during the orientation step. It is related to the accuracy of the position of each image and not to the accuracy of the attitude of the UAS itself:

- Use a higher value when the UAS has a low-end GNSS receiver, no accurate RTK position or no raw data collection for post-processing.
- Use a smaller value when the UAS has an accurate RTK GNSS sensor or when collecting raw data for post-processing.

This setting strongly affects the orientation results and so all the following steps. Attention has to be paid for the correct choice of it.

Poor results (noise in the Sparse Point Cloud) might be due to a current camera accuracy, either bigger or smaller than the one set by the user. For instance, when dealing with a low quality RTK position (because of interruption of the connection with the reference station or because of the acquisition environment), poor results can be generated due to an actual Camera Pose Accuracy lower than the expected. In this case a bigger value is of advantage for a better result.

**Control Point Accuracy (3D)**
The use of Control Point is recommended for:

- Accurate georeferencing of the images and the deliverables that depend on them.
- Calibrating a camera or for improving the existing calibration.

This parameter is used to weight the control point coordinates during the orientation step. It should reflect the real accuracy of the measured points.

This setting strongly affects the orientation results and so all the following steps. Attention has to be paid for the correct choice of it.

This setting is used only for control points that do not have a coordinate quality, so when using a point that already has a CQ 3D, this setting is ignored for that point.

**Control Point Marking Accuracy**
This parameter refers to how accurately a control point can be marked on the image. It is used to formulate the weight of the image observations of the control points in the orientation step. If for any reason control points cannot be marked on the images with a subpixel accuracy, for example blurry images, this value has to be increased to make it more realistic.

**Camera Calibration Optimisation**
This parameter is used to compute or to improve the interior parameters of the camera.
• **Automatic:** The parameters of the interior orientation: Focal Length, Principal Point and Distortion Model will be treated as unknowns. The parameters are estimated starting from the initial value eventually read in the image metadata (self-calibration will be conducted). On the contrary, if any values have been entered by the user, refer to “Optimise Orientation”, then **Automatic** means that no self-calibration takes place. The user-entered parameters are kept fixed during the orientation of the images.

• **User Defined:** Using the **User Defined** option, self-calibration is carried out and the interior orientation parameters are estimated according to the selected options.

### Focal Length
The focal length of the camera is read from the image metadata information (EXIF data). The more accurate the initial parameter is, the better the orientation of the images and the more accurate the scale of the reconstruction will be. This value can be optimised during camera calibration and is then replaced by either one or two camera constants. These constants are the adjusted focal length equivalents.

• **Compute Two:** The use of two camera constants compensates for the non-squareness of the pixels.

• **Compute One:** In the other cases the **Compute One** option can be used.

• **Do not compute:** Select **Do not compute** if the camera is already well calibrated and the existing values are reliable enough.

A scale issue in the object reconstruction might depend on a wrong used value. In this case either performing a new calibration of the camera, or carrying out the auto-calibration during the orientation step, can be of advantage to get a more reliable focal length value and a better result in the reconstruction.

### Principal Point
By default, the **Principal Point** is placed to the center of each image.

• **Compute:** Select **Compute** to improve the existing value for the principal point.

• **Do not compute:** Select **Do not compute** if the camera is already calibrated and you wish to keep the existing values.

### Distortion Model
This parameter controls the distortion of the lenses used to acquire images. The default distortion model works well for the majority of the frame cameras. However, for cases when additional information about the lens distortion model are available, further models are available:

• **Distortion Model 1 (K1, K2, P1, P2):** Default.

• **Distortion Model 2 (K1, K2, K3, P1, P2).**

• **Distortion Model 3 (K1, K2, K3, K4, P1, P2, S).**

• **Distortion Model 4 (K1, K2, K3, Kd1, Kd2, Kd3, P1, P2).**

• **Distortion Model 5 (K1, K2, K3, K4, K5, K6, Kd1, Kd2, Kd3, P1, P2, P3, P4, P5, P6, S1, T1).**

• **No Distortion Model.**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kx</td>
<td>Radial distortion parameters.</td>
</tr>
<tr>
<td>Px</td>
<td>Tangential distortion parameters.</td>
</tr>
<tr>
<td>S</td>
<td>Skew parameter when using Distortion Model 3.</td>
</tr>
</tbody>
</table>
### Check Point Tolerances

Along with control points, Infinity supports the use of check points. In order to have an independent measure for assessing the accuracy of the image orientation, a tolerance for each of the Root Mean Square Error (RMSE) on control points has to be set. The 3D position of the check points is not used during the orientation, yet the computed 3D position of each check point is compared to its current position. The differences are used to evaluate the overall accuracy of the orientation.

The following criteria, derived from ASPRS guidelines, are used to determine when the analysed check point should be considered as out-of-tolerance:

- If the computed RMSE values for Easting, Northing, Horizontal or Height exceed the ones entered.
- If the absolute value of the Mean of Easting, Northing or Height exceeds the 25% of the respective RMSE value entered.
- If the absolute value of $\Delta$Easting, $\Delta$Northing or $\Delta$Height for a check point exceeds three times the respective RMSE value entered. In this case, the results are marked in bold red text.

### Dense Point Cloud

**Filtering Threshold**

In the generated Dense Point Cloud there can be some outliers, due to blurry images or poor overlap. A filter can be used to remove them and generate a more accurate Dense Point Cloud.

The **Filtering Threshold** is the maximum value of the uncertainty (sigma) that a point can have in order not to be filtered out.

- Increasing this value may lead to a more complete but noisy point cloud.
- A smaller value guarantees more accurate points, although reducing the density of the Dense Point Cloud. If a too noisy Dense Point Cloud is generated, a smaller value can be of advantage.

**Min. Number of Matches per Point**

This parameter controls the minimum number, per 3D points reconstructed, of valid re-projections to images.

- Increasing this value reduces the noise, although a lower number of points in the point cloud might be computed. If a too noisy Dense Point Cloud is generated, a bigger value can be of advantage.

### DSM & Orthophoto

**Triangle Size**

This parameter refers to the size of the triangles in the 2.5D triangulated surface (DSM).

- **Small** option can be used if a more detailed reconstruction is needed.
- **Medium** is the default value. It works well for the majority of the cases.
- **Large** option generates less and bigger triangles.

☞ In case of large noise in the Dense Point Cloud, too small triangles might generate considerable noise in the DSM. In this case, a bigger **Triangle Size** is of advantage.
Orthophoto Resolution
This parameters controls the ground sample distance of the orthophoto.
- Decreasing the parameter, will increase the resolution of the orthophoto and the computation time for its generation.
- Increasing the parameter, will decrease the resolution of the orthophoto and the computation time. The orthophoto itself will be smaller in size.

4.5.6.3 Workflow
Processing Procedure
The processing procedure includes three core steps:
1. Orientation of images
2. Dense Point Cloud generation
3. DSM & Orthophoto generation

Some further processes can be carried out according to the user needs.

Import of the Images
Images can be imported through the import dialog or by Drag & Drop option. Currently, JPG and PNG file types are supported.

Import dialog

1. Select the appropriate file type for the images: Images – JPG, PNG. The images appear in the list.
2. Check or uncheck the desired Import Settings.
3. Click the Import button to start the import.

☞ If the images are imported by Drag & Drop, the default Import Settings are applied.

Import Settings
When the Create Image Group box is checked, an image group is created directly after closing the import dialog. In order to be processed, images have to be added to an Image group. If no Image Group is created on import, one
can be created after the import and images can be added to it. For further information, refer to "Image Groups".

☞ At least two images must be selected for this option to become available.
☞ By default, this setting is checked. However, if unchecked, Infinity will remember this selection at the following import.

When the **Import Image Data** box is checked the images are copied to the project. If this option is unchecked, the images will not be copied into the project but linked to it via the path specified in the import dialog. If, after importing, the images are deleted or moved to a different path, no processing will be allowed. A warning message is displayed if the images cannot be found at the expected location.

☞ When moving the project to another computer for further processing, the linked images must be copied to the exact same path as in the previous computer; otherwise, no further processing is possible.
☞ For very large datasets, it is recommended to link the images to the project rather than copy them
☞ By default, this setting is checked. However, if unchecked, Infinity will remember this selection at the following import.

**Definition of the Settings**

Once the Image Group is created, the settings can be defined through the Imaging ribbon bar. For further information, refer to "Image Processing Settings".

**Orientation of the Images**

After the Import and the Image Group creation, the images can be orientated. To orientate the images, do the following:

1. Set a master coordinate system in the project. Refer to "Working with Coordinate Systems".
2. Select the Image Group from the **Navigator** or the **Inspector**.
3. Select **Orientate** from the Imaging ribbon bar or from the context menu.

☞ Images can be oriented only if they are geotagged and have (at least a rough) camera calibration

☞ If the above mentioned requirements for images and coordinate system are fulfilled, images camera poses should be shown in the **View**. If this is not the case, check that the coordinate system used is the appropriate one for the area considered.

☞ Infinity reads information for camera focal length and computes the principal point position based on the information stored in the EXIF data.

If the camera calibration parameters are provided, for example in case of a factory calibration, they can be manually entered. To enter the camera calibration parameters, do the following:

1. Select all the images of the image group from the **Inspector** or from the **Navigator**.
2. Use the context menu option **Edit Camera Calibration**.

3. According to the selected **Distortion Model**, the calibration values can then be entered.

As described in "Working with Images", once the orientation is triggered, the processing task appears in the **Task** pane of the **Imaging** tab in the **Inspector**, and in the **Task Manager**.
4. When the orientation is computed, you can drill in the orientation result to view details about:
   • The exterior orientation.
   • The interior orientation.
   • The control and the check points, if any have been used. For further information, refer to “Using Control Points”.

5. To store the orientation result, highlight it and select Store from the Imaging ribbon bar or from the context menu. The Sparse Point Cloud will appear in the View.

Together with the orientation of the images, Infinity computes the 3D position of the common features that were matched and used for orientation, also called Tie Points. These points form a Sparse Point Cloud. This point cloud shows a very rough representation of the area, that will be reconstructed during the Dense Point Cloud computation.

After the orientation, the images along with the updated position in the EXIF data can be exported.

If you realise that the used settings are not compliant with the desired outcome, you can remove the orientation result in order to run a new orientation. To run a new orientation, do the following:

1. Highlight the orientation result and click Remove from the Imaging ribbon bar or from the context menu.

2. You can also select the image group and then Remove the stored orientation.

Every time you remove an orientation from an image group, the position and the attitude of each image roll back to the values they had after import.

To create a report for the orientation, select the orientation result and go to Reports > Image Orientation Report from the Imaging ribbon bar or use the context menu.

Project Details
This section includes information about the project, such as the project name, the customer details and the master coordinate system.

Image Group Information
This section includes information about the selected image group, such as the ID, the total number of images and their resolution, the sensor and the camera model, the EXIF focal length as well as the total size of the images in Gpx.

Orientation Settings
This section includes information on the settings that were used to compute the orientation of the images. The settings are described in detail in Image Processing Settings.

The Check Point Tolerances are the user entered values used to assess the quality of the check points.
Results Overview
This section includes general information about the orientation and the results of the tolerance test for the check points.

General
- Check how many camera poses have been orientated with respect to the total number of camera poses in the image group. Example 95/98.
- Check if the mean 3D error of the control points and the check points meets the project expectations.

Check Point Tolerances
- The computed RMSE values are listed. They will be marked as out-of-tolerance if they exceed the Check Point Tolerances that are shown in the Orientation Settings. More details are shown in the Check Points table.

Interior Orientation
This section includes information on the parameters of the interior orientation.

Calibration Source:
- Pre-Calibrated: The initial values for the parameters were imported to the project, for example from Leica Aibot.
- User Entered: The initial values for the parameters were edited by the user.
- Unknown: The initial values for the parameters were computed using information from the EXIF image metadata.
- Computed: The initial values for the parameters were computed in a previous step by self-calibration.

The initial value, the calibrated value and their differences are shown for each parameter of the camera and the lens of the Image group. Normally, the differences are expected to be small, but there is no actual limitation to this. Yet, a big difference may indicate instability of the self-calibration or the orientation. In most cases, this issue can be addressed by adding control points as explained in the Workflow.

Exterior Orientation
This section includes information about the exterior orientation of the images.

If control points have been used, the information shown here reflects the absolute position of the images. Otherwise, the information is shown with respect to the relative position of the images.

General Information
General statistics for the exterior orientation are shown in this subsection.
- Check the Minimum Number of Tie Points Per Image: If this value is zero, there is at least one image that has not been orientated, due to a not optimal acquisition. For example blurry images, not optimal camera network or flight height.

Absolute Camera Pose Standard Deviations
This table shows the mean and the standard deviation of the mean, for the standard deviations of the camera poses. Depending on the initial orientation estimates, these values are more or less close to zero. A value that is significantly bigger from the rest or from zero, indicates a possible bias of this
parameter. In most cases, this can be fixed by adding control points to the orientation.

**Control Points**

This table shows the residuals in each direction, the mean reprojection errors and the total number of images each control point has been marked on. The mean reprojection errors are checked with the nMAD (normalized Median Absolute Deviation) criteria. Possible outliers are marked as out-of-tolerance.

- If there are flagged values, review the markings of the specific control points.

The mean and the standard deviation are computed for each column. These values are more or less close to zero. A value that is significantly bigger from the rest or from zero, indicates a possible bias. In this case:

- Check that the control points that are used have a good distribution.
- Check that the control points have been correctly marked on at least four images.
- Check that there is no typing error in the actual coordinates of the control points.

More information on control points can be found in Image Processing Settings.

**Check Points**

This table shows the residuals in each direction, the mean reprojection errors and the total number of images each check point has been marked on. The mean reprojection errors are checked with the nMAD (normalized Median Absolute Deviation) criteria. The \( \Delta \) values, the mean and the computed RMSEs are checked against the tolerances defined in the Image Processing Settings. Possible outliers are marked as out-of-tolerance.

- If there are flagged values, review the markings and the actual coordinates of the specific check points.

More information on control points can be found in Image Processing Settings.

To see the number of oriented images, select the image group and view the Property Grid. This information is also available in the Imaging tab of the Inspector > Image Groups.

The oriented images have a special icon. Moreover, the images that have not been oriented do not have Omega, Phi and Kappa values.
Infinity supports the use of control points and check points. You can mark them either before running an orientation task or after storing it.

To mark control points, select the image group and select Add Control Points from the Imaging ribbon bar or from the context menu. This action starts the Mark Control Points wizard:

**Select Points**
In this window, you select the points that you would like to mark on the images. Any point from your project (imported or calculated) can be added as control point, provided that it has a 3D position.

1. Select the points you want from the **Available Points** list, move them to the **Control Points** list.

2. Click **Next** to proceed to the second page of the wizard.

**Match Points**
Infinity offers two ways to mark and match control points
- Basic Marking Mode: Used to mark multiple control points on one image before orientation
- Extended Marking Mode: Used to speed up the marking of a selected control point on multiple images, if the image group has already been orientated.

*General Description*
The main components of both marking modes are:

1. **Point list**
   The place to select which point will be marked.

2. **Map view**
   Shows the images and the control points that have been added in the list. You can use the map view button to hide or show the images, or - if the image group is already oriented - you can also restrict the images that are shown to those that the selected point can be re-projected on. Once a point has been marked, it is displayed in the map view with one of the following icons:
   - if it is used as a Control Point
   - if it is used as a Check Point

3. **Marking pane**
   Where the points are marked on the images. The two marking modes use this pane in a different way, that is explained below.

4. **Wizard navigator**
   Shows Details about:
   - The total number of orientated images / the total number of images in the image group
   - The total number of Control Points
   - The total number of Check Points
   - Which points have not been marked
   - Which points are not used

---

**Basic Marking Mode Layout**

**Extended Marking Mode Layout**

---

The **Warning** section provides information on possible weaknesses of the marking procedure, such as points that have been marked on one image only or if not enough number of control points is used.

The points that have been added in the point list can be used as Control Points or Check Points. This option is available in the **Use as** column/property in both marking modes.

*The Basic Marking Mode*

Apart from the common components that were described above, the page also comprises a thumbnail list of the images that belong to the selected image group.

The marking window shows the image that is active for control point marking. The list of control points includes all the points that can be marked.

**To mark a control point:**

1. Select the control point from the list or the map view.
2. Select the image you want to mark this control point on from the image thumbnail list or the map view.
   The selected image appears in the marking window.
3. Mark the point on the image.

If a specific point is found on the selected image and must be marked, navigate to the marking position on the image and use the context menu to select the desired point.

If there are images that have been linked to the control point(s), they are available in the flyout:

To speed up the point marking phase, Infinity can sort the image thumbnail list by the incrementing 2D distance of each image to the selected point. This increases the probability that the selected point appears in the first images of the list. To activate this sorting, select **Sort Images by the Distance to Point**. The same option is available in the Extended Marking Mode.

To activate this sorting, select **Sort Images by the Distance to Point**.
To sort the images by name, select the same button again.

*The Extended Marking Mode*

In this point-based view, multiple images with marking suggestions are displayed for a selected point.

**To mark a control point:**

1. Select the control point from the list or the map view.
2. Mark the point on the image.

The Point pane displays additional information for the selected control point, such as ΔEasting, ΔNorthing, ΔOrtho. Height, Δ3D, Mean Reprojection Error, etc. For a check point, these values may appear as out-of-tolerance, in case they exceed the RMSE criteria. For both control and check points, the Mean Reprojection Error may appear as out-of-tolerance, in case it exceeds the nMAD criteria.

If there are images that have been linked to the control point(s), they are displayed at the bottom of the pane.

The marking pane includes a set of buttons to:
- Show only images a selected point can be re-projected on (valid only if an orientation has already been stored for the selected image group).
- Sort images by distance to point or by name (the same option is available in the Basic Marking Mode).
- Sort images by ascending/descending reprojection error (valid only if an orientation has already been stored for the selected image group).
- Zoom in/out in all images using the same zoom factor (this can be activated/deactivated).
- Show images in small, medium or large size.
- Search for a specific image.

☞ The context menu that is available in the marking image offers shortcuts that can speed up the marking process.
If a point is already marked on an image, place the mouse over the point marking and use the context menu to **Remove**, **Use as Check/Control Point** or **Do not Use** the specific point.
If an orientation is already stored, the control points and the check points that have at least one out-of-tolerance value are indicated by the icon.
You can switch between the Basic and the Extended Marking Mode at any time: the markings and the settings are saved when switching from one mode to the other.

To close the wizard and store the markings, select **Finish**.
If you want to change the control points, for example:
- Add or remove control points,
- Improve markings,
- Disable control points,
- Change control points to check points,

You can start the wizard at any time you need to.

☞ If the images are already oriented, the selected point is automatically detected on the selected image. But this marking will not be used for updating the image orientation, unless the user confirms it. The suggested marking is shown by.

☞ When possible, the use of control points acquired at different heights is recommended in order to improve the orientation step.

### Optimise Orientation

The optimisation of the orientation can be triggered:
- By the control points wizard.
- By highlighting the oriented image group and selecting **Optimise** from the Imaging ribbon bar or use the context menu.

### Optimisation via the control points wizard

1. After making any change in the control point wizard for an oriented image group, on the second page there is now an additional check box.

   [ ] Update orientation on finish

2. Activate the **Update orientation on finish** option to optimise the orientation.
3. Select **Finish** in the wizard to start a new processing task. The orientation will be updated and optimised with the changes you made in the control point wizard.

**Optimisation of the camera parameters**

To fine-tune the interior orientation of the images, do the following:

1. **Open the Settings** from the **Imaging** ribbon bar and make the changes you want to the **Camera Calibration Optimisation** section.

2. **Highlight the oriented image group and select Optimise** from the **Imaging** ribbon bar or use the context menu.

**How to achieve an accurate orientation**

- Use control points that cover the perimeter of the area you are interested in. At least five control points are recommended.
- Use control points at different heights.
- Even if an RTK UAS was used for capturing images, use at least some check points.
- Mark the control points and the check points in at least four images. The images must be selected so that the light rays intersect well on these points.
- Even if you are sure that the camera is well calibrated, use some control points and check points to verify the results. A good distribution of the check points based on the shape of the area is also important.

If you want to check how accurate the orientation is without control points, mark only check points and process.

After the processing is complete, create an orientation report and check the residuals in the very last table of **Check Points**:

<table>
<thead>
<tr>
<th>Check Points</th>
<th>Check Points</th>
<th>Check Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>54500434</td>
<td>1.23076271</td>
</tr>
<tr>
<td>C2</td>
<td>54500135</td>
<td>1.23076271</td>
</tr>
<tr>
<td>C3</td>
<td>54500236</td>
<td>1.23076271</td>
</tr>
<tr>
<td>C4</td>
<td>54500337</td>
<td>1.23076271</td>
</tr>
<tr>
<td>C5</td>
<td>54500438</td>
<td>1.23076271</td>
</tr>
</tbody>
</table>

**In this example, the Δ values and the RMSEs indicate a poor result.**

After changing some of the check points to control points, the result is good:
Even on the independent check points, the residuals are small.

Optimisation is the process of updating the exterior and/or interior orientation of images, by making some changes either to the control points or to the camera calibration values.

The initial stored orientation can be optimised so that:

- Any wrong point marking is manually removed.
- Any control point with wrong 3D position is disabled.
- The camera calibration is fine-tuned to fit the specific image capture.

Since most cameras that are used do not retain a constant internal geometry, the camera optimisation can improve under certain circumstances the accuracy of the interior and exterior orientation and its deliverables.

The orientation of an image group may take a considerable amount of time. However, the optimisation only triggers a final bundle adjustment, without recomputing the orientation from scratch.

---

### Generation of the Dense Point Cloud

<table>
<thead>
<tr>
<th>Control Points</th>
<th>Quality 3D [m]</th>
<th>Easting [m]</th>
<th>Northing [m]</th>
<th>Ortho. Height [m]</th>
<th>ΔEasting [m]</th>
<th>ΔNorthing [m]</th>
<th>ΔOrtho. Height [m]</th>
<th>Δ3D [m]</th>
<th>Mean Reprojection Error [mm]</th>
<th>Images Marked</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>-</td>
<td>546.619.294</td>
<td>290.772.954</td>
<td>425.410</td>
<td>-0.090</td>
<td>0.0045</td>
<td>0.0159</td>
<td>0.0332</td>
<td>0.331</td>
<td>5</td>
</tr>
<tr>
<td>C3</td>
<td>-</td>
<td>546.948.946</td>
<td>290.771.695</td>
<td>425.450</td>
<td>-0.075</td>
<td>-0.087</td>
<td>0.0075</td>
<td>0.0378</td>
<td>0.908</td>
<td>4</td>
</tr>
<tr>
<td>C6</td>
<td>-</td>
<td>546.635.385</td>
<td>290.772.144</td>
<td>425.433</td>
<td>0.0105</td>
<td>-0.0109</td>
<td>-0.0017</td>
<td>0.0152</td>
<td>4.03</td>
<td>8</td>
</tr>
<tr>
<td>C15</td>
<td>-</td>
<td>546.631.790</td>
<td>290.777.867</td>
<td>425.409</td>
<td>0.0113</td>
<td>0.0022</td>
<td>0.0088</td>
<td>0.0329</td>
<td>4.20</td>
<td>9</td>
</tr>
<tr>
<td>R5</td>
<td>-</td>
<td>546.938.118</td>
<td>290.781.659</td>
<td>424.2126</td>
<td>0.0283</td>
<td>0.0219</td>
<td>0.0095</td>
<td>0.0370</td>
<td>8.58</td>
<td>7</td>
</tr>
</tbody>
</table>

| Mean | 0.0000 | 0.0000 | 0.0000 | 0.0012 | 0.64  |
| SD   | 0.0258 | 0.0375 | 0.0483 | 0.0092 | 2.39  |

<table>
<thead>
<tr>
<th>Check Points</th>
<th>Quality 3D [m]</th>
<th>Easting [m]</th>
<th>Northing [m]</th>
<th>Ortho. Height [m]</th>
<th>ΔEasting [m]</th>
<th>ΔNorthing [m]</th>
<th>ΔOrtho. Height [m]</th>
<th>Δ3D [m]</th>
<th>Mean Reprojection Error [mm]</th>
<th>Images Marked</th>
</tr>
</thead>
<tbody>
<tr>
<td>C3</td>
<td>-</td>
<td>546.930.754</td>
<td>290.781.739</td>
<td>424.1413</td>
<td>-0.0186</td>
<td>-0.0177</td>
<td>-0.0182</td>
<td>0.0399</td>
<td>0.73</td>
<td>3</td>
</tr>
<tr>
<td>R3</td>
<td>-</td>
<td>546.920.477</td>
<td>290.775.182</td>
<td>424.2266</td>
<td>-0.0004</td>
<td>-0.0007</td>
<td>-0.0086</td>
<td>0.0009</td>
<td>1.48</td>
<td>7</td>
</tr>
<tr>
<td>R4</td>
<td>-</td>
<td>546.928.854</td>
<td>290.774.049</td>
<td>424.2400</td>
<td>0.0251</td>
<td>0.0122</td>
<td>-0.0011</td>
<td>0.0279</td>
<td>6.20</td>
<td>10</td>
</tr>
<tr>
<td>R6</td>
<td>-</td>
<td>546.942.418</td>
<td>290.777.859</td>
<td>424.2281</td>
<td>0.0305</td>
<td>0.0103</td>
<td>-0.0242</td>
<td>0.0434</td>
<td>6.96</td>
<td>8</td>
</tr>
</tbody>
</table>

| Mean | 0.0094 | 0.0013 | -0.0090 | 0.0276 | 5.49  |
| SD   | 0.0218 | 0.0362 | 0.0254  | 0.0140 | 2.75  |
| RMSE | 0.0011 | 0.0044 | 0.0181  |        |       |
| RMSE Horizontal | 0.0056 |        |         |        |       |

Even on the independent check points, the residuals are small.

Optimisation is the process of updating the exterior and/or interior orientation of images, by making some changes either to the control points or to the camera calibration values.

The initial stored orientation can be optimised so that:

- Any wrong point marking is manually removed.
- Any control point with wrong 3D position is disabled.
- The camera calibration is fine-tuned to fit the specific image capture.

Since most cameras that are used do not retain a constant internal geometry, the camera optimisation can improve under certain circumstances the accuracy of the interior and exterior orientation and its deliverables.

The orientation of an image group may take a considerable amount of time. However, the optimisation only triggers a final bundle adjustment, without recomputing the orientation from scratch.

---

To create a Dense Point Cloud from an image group, do the following:

1. Highlight the image group.
2. Select **Dense Point Cloud** from the Imaging ribbon bar or use the context menu.
3. Once the Dense Point Cloud process is triggered, the processing task appears in the **Task** pane of the Imaging tab in the Inspector and in the Task Manager. Refer to "Working with Images".
4. To store the result, highlight the result and select **Store** from the Imaging ribbon bar or from the context menu. The Dense Point Cloud appears in the View.

The Dense Point Cloud can be filtered according on the settings described in the "Image Processing Settings". To filter the stored Dense Point Cloud, do the following:

1. Highlight the Image Group object from which you created the Dense Point Cloud.
2. Select **Filter Dense Point Cloud** from the context menu.
3. To store the filtered Dense Point Cloud result and see it in the View, highlight it and select Store from the Imaging ribbon bar or from the context menu.

To remove a stored Dense Point Cloud result, do the following:
1. Highlight the Dense Point Cloud result.
2. Select Remove from the Imaging ribbon bar or from the context menu.

To create a report for the Dense Point Cloud, do the following:
1. Highlight the Dense Point Cloud result.
2. Select Reports > Dense Point Cloud Report from the Imaging ribbon bar or from the context menu.

☞ If the images are not oriented at the specified processing resolution or the orientation is computed but not stored, an orientation will be computed first and then a dense point cloud will be created, based on the computed orientation.

Generation of the DSM & Orthophoto

To create a Digital Surface Model and an orthophoto from an image group, do the following:
1. Highlight the image group.
2. Select DSM & Orthophoto from the Imaging ribbon bar or use the context menu.
3. To store the DSM & Orthophoto result, highlight the result and select Store from the Imaging ribbon bar or use the context menu.

To remove a stored DSM & Orthophoto result, do the following:
1. Highlight the DSM & Orthophoto result.
2. Select Remove from the Imaging ribbon bar or from the context menu.

To create a report for the DSM & Orthophoto, do the following:
1. Highlight the DSM & Orthophoto result.
2. Select Reports > DSM & Orthophoto Report from the Imaging ribbon bar or from the context menu.

☞ If the images are not oriented at the specified processing resolution, or the previous step is computed but not stored, an orientation will be computed first, then a dense point cloud will be created, based on the computed orientation. Finally a DSM & Orthophoto will be created, based on the computed orientation and the dense point cloud. This is equivalent to run a One step process. For further information, refer to "One Step Process".

One Step Process

It is possible to run the complete workflow using the DSM & Orthophoto process.

In case, there are neither Orientation or Dense Point Cloud stored, triggering this process generates a full set of results:
• Orientation.
• Dense Point Cloud.
• DSM & Orthophoto.

This process implies less control on the results, but can be effective, if the quality of the input data is high.

## 4.5.6.4 Export Image Processing Results

### Export Image Processing Results

Infinity can export:

- The oriented images with the updated position in the EXIF data.
- The Dense Point Cloud, in the standard formats used for point clouds.
- The Orthophotos, as georeferenced images.

## 4.5.6.5 Processing Considerations

### Processing Considerations

The number of images that can be processed by Infinity depends on several factors:

- The available RAM.
- The processor.
- The defined processing settings.

Considering a 20 megapixel image, 16GB of RAM is recommended to process 100-120 images at full resolution. The processing limits depend on the total pixel count of all images being processed.

It is possible to process images on the local machine or to use a dedicated worker host machine. When working with larger data sets it's recommended to use a dedicated worker host.

☞ Working with smaller image groups in a project will help with processing large data sets.

### System Requirements

<table>
<thead>
<tr>
<th>Components</th>
<th>Minimum</th>
<th>Recommended</th>
<th>Recommended worker host</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows 7, 8, 10,</td>
<td>Windows 10,</td>
<td>Windows 10,</td>
</tr>
<tr>
<td></td>
<td>Server 2012,</td>
<td>Server 2016 (64 bit)</td>
<td>Server 2016 (64 bit)</td>
</tr>
<tr>
<td>Processor</td>
<td>Multi-Core CPU (i5,</td>
<td>Multi-Core CPU Intel i7/Xeon</td>
<td>Multi-Core CPU Intel i7/Xeon</td>
</tr>
<tr>
<td></td>
<td>i7 Xeon recommended)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>16 GB</td>
<td>64 GB</td>
<td>128 GB</td>
</tr>
<tr>
<td>Graphics</td>
<td>DirectX9 compatible 2 GB</td>
<td>DirectX9 compatible 4 GB</td>
<td>-</td>
</tr>
</tbody>
</table>

### Setup Worker Host

The image-processing tasks can be sent to a different computer (host) for processing, as long as the following requirements are met:
Both computers have an Infinity licence with the Point Clouds from Images option.
Both computers have the same version of Infinity.
The image-processing engine is already running on the computer that will be used for processing.
Infinity is running on the computer that sends the processing task.
The computers are working within the same network.

By default, the host for image-processing tasks is the local computer, that is the computer where the project is already running.

To define the host, do the following:

1. Go to the Backstage > Preferences.
2. Select the Image Processing tab.
3. Enter the necessary information regarding the Host Name, the Port number, the User Name and the Password.

4.6 Infrastructure

4.6.1 Overview

The Infrastructure module allows you to create basic Road designs as well as convert data from external files that already contain a design.

When a design is imported from an external file, the object is created directly. However, the user can still edit the information that has been imported with the result of an updated design.

Once a road design is ready, Leica Infinity can export it to a format suitable for field use.

See also:
Export to Leica ConX

Refer to the tutorials "How to manually create a road and use it for volume calculations":
https://leica-geosystems.com/-/media/2b014fed0b854491b295bac4ee1df766.ashx

"How to prepare a Road job from data defined by cross sections":
https://leica-geosystems.com/-/media/7508f29835254de1be874acac79736ef.ashx

"How to create a Road design from polylines in a CAD file":
https://leica-geosystems.com/-/media/45f1d1d913764be29bc2b8d9cc13b325.ashx

Tutorial data can be downloaded in the Localisation Tool.
An alignment is a line object used to denote the path of a road, railway, tunnel etc. A full design requires a 3D alignment in order to serve as centreline and to calculate the rest of the infrastructure elements.

See also:
Alignment Objects

**Road objects:**
A Road object consists of a group of stringlines. The stringlines can be defined by a centreline and cross sections or imported from a design file. If imported from a design file it is possible to set one of the stringlines as centreline, which creates an alignment object in the background.

See also:
Road Objects

**Cross sections:**
A cross section is a slice or cut at a certain chainage of the road. In a vertical view it indicates the position of a road's material layers.
Stringlines result from interconnecting the nodes of subsequent cross sections.

See also:
Cross Sections

**Infrastructure Manager:**
The Infrastructure Manager is the tool that allows for the input and editing of the different components that lead to a full 3D Alignment object and, based on an existing Alignment acting as Centreline, for the creation, editing and viewing of the rest of elements that lead to a complete full Road design object.
If any potential conflicts are found, Infinity notifies the user.

See also:
Infrastructure Manager

**Material Layers:**
Within Leica Infinity the Material Layers represent the different layers of a road and group sets of stringlines that belong to the same level, material or phase of construction and are, therefore, thematically interconnected.

See also:
Material Layers

### 4.6.2 Alignment Objects

Each Road object needs at least one Alignment object which serves as the Centreline of the road.

The Centreline is the main line in a road model. It is the reference axis that determines the distance along the road (chainage) and across it (offsets).

All alignments available in a project are grouped and listed in the Navigator and the Inspector.
By default they will be imported or written to the Alignments Layer.

**To create a new alignment:**
1. Click on Alignment > Alignment in the Infrastructure ribbon bar. Next to the Property Grid the “New Alignment” tab opens up.
2. Enter the alignment properties and press Create.
3. The Infrastructure Manager opens up next to the Inspector.
4. In the Infrastructure Manager build up the alignment by defining its horizontal (mandatory) and vertical (optional) elements. For both the POB/VPOB (Point of Beginning/Vertical Point of Beginning) are already predefined assuming the Start Station as defined in the Alignment Properties.
5. In the Inspector View right-click on the POB and select “Add below” from the context menu. Alternatively, click on “Add below” in the Infrastructure > Road Design ribbon bar. By default an element of type “Straight” will be added. Optionally choose a different Type and Method and edit the elements as required.
6. Continue adding new elements below or in between (above).

**To edit existing alignments:**
1. Right-click on the Alignment object in the Navigator or the Inspector and select Edit from the context menu.
2. Edit the elements of the alignment in the Infrastructure Manager.

**To use an alignment as centreline in a road:**
1. In the Navigator or in the Inspector select the Road object.
2. In its Property Grid go to Details and click on the Edit icon next to Centreline.
3. Choose a different alignment from the list and confirm your selection with OK.
4. Click on Apply in the Property Grid to update the Road object.

---

**4.6.3 Road Objects**

**Road Objects**

Road objects can be cross section based or stringline based.

**Cross section based road objects:**

Cross section based road objects consist of:

- a 3D alignment that has been created or chosen to serve as its Centreline.

☞ Any of the alignments available within the project can be chosen as centreline.

- cross section templates assigned to chainage values along the centreline.

☞ Cross section templates remain in the project even if assignments are deleted.

- several Material Layers containing stringlines of the same level, material or phase of construction.

☞ Daylight stringlines require a Target surface to exist in the Road object.

Example:
Optionally a Target surface can be assigned to the road object to visualize cut or fill slopes. It must be available within the project as a surface, before it can be chosen as target surface.

Example:
If the Target surface is removed from the Road object, the so-called Daylight stringlines which indicate the intersection of the road design with the terrain model will disappear, too.

**Stringline based road objects:**

Road objects imported from external files often come in in the form of a list of stringlines.

In this case the stringlines define the Road object, which has typically been calculated in a 3rd party software and sent to Leica Infinity for its preparation and conversion to a field-compatible format.

Example:
Any of the stringlines available within the Road object can be set as centreline: Right-click on the stringline and select "Set as Centreline" from the context menu.

**To create a new road object:**

1. Click on Road > Road in the Infrastructure ribbon bar. Next to the Property Grid the "New Road" tab opens up.
2. Enter the road properties.
   - Go to Details and click on the Edit icon next to Centreline to optionally select a centreline. All alignments available in the project are available for selection.
   - Click on the Edit icon next to Target Surface to optionally select a target surface. All surfaces available in the project are available for selection.
   - Having a target helps when a user intends to assign cross sections to the road.
3. Press Create.

The new Road object will be added to the list in the Navigator and the Inspector.

**To edit a road object:**
1. To edit a road right-click on the Road object and select Edit from the context menu. The Infrastructure Manager opens up next to the Inspector.

2. To assign cross section templates go to the Cross Sections tab. Each assigned cross section will be added under Cross Section Assignments in the Inspector and the Navigator.

3. Optionally add Material Layers. To add a new layer click on Road Design > Material Layer in the Infrastructure ribbon bar.

☞ When you assign cross sections to a stringline based road the nodes have to be assigned to material layers of their own. Simple stringlines cannot share a material layer with stringlines resulting from cross section assignments.

### 4.6.4 Cross Sections

**Cross Sections**

Within Leica Infinity cross sections can be imported or manually created. Manually created cross sections are always stored as a template and are as such available for roads.

Imported cross sections are not stored as a template automatically, but you can "copy" them to a new cross section template.

See also:

How to define and assign cross sections?

If available as a template a cross section can be selected to be assigned to a road from the list in the Cross Sections tab of the Infrastructure Manager. Assigned cross sections can be edited and if available as a template your changes can be "updated" to the template for further use.

☞ Assignments using a modified template will not automatically be updated.

Re-assign the updated template if necessary.

**To manually create a cross section choose to create a cross section template:**

1. Click on Road Design > Cross Section in the Infrastructure ribbon bar. Next to the Property Grid the "New Cross Section Template" tab opens up.

2. Enter the template properties. Go to Details and click on the Edit icon next to Material Layers to select the layers that shall be available for to define elements upon. If not, all elements will be written to a default Material Layer. Available for selection are all layers of the Road object. New layers can be added any time.

3. Press Create.

See also:

Material Layers

The new template will become available for selection in the Infrastructure Manager > Cross Section tab.

On how to "extract" a new cross section by interpolation between existing cross section assignments see:
4.6.5 Material Layers

Within Leica Infinity the Material Layers represent the different layers of a road and are used to group sets of stringlines that belong to the same level, material or phase of construction.

☞ It is not possible to combine imported stringlines and cross section nodes in the same Material Layer.

Layers defined for Infrastructure or Road objects are imported and stored to the Road object as "Material Layers". Material Surfaces that are created from Material Layers can have their own code or style attributes.

Stringlines imported or created from cross sections are stored to the Layer "Stringlines", and can have their own code and style attributes.

See also:
Layer Manager

To create a new Material Layer:

1. Select the Road to which you want to add a new Material Layer.
2. Click on Road Design > Material Layer in the Infrastructure ribbon bar. Next to the Property Grid the "New Material Layer" tab opens up.
3. Give the new Material Layer a name.
4. Optionally, click on the Edit icon next to Centreline to select a centreline.
5. Press Create.

All Material Layers will always be visible from the Navigator. When used with a cross section based road, the Material Layers are also visible in the Infrastructure Manager > Cross Sections tab.

A material layer applies to all cross sections.

With stringline based roads the new material layer can be used to add stringlines to it which have been on another layer before:

1. Select the stringline(s) that shall be assigned to another or a new Material Layer.
2. Right-click and select "Add to Material Layer" from the context menu or click on "Add to" in the Infrastructure > Road Design ribbon bar. Choose the target Material Layer from the list.
☞ Re-assigning a stringline to a different Material Layer does only work for stringline based roads.

4.6.6 Inspect Check Road and Stake Road application results

To check and document stakeout results import the Stake Road job and/or the Check Road job into Leica Infinity.

The aim is to check the stakeout results. The differences between design coordinates and stakeout results can be:

• seen in the graphical view
• checked in the Inspector > Features tab or in the Infrastructure tab under Checks and Stakes.
• saved in a report
4.6.7 **Infrastructure Manager**

4.6.7.1 **Overview**

The Infrastructure Manager is the dedicated tool to view, create and edit the individual components of an Alignment or a Road object.

It opens up automatically when you create a new alignment or when you choose to add a new cross section template.

To edit existing elements it can also be invoked from the Navigator or the Inspector by selecting **Edit** from the context menu.

By default the Infrastructure Manager opens up as a new tab next to the Inspector.

The Chainage Bar represents the whole horizontal alignment from its start to the end. The bars show you where cross sections are assigned.

- When the numbering of nodes is different between cross sections, then these areas of the alignment will be transition areas and marked as such in the Chainage Bar.
- When cross section assignments are missing or there are gaps in the road, then these areas will be without any marking.
You can shift the slider to any position in the road or enter a chainage value to make the slider jump. Both Alignment views (horizontal and vertical) as well as the Cross Section view will follow your movements. On the bars the Cross Section view will show you the details of assigned cross sections.

### 4.6.7.2 Alignments

**How to define alignments?**

Alignments are defined in the Horizontal and/or the Vertical profile tabs of the Infrastructure Manager.

In the Horizontal tab you can also define station equations.

**How to define a horizontal alignment?**

Each horizontal alignment starts at the POB, the Point of Beginning, and is defined by a sequence of geometry elements.

Existing elements can be edited. New elements can be added above or below.

1. Select an element and click on Add Above/ Below in the Road Design ribbon bar or select Add Above/ Below from the context menu.
   By default straight elements will be added.
2. Edit the element properties. Leica Infinity guides you through which definitions are mandatory resp. optional.
   The graphical View will follow your changes.
3. Press Apply to save your changes to the alignment.

To enter station equations switch to the Equations tab.

1. Click on Add Below in the Road Design ribbon bar and enter the Back and Ahead values in the Inspector view.
2. Press Apply.

In the graphical view purple lines (perpendicular to the alignment) will indicate in which places along the alignment station equations are defined.

For each Cross Section Assignment its Modified Station value is listed in the Inspector and in the Property Grid.

**How to define a vertical alignment?**

Each Vertical alignment starts at the VPOB, the Vertical Point of Beginning, and is defined by a sequence of geometry elements.

The procedure of adding elements is the same as for horizontal alignments (see above).

### 4.6.7.3 Cross Section Assignments

**How to define and assign cross sections?**

In the Cross Sections tab of the Infrastructure Manager you can switch between editing cross sections and editing connections.

Edit Cross section view:
Edit Connections view:

Each cross section is shown as a vertical cut through the road layers at a specific station/chainage.

The Inspector View has as many tabs as Material Layers are defined. The layer of the active tab will be color indicated in the graphical representation of the cross section.

Each of the nodes that constitute a cross section is defined by offsets to the left and the right of the centreline. The centreline will be available on all layers.

**To create a new cross section assignment:**

1. Shift the slider to the position in the chainage bar where a cross section shall be assigned to or enter the chainage value.
2. Click on ☀ New Template to create a new cross section template or click on ✨ Add to and select a template from the list.
3. Press Apply in the Infrastructure Manager.

The template will be assigned as a cross section to the selected chainage and assume as its Id the current chainage value. Existing cross sections in this position will be overwritten.

In the Navigator and the Road Inspector the cross section assignment will be added to the list.
Assignments can be deleted. The template will remain. Changes you have made to an assigned cross section will be lost if the template has not been updated before.

**To edit an assigned cross section:**
1. Shift the slider upon a cross section in the chainage bar or enter its chainage value.
2. Edit the offsets and/or side slopes of single nodes or add new nodes in the Inspector View. The graphical View will follow your changes. To add new nodes right-click and select Add Above or Add Below from the context menu.
   - If you design a cross section from scratch and you know that left and right side shall be identical, then you can just create the right OR the left side and press the Mirror button to automatically create the nodes on the other side.
   - This does only work when one side is completely empty.
3. If a template has been used, optionally update your changes to the template for further use.
   - Assignments that have come in with your road data on import will not have underlying templates.
   - Copy them to a new template if you want to save your changes.
   - Assignments using a modified template will not automatically be updated.
   - Re-assign the updated template if necessary.
4. Press Apply.

**To create a copy of an assigned cross section:**
1. Shift the slider upon the cross section that shall be copied or enter its chainage value.
2. Click on Copy to New Cross Section Template. Next to the Property Grid the "New Cross Section Template" tab opens up.
3. Shift the slider to the position in the chainage bar where the cross section shall be copied to or enter the chainage value.
4. Press Create in the "New Cross Section Template" tab. The Template Id can be modified.
5. Press Apply in the Infrastructure Manager.

The copy of the previously selected assignment will be created and assigned to the selected chainage. Existing cross sections in this position will be overwritten.

The template will be available for future use.

**To extract a cross section to a new cross section template:**
Cross sections can be extracted from a transition area by means of interpolating all its nodes from the stringlines between the two existing cross sections.
1. Shift the slider to the position in the chainage bar where the new cross section shall be interpolated. Or enter the chainage value.

2. Click on Extract to New Cross Section Template. Next to the Property Grid the "New Cross Section Template" tab opens up.

3. Press Create in the "New Cross Section Template" tab. The new cross section will be interpolated at the selected chainage.

4. Press Apply in the Infrastructure Manager to assign the new cross section. The template will be available for future use.

**How to edit connections?**

To fix problems found within road design data using cross sections:

1. Switch to the Edit Connections view.

2. Shift the slider in the Chainage Bar to the cross section for which you want to edit connections. The Graphical View will show the selected cross section and the following one. The Inspector will be split to show the details of both cross sections.

3. In the Inspector select the elements to be connected in both cross section profiles and then Link from the context menu or from the Infrastructure > Road Design ribbon bar. To disconnect elements select them both and then Unlink.

The stringline will be re-calculated and redrawn in the graphical view.

### 4.7 Adjustments

#### 4.7.1 Overview

Adjustments

From the observations you have made in the field, you will have to compute an end result, the coordinates. When redundant observations are available, as it should be the case, you will have to choose a strategy so as to get at a unique and optimal solution. In geodesy, this strategy will usually be a least squares adjustment, which is based on the following criterion: the sum of the squares of the observational residuals must be minimized. After carrying out a least squares adjustment you will know that based on the available observations you have achieved the best possible solution.

But, after you have found the best possible solution it is further important to be able to assess the quality of this solution in order to verify whether your network meets the requirements. The quality of a network can be assessed in terms of precision and reliability, which can be quantified by setting the adjustment parameters.

Finally, quality control has to include some sort of statistical testing in order to clear the result of possible outliers. The effectiveness of testing depends on the reliability of the network. The more reliable a network is, the higher the probability that outliers will be detected by the testing.

To summarize the relationship between least squares adjustment, precision and reliability and statistical testing we can say that:
• based on the available data, the **least squares adjustment** produces the best possible result
• statistical tests check the result in order to make it 'error-free'
  
  See also:
  
  Statistical Testing
• the precision and reliability settings quantify the quality of the result.
  
  See also:
  
  General Adjustment Settings

In Leica Infinity the adjustment computation is performed using the MOVE3 Adjustment kernel licensed to LEICA Geosystems AG by Grontmij Geo Informatie, bv, Rosendaal, The Netherlands. For detailed information refer to: www.move3.com.

☞ Refer to the tutorials "How to adjust a GNSS+Level network":
  
  https://leica-geosystems.com/-/media/94056ba161ce4993b46b2848ad58902.ashx

  "Advanced Network Adjustment":
  
  https://leica-geosystems.com/-/media/02614143f73640338df088b7f7123ef0.ashx

  "Advanced Adjustment Concepts":
  
  https://leica-geosystems.com/-/media/80026c2d4e22481f05a0df1d2224f8.ashx

  Tutorial data can be downloaded in the Localisation Tool.

**Prepare the data for Adjustment**

**In Infinity there are four basic steps to performing an adjustment:**

1. Define the control points - Fixed in 3D, 2D, 1D or not fixed.
2. Select the observations that are to be considered in adjustment - TPS, GNSS and Level observations.
3. Run the adjustment and evaluate the results, even comparing several adjustment runs.
4. Store the results that satisfy the adjustment criteria.

**Run Full Adjustment**

To run a Network adjustment:

Press the ![3D](image) button in the Adjustments ribbon bar to run an Adjustment.

Select from the drop down menu whether you want to adjust **3D** (Position and height), **2D** (position only) or **1D** (height only). The last selected method is remembered.

Depending on the chosen dimension the following types of data will be adjusted:

<table>
<thead>
<tr>
<th>Dimension</th>
<th>TPS</th>
<th>GNSS</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>3D</strong></td>
<td>Direction, Zenith Angle and Slope Dist.</td>
<td>DX, DY, DZ</td>
<td>---</td>
</tr>
<tr>
<td><strong>2D</strong></td>
<td>Direction and Horizontal Dist.</td>
<td>DX, DY, DZ</td>
<td>---</td>
</tr>
<tr>
<td><strong>1D</strong></td>
<td>Trig. Height Diff.</td>
<td>---</td>
<td>Height Diff.</td>
</tr>
<tr>
<td>Adjustment Method</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3D</td>
<td>Data will be adjusted in all available dimensions. If only 2D or 1D data is available the 2D and 1D observations will be adjusted instead.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2D</td>
<td>If your network contains GNSS baselines these will always be adjusted in 3D even if the dimension is set to 2D. TPS slope distances &amp; zenith angles will be reduced to horizontal distances. Slope distances without zenith angles are ignored. This adjustment is stored with the Adjusted Least Squares 2D point role.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1D</td>
<td>If you choose 1D the GNSS baselines are excluded from the adjustment. TPS slope distances &amp; zenith angles will be reduced to trigonometric height differences. TPS directions are ignored. This adjustment is stored with the Adjusted Least Squares 1D point role.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The adjustment result will be available in the Adjustment Results view of the Inspector and can be stored if it meets your needs for accuracy.

Network Reports
For each result in the Inspector’s list you can create a report in order to compare individual adjustment runs.

Press the Reports button in the ribbon bar and select Network Adjustment Report from the drop-down menu.

The report will open in a separate window and can be saved as a PDF or HTML file. Both types of file will be added to the Archive section of the Navigator under Reports and can be opened from there again.

Store Result
In the General Adjustment Settings you can choose to automatically store a result after the network computation is completed. If you have deselected this settings you can store the result manually. A reason for doing that can be to first inspect a result before storing it.

See also:
General Adjustment Settings
Inspecting Adjustments
1. Go to the Adjustment Results view of the Inspector and select the result which you want to store from the list.

2. Press the Store Result button in the ribbon bar to store the adjustment result manually.

After saving a result the point role Adjusted least squares will be assigned to all adjusted points. You can select this point role for each point in the Navigator and inspect the properties in the Property Grid.

☞ Only one result can be selected to be stored. You cannot store multiple Results. When you want to store another result, select it from the list and press the Store Result button again. When you want to remove the Adjusted Least Squares point roles from the project, press the Remove Adjustment button in the ribbon bar.

What is stored to the project

A very useful feature of Infinity is letting the user run several adjustments in order to compare results and in general decide which adjustment satisfies the adjustment criteria.

☞ It is important to recognize the adjustment results stored to the project will be merged to the existing data in the project. The adjusted coordinate values will be merged to the Library points and the point role will reflect the value that was stored. It is also possible to merge the coordinate values from two adjustment runs - it is possible to combine the 2D and 1D runs.

Adjusted Least Squares point roles

After storing an adjustment result, the following table explains the point role that will be stored to the points project data:

<table>
<thead>
<tr>
<th>Point Role</th>
<th>Storing Adjustment Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjusted Least Squares 3D</td>
<td>Storing 3D will create a point role that indicates all three coordinate values are from the adjustment. If an existing adjusted point role exists, then it is replaced with the adjustment values of the most recent store.</td>
</tr>
<tr>
<td>Adjusted Least Squares 2D</td>
<td>Storing 2D will create a point role that indicates the position coordinate values are from the adjustment. If an existing adjusted point role exists, then this store replaces the position coordinate values. The height value is not replaced.</td>
</tr>
<tr>
<td>Adjusted Least Squares 1D</td>
<td>Storing 1D will create a point role that indicates the height values are from the adjustment. If an existing adjusted point role exists, then this store replaces the height coordinate value only. The position coordinate values are not replaced.</td>
</tr>
</tbody>
</table>
## Point Role Storing Adjustment Dimension

<table>
<thead>
<tr>
<th>Point Role</th>
<th>Storing Adjustment Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjusted Least Squares 2D + 1D</td>
<td>When storing a 2D and then a 1D adjustment the height coordinate value is merged with the position coordinate values to provide a 2D + 1D adjusted coordinate. Run and store a 2D adjustment, the Adjusted Least Squares 2D point role is available. Run and store a 1D adjustment, the adjustment will respect the 2D value and update the height value.</td>
</tr>
<tr>
<td>Adjusted Least Squares 1D + 2D</td>
<td>When first storing a 1D and then a 2D adjustment the position coordinate values are merged with the height coordinate value to provide a 1D + 2D adjusted coordinate. Run and store a 1D adjustment, the Adjusted Least Squares 1D point role is available. Run and store a 2D adjustment, the adjustment will respect the 1D value and update only the position value.</td>
</tr>
</tbody>
</table>

### Remove Adjustment

To remove a stored adjustment and with it the adjusted point roles:

Press the **Remove Adjustment** button from the ribbon bar to remove the stored result.

The status of the stored adjustment run will be **set back to ”not stored”** and the point roles **Adjusted least squares** will be **removed** from all adjusted points. But the adjustment run itself will be kept in the **Adjustment Results** section of the **Inspector** for future reference and could be saved again if required.

To delete an adjustment result from the list, select the result and press the **Delete** button in the top left corner of the main Leica Infinity window.

### 4.7.2 Free and Constrained Adjustments

#### Free and Constrained Adjustments

The adjustment of a network is usually subdivided into two separate steps or phases:

1. computation of a free network adjustment
2. computation of a constrained adjustment.

This approach is intended to separate the statistical testing of observations and known stations.

See also:

Statistical Testing

#### Free adjustments:

A free network is a network in which the geometrical layout is determined by the observations only. The position, scale and orientation of the network are fixed by a minimum number of constraints. The Control coordinates of known
stations do not impose any extra constraints on the adjustment solution, yet. In a free network adjustment the emphasis is on the quality control of the observations rather than on the computation of coordinates. Selecting other stations to fix the position, scale and orientation will change the coordinates but not the results of statistical testing.

**Constrained Adjustments:**

Having eliminated possible outliers in the observations by running a free adjustment, the network can be connected to the known stations. This does impose extra constraints on the solution. Now, the emphasis is on the analysis of the known stations and on the computation of the final coordinates. There are two types of constrained adjustments: **absolutely constrained** and **weighted constrained**. The difference between these two types lies in the way coordinates are computed:

- In an absolutely constrained adjustment the coordinates of the known stations are kept at their original value, i.e. they do not get a least squares correction. An absolutely constrained adjustment is sometimes called a pseudo least squares adjustment.
- In a weighted constrained adjustment however, the known stations do get corrections.

Your decision whether to compute the adjustment absolutely or weighted constrained leaves the testing results unchanged.

### 4.7.3 Adjustment Settings

#### 4.7.3.1 General Adjustment Settings

**General Adjustment Settings**

The parameters for adjustment computations can either be set in the Backstage under Info and Settings or from inside the Adjustment module. Changes will be stored with the project and applied to all future adjustment runs. To set the adjustment parameters back to the default values: Go to the Backstage (File tab) and press the Defaults button in Adjustment Parameters section under Info and Settings.

**Computation**

**Store results immediately after computing**

Decide whether you want to store the results of an adjustment immediately and automatically after computing, or whether you want to store the results manually later on.

By default the option **Store results immediately after computing** is active. When you change this setting, it has immediate effect and also applies to projects which are already open.

When you de-activate this setting, you can store the results manually by pressing the **Store Results** button in the Adjustment ribbon bar.

**Controls**

Choose how **Control** coordinates shall be introduced into the adjustment computation.
• **Constrained**
  Two or more control points are kept absolutely fixed.

• **Weighted**
  Control points are kept relatively fixed and are allowed to move according to their standard deviations.

## Iterations

### Max. Iterations

Set the maximum number of iterations or computation runs that will be performed to try and reach the iteration criteria (see below). The max. no. of iterations defines an upper limit and prevents the computation from running into an endless loop if there are problematic observations taking part in the adjustment which prevent the iteration criteria from ever being met. With GNSS observations, one iteration is normally sufficient to meet the iteration criteria. In this case, the Adjustment will automatically stop the computation even if maximum three iterations have been set.

### Iteration Criteria

The iteration criteria is the maximum allowed size of corrections to the adjusted coordinates which must be reached before the iteration will stop. The iteration criterium is subject to the max no. of iterations.

## Visualisation Exaggeration Factors

### Absolute and Relative Error Ellipses/ Reliability

Set factors in order to enlarge the visualisation of error ellipses and reliability boxes such that the error ellipses and reliability boxes can properly be seen in the graphical View.

### Threshold

Set a threshold value above which error ellipses and reliability boxes shall be shown in the graphical View. Errors or reliability values below will not be displayed independent of the given exaggeration factor.

## Confidence Levels

Here you can set the confidence levels (that is the standard deviations) for "Heights - 1D" and absolute and relative "Error Ellipses - 2D". The given values will be stored in the Adjustment results and shown in the Adjustment Report. In the graphical View absolute and relative error ellipses are shown.

The axes of the absolute and relative error ellipses will be multiplied by a scale factor that is derived from the confidence levels as set by the user for the stored adjustment result. If you use other than the standard confidence levels then confidence ellipses/ellipsoids will be shown instead of error ellipses/ellipsoids.

The standard deviation for heights is treated in the same way.

The system default values are the standard 1-sigma values, that is:

- for Heights - 1D: 68.3%
- for Error Ellipses - 2D: 39.4%

☞ Changing the confidence levels does not have any effects on the statistical tests.
Here you can define the standard deviations and the centering and height errors to be taken into account for the adjustment of TPS data. Altogether the values defined here are used to define an overall accuracy information to be fed into the adjustment.

**Standard Deviations**

Here you can define the default standard deviations that shall be applied to all TPS observations when computing an adjustment.

**Source for Standard Deviations**

- Choose **Individual** to make the adjustment apply the accuracies which are stored with the observations. These are normally the standard deviations pre-defined for all measurements on the instrument.
- Choose **Use Defaults** to make the adjustment apply the default settings to be defined below for all observations. A ppm value can be entered to account for the relative length (the distance) of an observation.

**Centering/ Height Errors**

Here you can define the default accuracy that shall be applied to the two end points (Setup and Target) of a measurement.

The **Centring** error defines the predicted error that could have been made when centring the instrument/ target on a point. The **Height** error defines the predicted error when measuring the instrument/ target height above a point.

**Source for Centering/ Height Errors**

- Choose **Individual** to make the adjustment apply the accuracies which are assigned to the two end points (Setup and Target) individually.
- Choose **Use Defaults** to make the adjustment apply the default settings to be defined below for Setup and Target.

Here you can define the standard deviations, the centering and height errors and the sigma a priori to be taken into account for the adjustment of GNSS data. Altogether the values defined here are used to define an overall accuracy information to be fed into the adjustment.

**Standard Deviations**

Here you can define the default standard deviations that shall be applied to all GNSS observations when computing an adjustment.

**Source for Standard Deviations**

- Choose **Individual** to make the adjustment apply the accuracies which are stored with the observations.
- Choose **Use Defaults** to make the adjustment apply the default settings to be defined below for all observations. A ppm value can be entered to account for the relative length of a baseline.

**Centering/ Height Errors**

Here you can define the default accuracy that shall be applied to the two end points (Reference and Rover) of a measurement.

The **Centring** error defines the predicted error that could have been made when centring the reference/ rover on a point. The **Height** error defines the predicted error when measuring the reference/ rover height above a point.
**Source for Centering/Height Errors**

- Choose **Individual** to make the adjustment apply the accuracies which are assigned to the two end points (Reference and Rover) individually.
- Choose **Use Defaults** to make the adjustment apply the default settings to be defined below for reference and rover.

**Sigma a priori**

Here you can enter a value to compensate for too optimistic GNSS observations. Quite often, observations coming from GNSS post-processing programs are too optimistic in their accuracy information. This in itself does not matter when adjusting pure GNSS observations but it becomes important when combining GNSS and TPS observations.

**Level Accuracy Information**

Here you can define the standard deviations to be taken into account for the adjustment of Level data. Altogether the values defined here are used to define an overall accuracy information to be fed into the adjustment.

**Source for Standard Deviations**

- Choose **Individual** to make the adjustment apply the accuracies which are stored with the observations. These are normally the standard deviations pre-defined for all measurements on the instrument.
- Choose **Use Defaults** to make the adjustment apply the default settings to be defined below for all observations. A ppm value can be entered to account for the relative length (the distance) of an observation.

**4.7.3.2 Test Criteria**

The parameters for adjustment computations can either be set in the **Backstage** under Info and Settings or from inside the **Adjustment** ribbon bar. Changes will be stored with the project and applied to all future adjustment runs.

To set the adjustment parameters back to the default values:

Go to the **Backstage (File tab)** and press the **Defaults** button in **Adjustment Parameters** section under **Info and Settings**.

**Level of Significance (α₀)**

The Alpha₀ criterium determines the probability of rejecting a good observation. By default the Level of Significance is set to 5% as this is regarded as a good compromise. Setting the Alpha₀ value too low may result in a bad observation being accepted.

**Power of test (1 - β)**

The 1-Beta criterium determines the power of the test, i.e. the probability of accepting a bad observation. By default the power of testing is set to 80% as this is regarded as a good compromise. Setting the Beta value too high may result in good observations being rejected.

The Alpha₀ and Beta settings are subjective and should be determined by an experienced surveyor who carried out the field work. If you feel unsure about what Alpha₀ and Beta should be set to, accept the suggested default values. For a theoretical background and further information on both these values read the topic on the W-Test.
**Sigma a posteriori**
This is a global setting that compensates for the uncertainty of the a priori value. It affects the estimated precision of the adjusted coordinates. You can, if required, only apply the sigma a posteriori if the adjusted coordinates fail the so-called F-Test. The F-Test is a test that is applied to the sigma a priori and the sigma a posteriori. If both are statistically different the result of the F-Test indicates that the stochastic values awarded to the observations a priori are incorrect (assuming outliers have been removed!). Applying the sigma a posteriori will then compensate for this problem.

See also:
W-Test
F-Test

### 4.7.3.3 Advanced Terrestrial Parameters

**Advanced Terrestrial Parameters**

The parameters for adjustment computations can either be set in the **Backstage** under Info and Settings or from inside the **Adjustment** ribbon bar.

Changes will be stored with the project and applied to all future adjustment runs.

To set the adjustment parameters back to the default values:
Go to the **Backstage** (File tab) and press the **Defaults** button in **Adjustment Parameters** section under **Info and Settings**.

**Use reduced observations**
When calculating a network adjustment by default all active observations will be used. Select this option, if you wish to only use the reduced observations for all Sets of Angles applications stored in a project. The single observations contained in the Sets of Angles will then not be taken into account.

The standard deviations for the reduced observations will be taken from the Sets of Angles calculation, i.e. the mean error of the averaged observations.

**Use vertical refraction coefficient**
- Select **Ignore** if you want to apply a vertical refraction coefficient to zenith angles individually before feeding the data into the Adjustment.
- Select **Compute** if you want to estimate the vertical refraction coefficient. This will mainly be used in projects which contain many zenith angle measurements and thus a good estimate can be obtained.
- Select **Use** if you want to apply the above set default value to all zenith angles.

As the vertical refraction coefficient will be applied to all vertical angle measurements in the network, it should only be used in networks that cover relatively small areas.

**Vertical Refraction Coefficient**
The vertical refraction coefficient accounts for the influence of refraction on zenith angles. The default is set to a typical value of 0.13.

**Use scale factor correction**
• Select **Ignore** if you want to apply a scale factor to distances individually before feeding the data into the Adjustment.
• Select **Compute** if you want to estimate the scale factor. This will mainly be used in projects which contain many distance measurements and thus a good estimate can be obtained.
• Select **Use** if you want to apply the above set default value to all distances.

**Scale Factor Correction**
Here you can define the scale factor, that shall be applied to distance measurements as an additional factor mainly used to compensate for atmospheric conditions.

### Coordinate System Settings

**Coordinate System**

• Choose **WGS84** if you want to adjust your observations in the WGS84 system.
• Choose **Local Geodetic** if you have a local coordinate system attached to your project and you want to adjust the observations in the local system of your **Control** points.

The transformation used with your local coordinate system has to be either a **Classical 3D** or **None** for this option to become active. Read more in the topic "Status Bar" on how to attach a local coordinate system to a project.

• Choose **Local Grid** if you want to adjust pure TPS observations in a local grid system. In this case no information on the local ellipsoid is necessary.

If your project contains GNSS and TPS observations and you select this option then only the TPS observations are adjusted. GNSS observations will be ignored. Choose **Local Geodetic** if you want to compute a **combined** adjustment.

**Height Mode**
Depending on the selected height mode the adjusted coordinates will have ellipsoidal or orthometric heights:

• Choose **Ellipsoidal** if you want to adjust your observations with ellipsoidal heights.
• Choose **Orthometric** if you want to adjust your observations with orthometric heights.
If for your Control points orthometric heights are available and a geoid model is included in the coordinate system to be used with the project then:
Run the adjustment with setting the height mode to **ellipsoidal**.

After the adjustment the geoid separations will be applied again to get the orthometric heights of the adjusted coordinates.

**Parameters**
In order transform observations **four** parameters are required: three rotations about each axis and a scale factor. These parameters can either be pre-defined and used as such in the adjustment or you can make the adjustment compute the parameters.

- Select **Compute** if you want the adjustment to compute the parameters independent of the parameters given by the attached coordinate system
- Select **Use** if you want your observations to be adjusted using the parameters as defined here. This will not have any influence on the parameters given by the attached coordinate system

☞ In order to compute transformation parameters you should keep at least three of your points fixed. Otherwise the network computation will create error messages. It is also important to note that the computed transformation parameters are only valid for transforming observations - they are not to be used for transforming coordinates.

### 4.7.4 Inspecting Adjustments

#### 4.7.4.1 Adjustments Inspector

**Inspecting Adjustments**

With Leica Infinity you are very flexible to run adjustments under various pre-conditions and keep the results next to each other. You can inspect and select Control points to be fixed, Observations not to be used, adapt the Settings and compare and judge afterwards which Result fits your needs best before you finally save one solution to your project.

**To inspect adjustments:**

Go to the Inspector and open the 📊 Adjustment tab.

**Define Coordinate Constraints**

The Define Coordinate Constraints view lists all Control points in your project. Control points are needed when you want to adjust a constrained or weighted constrained network.

**If you want a Control point to take part in the adjustment:**

Select the ✅ Fix 2D checkbox if you want its position coordinates to take part in the adjustment.

Select the ✅ Fix 1D checkbox if you want only the height coordinate to take part.

Select ✅ both checkboxes if you want all coordinate components to take part.
The role of all Control points selected here will change to Control Fixed 3D (or 2D or 1D) to indicate that these points are considered for taking part in the adjustment.

See also:

Leica Infinity Objects

If you want to compute a weighted constrained network standard deviations have to be available for each Control point taking part in the adjustment.

Before you start the adjustment run the Control coordinates can be edited in the Property Grid if required.

You can import Control coordinates, e.g. from an ASCII file, or you can enter them manually by selecting a point and pressing the Create Control point button next to the existing point role in the Feature section of the Property Grid.

Select Observations

The Select Observations view lists all observations in your project. By default all observations are selected to be used in the adjustment computation. If you want to exclude observations:

- de-select the Use checkbox for a single observation or
- multi-select a set of observations, right-click into the selection and choose Adjustment > Don't Use from the context menu

A reason for excluding an observation could be that it has been identified as an outlier in a previous adjustment run.

See also:

W-Test

Possible reasons for outliers could be mistakes in elements like the Target Height or Type, Offsets or the Atmospheric or Geometric Corrections.

All of these elements as well as the Coding information can be edited in the Property Grid before you start an adjustment run.

See also:

Observation Properties

Computed Loops Results

The Computed Loops Results view lists all loop computation results. To inspect the results open the Computed Loops Report.

For detailed information see:

Overview

Pre-Analysis Results

The Pre-Analysis Results view lists all pre-analysis results. To inspect the results open the Pre-Analysis Report.
For detailed information see:

Overview

Adjustment Results

The Adjustment Results view lists all adjustments that have been computed within the current project. On the top level for each adjustment run you can see:
• the Adjustment Type that has been computed, i.e. inner constrained, constrained or weighted constrained
• the Dimension, i.e. position only or position and height or height only
• the Confidence Levels that have been defined for heights and error ellipses.
• the Degrees of Freedom
• the Critical value for the F-Test as computed on the basis of the currently given Level of Significance plus the F-Test result.

To inspect the resulting adjusted coordinates and observations:

Drill into a result by clicking onto the arrow next to it.

Under Coordinates you can inspect the adjusted coordinates together with:
• the values by which they have been corrected in their components
• the resulting standard deviations for all points that have not been kept fixed or only weighted fixed
• the values defining the error ellipses
• the external reliability in each coordinate direction

Under Observations you can inspect the adjusted observations separately for TPS and GNSS together with:
• the residuals that have been amended in each observation component
• the resulting standard deviations for each observation component
• the W-Test results for each observation component

To manually save the result that meets the demanded accuracy best:

Select it and press the Store result button in the Ribbon bar to save it

On how to remove a stored result from the database and on how to remove an adjustment run from the list of results refer to the Overview topic on Adjustments.

4.7.4.2 Error Ellipses/ Ellipsoids

Error Ellipses/ Ellipsoids

A surveying network can be checked in terms of both, accuracy and precision. The most common approach to check a network’s precision is the calculation of the absolute and relative error ellipses.

Infinity can display both kinds of ellipses/ellipsoids in the graphical View as well as show the respective information in the Inspector and the Network Adjustment Report.

To show the error ellipses/ellipsoids in the graphical View:
1. Run a network adjustment in 2D or 3D.
2. Store the result.
3. Activate (switch on: ☀️) the **Absolute Error Ellipses** and **Relative Error Ellipses** layers in the Layer Manager.
4. Switch the graphical View to display objects as "Shaded" or "Shaded with Edges".

For further information on how to run adjustments and store results see also: Adjustments

- If the graphical view is in 3D mode, then error ellipsoids are shown (instead of 2D error ellipses).
  On how to switch between standard views see also: Graphical View

- Error Ellipses/ Ellipsoids are only shown if you run the adjustment using standard confidence levels, that is 68.3% for Heights - 1D and 39.4% for absolute and relative Error Ellipses - 2D.
  If you choose other confidence levels, then the graphical View will show Confidence Ellipses/ Ellipsoids instead.
If errors are too small, go to Settings > General and enlarge the Visualisation Exaggeration Factors. Else you might not be able to see the Reliability Boxes. If errors are below the given threshold value they will not be shown, either. Set the threshold to a value smaller than the errors. See also: General Adjustment Settings

4.7.4.3 Reliability Boxes

Reliability Boxes

External reliability can be expressed in terms of Reliability Boxes. For each station in a project a Reliability Box is computed as a means to express the influence of a possible error in the observations or of known coordinates on the adjusted coordinates. In constrained adjustments the selection of control points that shall remain fixed during adjustment has a direct influence on the Reliability Boxes. The box represents the area that the adjusted station will be in (with a probability of 80%) if all observations and known coordinates of the network are accepted by the statistical tests. Depending on the possible error or known coordinate with the largest influence on the adjusted coordinate, the size of the box is computed according to the size of the minimum detectable bias.

To show the Reliability Boxes in the graphical View:
1. Run a network adjustment in 2D or 3D.
2. Store the result.
3. Activate (switch on: ☐) the Reliability layers in the Layer Manager.
4. Switch the graphical View to display objects as "Shaded" or "Shaded with Edges".

For further information on how to run adjustments and store results see also: Adjustments

If the graphical view is in 2D mode, then squares are shown (instead of 3D boxes).
On how to switch between standard views see also: Graphical View

Illustration:
If errors are too small, go to **Settings > General** and enlarge the **Visualisation Exaggeration Factors**. Else you might not be able to see the Reliability Boxes. If errors are below the given threshold value they will not be shown, either. Set the threshold to a value smaller than the errors. See also: General Adjustment Settings

### 4.7.5 Tools

#### 4.7.5.1 Loops Computation

**Overview**

The Compute Loops functionality is one of the pre-analysis tools included in the Adjustment module. It is used for automatic computation of network loops and loop misclosures.

A loops computation is always applied to the unadjusted network as a means of checking observations before running the adjustment. It detects all loops with a minimum number of sides (triangles).

Loops that could be formed by combining different types are not considered. As concerns loop type definitions, see below.

**Loop Types**

<table>
<thead>
<tr>
<th>Loop Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GNSS Loops</td>
<td>The three sums of all coordinate differences DX, DY and DZ yield closing errors in X, Y and Z.</td>
</tr>
<tr>
<td>Loop Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Direction and Distance Loops</td>
<td>The sum of the angles in the loop should be a multiple of 200 gon or 180 deg. The remainder is the angular closing error. The closing errors in X (local Easting) and Y (local Northing) are computed in a local XY system, with the positive Y axis being parallel to the first side of the loop, and the X axis being perpendicular to it. If the two directions of one angle in a loop are not from the same setup, then the angular closing error cannot be computed. The closing errors in X and Y however can still be computed by starting at the point with the missing angle. If two or more angles are missing no closing errors can be computed.</td>
</tr>
<tr>
<td>Zenith Angle and Distance Loops</td>
<td>The sum of the derived trigonometric height differences also yields a closing error in height.</td>
</tr>
<tr>
<td>Height Difference Loops</td>
<td>The sum of all height differences equals the closing error in height.</td>
</tr>
</tbody>
</table>

The calculated closing errors are tested using the W-Test.

- The routine does not make use of approximate and/or known coordinates, and it does not necessarily take into account all observations.
- Instrument heights, scale factors and vertical refraction coefficients are accounted for.
- The results do not point to a specific observation that could possibly be a blunder.

**Compute Loops**

To run a loops computation:

Press the ![gear](image) button in the Tools ribbon of the Adjustment module.

- Select from the drop down menu whether you want to compute **3D** (Position and height), **2D** (position only) or **1D** (height only) loops. By default, loops will be computed according to the main Adjustment Settings.
- Only when set to 3D all loop types will be considered in the computation.
  2D only considers "GNSS Baseline" loops and "Direction and Distance" loops.
  1D only considers "Zenith Angle and Distance" loops and "Height Difference" loops.

Computation results will be available under ![computed loops results](image) in the Adjustments Inspector.
The results of all loops computations will be kept in the list until you select them and delete them. To delete a result from the list right-click upon it and select **Delete** from the context menu.

**Loops and Misclosures Reports**

In order to inspect results in detail select a computation run and open the Loops and Misclosures Report from the context menu.

You can generate a report for each result listed in the Inspector in order to inspect misclosure details. Loops and closing errors are listed by loop type as described in the Overview topic. See also:

☞ The Inspector itself does not allow for any drilling-in to results of loop computations.

To generate a Loops and Misclosures Report:
1. Select a computation result in the Inspector
2. Press the Reports button in the Adjustment ribbon bar and select Loops and Misclosures Report from the drop-down menu.
   OR:
   Right-click and open the Loops and Misclosures Report from the context menu.
   ☞ The report will open up in a separate window and can be saved as a PDF or HTML file. Both types of file will be added to the Navigator under Archive > Reports and can be opened from there again.

4.7.5.2 Pre-Analysis

Overview
Pre-analysis is a tool that can be used:
• to detect possible weaknesses in a surveying network before adjustment
• to detect unknowns which cannot be solved
• to check input data

To run a pre-analysis:

Press the button in the Tools ribbon of the Adjustment module.
   ☞ Select from the drop down menu whether you want to compute 3D (Position and height), 2D (position only) or 1D (height only) loops. By default, loops will be computed according to the main Adjustment Settings.

Computation results will be available under Pre-Analysis Results in the Adjustments Inspector.

The results of all pre-analysis computations will be kept in the list until you select them and delete them. To delete a result from the list right-click upon it and select Delete from the context menu.
Pre-Analysis Reports

In order to inspect results in detail select a computation run and open the Pre-Analysis Report from the context menu.

You can generate a report for each result listed in the Inspector in order to inspect details of a pre-analysis.

The Inspector itself does not allow for any drilling-in to results of a pre-analysis.

To generate a Pre-Analysis Report:

1. Select a computation result in the Inspector
2. Press the Reports button in the Adjustment ribbon bar and select Pre-Analysis Report from the drop-down menu.
OR:
Right-click and open the Pre-Analysis Report from the context menu.

The report will open up in a separate window and can be saved as a PDF or HTML file. Both types of file will be added to the Navigator under Archive > Reports and can be opened from there again.

The Pre-Analysis Report includes the following information:
• **Configuration Defects:** This section reports upon singularities that may come up when a network is adjusted. It lists unknowns that cannot be solved, either because of the network geometry or because of the type of observations or because of the coordinate system that shall be used for the adjustment.

• **Comparison of Identical Observations:** This section reports upon multiple observations to the same point that differ by a certain amount and may, therefore, be suspect. If there is a high probability that an error exists, the W-Test value will be marked with bold red text. Other possibly suspect observations are left to the discretion of the user.

• **Comparison of Observations and Approximate Coordinates:** This section reports upon observations checked against the pseudo-observations, that are derived from approximate coordinates. Observations, for which a large difference is identified, are listed.

• **Possibly Identical Observations:** This section reports upon observations which are suspected to be identical. You may wish to investigate if observations are really separate.

• **Possibly Coinciding Stations:** This section reports upon stations which coincide with a distance of less than 2 meters. Such stations are suspected to be identical, though they have not been given the same point Id.

Depending on your data additional warning messages may appear after the last section of a pre-analysis report.

### 4.7.6 Least Squares Adjustment

#### 4.7.6.1 Mathematical Model

**Mathematical Model**

Usually in a survey, the observations themselves are not the quantities, which we are aiming for. Instead, we use the observations to determine unknown parameters, e.g. the coordinates of stations in a network. The observations are expressed as a function of the parameters in a so-called functional or mathematical model.

In some cases, the model representing the relations between the observations and the unknown parameters is very simple. The relation, for instance, in a 1-dimensional leveling problem between the observed height differences and the unknown heights is simply linear:

\[ \Delta X_{i,j} = h_j - h_i \]

More complicated is the case for a GPS network where the unknowns are coordinates \((X,Y,Z)\) to be determined in a reference system different from that of the observed baselines \(\Delta X\):

\[ \Delta X_{i,j} = \text{function} (\alpha, \beta, \gamma, \mu, X_1, Y_1, Z_1, X_j, Y_j, Z_j) \]

with \(\alpha, \beta, \gamma, \mu\) = transformation parameters

As the least squares approach requires **linear** equations, the complex model above must be linearized. Usually this means that a number of **iterations** is needed to reach a solution. Moreover, **approximate** values for the coordinate unknowns in the adjustment are required. Bad approximate values can lead to an increasing number of iterations or, in the worst case, to no convergence at all.
Nuisance parameters
Since coordinates are our main concern, other unknowns in the mathematical model are not always useful for us. Unknowns such as the transformation parameters mentioned above, are called additional or nuisance parameters. Typical nuisance parameters are: transformation parameters, scale factors, azimuth offsets, orientation unknowns and refraction coefficients. Some of these parameters can be kept fixed at a certain value, which makes them not be corrected in the adjustment. Whether or not to keep parameters fixed is a question which cannot easily be answered. We must always be careful to avoid overconstraining as well as overparameterization. The introduction of refraction coefficients, for example, could result in the absorption of systematic effects which are not caused by refraction. However, ignoring the refraction, when in fact it does have an influence on the measurements, will cause an equally unfavourable effect. The success of what could be referred to as ‘tuning’ of the model will depend largely on the user’s expertise.

Another typical nuisance parameter is the scale factor which may be estimated for distance measurements. The aim of introducing a free scale factor in the adjustment is to overcome a possible bias in the internal scale of the measurement equipment and, in more general terms, to prevent the overconstraining of the network in a free adjustment. A free scale factor will ‘shrink’ or ‘blow up’ the network in order to make it fit to the known stations in constrained adjustments. As a result, in some situations a free scale factor may obstruct the statistical testing of known stations: an outlier in the coordinates of a known station could remain undetected when, due to the ‘shrink’ or ‘blow up’ effect, the network is forced to fit to the known stations without any rejections. The outlier will be absorbed by the scale factor, which will subsequently have a value distinctly different from 1.0. It is, therefore, recommended to examine the value of the scale factor after the adjustment and, in case of doubt, to re-run the adjustment with a fixed scale.

Singularity
An adjustment fails when the mathematical model, as represented by the design matrix and normal matrix, is singular.

Singularity is caused by:
• an ill-posed problem
• an improperly formulated model

A problem may be ill-posed because we expect too much from the observations, or because not enough observations are included. An example of an ill-posed problem is the determination of the 2D coordinates of an unknown station by a single horizontal direction from another station.

A model is improperly formulated, when too many parameters are included. In general an improperly formulated model does not correctly represent the existing physical reality.

Additionally, the ill-conditioning of the normal matrix N could result in singularity, a problem which occurs especially with computerized solutions to least squares problems. An ill-conditioned matrix can become ‘singular’ as a result of the internal accuracy limits of the computer hardware. An example of an ill-conditioned problem is the intersection of a station by two or more nearly parallel directions.
Minimum number of constraints

Apart from the problems mentioned above, an adjustment of terrestrial observations cannot be solved unless the location, orientation and scale of the network are established, i.e. a 'datum' must be defined. This is done by imposing constraints on the solution. The minimum number of constraints depends on the dimension of the network:

In a 3D network there are 3 translations, 3 rotations and 1 scale factor. The singularity is then eliminated by fixing at least 7 coordinates of 3 stations \{Lat1, Lon1, h1, Lat2, Lon2, h2, h3\}.

4.7.6.2 Stochastic Model

Stochastic Model

A geodetic observation, such as a direction, distance or height difference, is a random or stochastic variable. A stochastic variable cannot be described by a single and exact value because there is an amount of uncertainty involved in the measurement process. For example, repeatedly measuring the distance between two stations will result in a range of different values. This variation is accounted for by a probability distribution. This means that in addition to the mathematical model, it is necessary to formulate a second model which describes the stochastic deviations of the observations; the stochastic model.

For geodetic observations a normal probability distribution is assumed (see below). The distribution is based on the mean \(\mu\) and the standard deviation \(\sigma\).

The mean \(\mu\) represents the value of the mathematical expectation of the observable. The standard deviation is a measure of the dispersion or spread of the probability. The standard deviation characterises the precision of the observation. The square of \(\sigma\) is called the variance. By definition there is a 0.684 probability that normally distributed stochastic variables will fall within a window limited by \(-\sigma\) and \(+\sigma\). For a window limited by \(-2\sigma\) and \(+2\sigma\) this probability is 0.954. In general, the probability that a stochastic variable takes a value between \(x_1\) and \(x_2\) is equal to the area enclosed by the curve, and the \(x_1\) and \(x_2\) ordinates. This is the shaded area in the diagram above.
Correlation of observations

It is possible for two or more observations to be interdependent or correlated. This means that a deviation in one observation will influence the other. The correlation between two observations \( x \) and \( y \) is mathematically expressed by the covariance \( \sigma_{xy} \). The covariance is also used in the correlation coefficient, defined as:

\[
\rho = \frac{\sigma_{xy}}{\sigma_x \sigma_y}
\]

The coefficient takes values between minus and plus one:

\[-1 \leq \rho \leq 1\]

If the observations are not interdependent it follows that \( \rho = 0 \). The vector elements \((DX, DY, DZ)\) of a GPS baseline are an example for correlated observations. To express this correlation a 3x3 matrix is used. This symmetric matrix is a combination of standard deviations and correlation coefficients:

\[
\text{Des and Adjust } \rho - \text{matrix} = \begin{bmatrix}
\sigma_{xx} & \rho_{xy} & \rho_{xz} \\
\rho_{yx} & \sigma_{yy} & \rho_{yz} \\
\rho_{zx} & \rho_{zy} & \sigma_{zz}
\end{bmatrix}
\]

Sigma a priori

In essence the stochastic model consists of a choice for the probability distribution of the observations. Practically this means that for each observation a standard deviation \( \sigma \) is chosen. The value for \( s \) is based on knowledge about the measurement process (conditions in the field, type of instrument) and experience. The standard deviation of most observation is supposed to consist of an absolute part, and a relative part. In the relative part the dependence on the distance between station and target, which characterises the precision of most observations, is accounted for. The standard deviations are entered in the variance-covariance matrix \( \Sigma \). The precision of the unknowns in the adjustment depends on the precision of the observations given in \( \Sigma \), and on the propagation of this precision by the mathematical model.

4.7.7 Statistical Testing

4.7.7.1 Overview

Statistical Testing

Both, the mathematical and the stochastic model are based on a set of assumptions. This set is called a statistical hypothesis. Different assumptions result in different hypotheses. Statistical testing is used to verify the hypotheses. A special set of assumptions is referred to as the null-hypothesis \( H_0 \). This hypothesis implies that:

- your observation does not contain any gross errors (blunders)
- your mathematical model delivers a correct description of the relations between your observations and unknown parameters
- the chosen stochastic model for your observations appropriately describes the stochastic properties of the observations

It is clear that there are two possible results for the testing of a hypothesis: acceptance or rejection. A specific cut-off point or critical value decides on acceptance or rejection. The critical values establish a window of acceptance.
The further beyond this window a result is, the less certain the set of assumptions is satisfied. Critical values are determined by you choosing a level of significance $\alpha$. The probability that the critical value is exceeded, although the set of assumptions is valid, is equal to $\alpha$. In other words, $\alpha$ is the probability of an incorrect rejection. Alternatively, the complementary level of confidence $1-\alpha$, is a measure of the confidence you can have in the decision.

**While testing the null-hypothesis $H_0$ there are two unfavourable situations that might occur:**

- Rejection of $H_0$ while in fact it is true. The probability of this situation occurring is equal to the significance level $\alpha$. This situation is called a Type I error (see table below).
- Acceptance of $H_0$ while in fact it is false. The probability of this situation occurring is $1-\beta$, with $\beta$ being the power of the test. This situation is called a Type II error (see table below).

<table>
<thead>
<tr>
<th>Situation</th>
<th>Decision: accept $H_0$</th>
<th>Decision: reject $H_0$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$H_0$ true</td>
<td>correct decision: probability = $1-\alpha$</td>
<td>Type I error: probability = $\alpha$</td>
</tr>
<tr>
<td>$H_0$ false</td>
<td>Type II error: probability = $1-\beta$</td>
<td>correct decision: probability = $\beta$</td>
</tr>
</tbody>
</table>

See the following topics for further information on testing the null-hypothesis and alternative hypotheses:

- F-Test
- W-Test
- T-Test

**4.7.7.2 F-Test**

The F-Test is a commonly used multi-dimensional test for checking the null-hypothesis $H_0$. The F-Test is often called the overall model test, because it tests the given mathematical and stochastic models in general.

The F-value is defined by the expression:

$$ F = \frac{s^2}{\alpha^2} $$

with

- $s^2$ = a-posteriori variance factor derived from the computed residuals and the redundancy
- $\alpha^2$ = a-priori variance factor.

The F-value is tested against a critical value of the F-distribution, which is a function of the redundancy and the significance level $\alpha$. But the information provided by the F-test, i.e. the acceptance or rejection of the null-hypothesis, is not very specific. Therefore, if $H_0$ is rejected it makes sense to ask for the reasons why by tracing errors in observations or pre-assumptions. There are three reasons for rejection:
* gross errors
  If you suspect that $H_0$ is rejected because of a gross error in one of the observations, then the so-called **data snooping** will provide you with revealing information by applying the W-Test in order to seek for and find errors in individual observations. The F-Test and the W-Test are interlinked by a common value for the power of test $\beta$. The method is the called the B-Method of testing.

* incorrect mathematical model
  If you suspect that $H_0$ is rejected because of a mathematical model that is incorrect or not refined enough, then check the Adjustment Settings. For example, re-define and make the vertical refraction coefficient or the **scale factor correction** be used to improve the mathematical model.

  See also:
  Advanced Terrestrial Parameters

* incorrect stochastic model
  If you suspect that $H_0$ is rejected because of a stochastic model that is incorrect or not refined enough, then check the Adjustment Settings. If the a-priori variance-covariance matrix is too optimistic increase the input **standard deviations** and/or **centering/height errors** of the observations to improve the stochastic model.

  See also:
  TPS Accuracy Information

☞ When you optimize the mathematical or stochastic model always bear in mind that the purpose of statistical testing is not to have all observations accepted, but to detect outliers and model errors.

### 4.7.7.3 Chi-Square Test

**Chi-Square Test**

Unlike the F-Test used in the B-Method of testing, the Chi-square is a two-tailed test, i.e. it tests the Chi-square value against both the upper and the lower bound.

In practice, if the Chi-square value is lower than the lower bound, this means that the standard deviations are too pessimistic. On the other hand, if the Chi-square value is higher than the upper bound, this can be interpreted in the same way as if the F-Test fails.

See also:
Interpreting Test Results

### 4.7.7.4 W-Test

**W-Test**

A rejection of the F-Test does not directly indicate the reason for the rejection itself. Thus, in case the null-hypothesis is rejected, other hypotheses must be formulated if you want to describe a possible error or a combination of errors.

There is an infinite number of hypotheses which you could formulate as an alternative for the null-hypothesis. But the more complex these hypotheses become the more difficult they are to be interpreted. A simple but effective hypothesis, though, is the so-called **conventional alternative hypothesis**, based on the assumption that you have to suspect an outlier in only one **observation** while all others are correct. The one-dimensional test associated with this hypothesis is called **W-Test**.
The assumption that just a single outlier corrupts your network is, indeed, quite realistic. A strong rejection of the F-Test can often be traced back to a gross error in just one observation. The conventional alternative hypothesis for each observation implies that each individual observation is tested. The process of testing each observation in a network by a W-Test is called data snooping.

Often the size of the least squares correction alone is not precise enough to indicate an outlier when you check the observations in your network. A better test quantity, though only suited for uncorrelated observations, is the least squares correction divided by its standard deviation. For correlated observations, e.g. for the three coordinate elements of a baseline, the complete weight matrix of the observations must be taken into account. This condition is fulfilled by the test quantity W of the W-Test, which has a standard normal distribution and is most sensitive to errors in one of the observations.

The critical value $W_{\text{crit}}$ depends on your choice of the significance level $\alpha_0$. If the W-Test is rejected because of $W > W_{\text{crit}}$, there is a probability of $1 - \alpha_0$ that the corresponding observation indeed holds an outlier. On the other hand, there is a probability of $\alpha_0$ that the observation does not hold an outlier, which implies that the rejection was unjustified. In geodesy values for $\alpha_0$ between 0.001 and 0.05 are most commonly used. The table below gives you an overview on the $\alpha_0$-values and their corresponding critical values. Which $\alpha_0$ you effectively choose depends on how strict and rigid you intend to test your observations. A very strict testing (with a small critical value), will lead to a larger $\alpha_0$ and subsequently to an increased probability to reject valid observations. An $\alpha_0$ value of 0.001 implies one false rejection in every 1000 observations. This has proven to be a realistic choice.

<table>
<thead>
<tr>
<th>significance level $\alpha_0$</th>
<th>0.001</th>
<th>0.010</th>
<th>0.050</th>
</tr>
</thead>
<tbody>
<tr>
<td>critical value W-test</td>
<td>3.29</td>
<td>2.58</td>
<td>1.96</td>
</tr>
</tbody>
</table>

Essential for a successful testing by the B-Method is that an outlier is detected with the same probability by both the F-Test and the W-Test. To achieve this the test power $\beta$ is by default fixed on a level of usually 0.80 for both tests. You can adapt $\beta$ by 10% up or down in the settings for the Test Criteria. The W-Test’s level of significance $\alpha_0$ has to be selected, too, which leaves the F-Test’s level of significance $\alpha$ to be determined. With $\alpha_0$ and $\beta$ being fixed, $\alpha$ strongly depends on the redundancy in the network and will increase for large networks with many observations and a considerable amount of redundancy. In such networks it becomes difficult for the F-Test to react on a single outlier. The F-Test, being an overall model test, is not sensitive enough to achieve this task. Thus, it is common practice to always carry out a data snooping, no matter what the result of the F-Test might be.

See also:
Test Criteria

### 4.7.7.5 T-Test

**T-Test**

As discussed in the topic on the W-Test, the **W-Test** is a 1-dimensional test which checks the conventional alternative hypothesis. This hypothesis assumes that there is just one erroneous observation at a time. This so-called data snooping works very well for single observations, e.g. for directions, distances, zenith angles, azimuths or height differences. However, for some observations
such as GPS baselines, it is not enough to test the DX-, DY-, DZ-components of each vector separately. It is imperative to test the baseline as a whole as well.

For this purpose we introduce the T-test. Depending on the dimension of the quantity to be tested, the T-test is a 3- or 2-dimensional test. As with the W-Test, the T-Test is also interlinked with the F-Test by the B-Method of testing. The T-Test has the same power as both other tests, but has its own levels of significance and its own critical values (see tables below).

Significance level/critical value for 2-dimensional T-test, based on \( \alpha_0 \) of the W-test:

<table>
<thead>
<tr>
<th>significance level ( \alpha ) (2-dim)</th>
<th>0.001</th>
<th>0.010</th>
<th>0.050</th>
</tr>
</thead>
<tbody>
<tr>
<td>critical value T-test</td>
<td>5.91</td>
<td>3.81</td>
<td>2.42</td>
</tr>
</tbody>
</table>

Significance level/critical value for 3-dimensional T-test, based on \( \alpha_0 \) of the W-test:

<table>
<thead>
<tr>
<th>significance level ( \alpha ) (3-dim)</th>
<th>0.001</th>
<th>0.010</th>
<th>0.050</th>
</tr>
</thead>
<tbody>
<tr>
<td>critical value T-test</td>
<td>4.24</td>
<td>2.83</td>
<td>1.89</td>
</tr>
</tbody>
</table>

The T-test is equally useful when you want to test for slight deformations on known stations. The data snooping successfully finds an outlier that might have occurred, for example, due to a typing error in either the Easting or the Northing or the Height component causing a gross error in one of the coordinate components. But the deformation of a whole station might stay undetected by the data snooping when the shifts caused by the deformation in each coordinate component are relatively small. For testing a possible deformation influencing the whole coordinate triplet, i.e. the Easting and the Northing and the Height a different alternative hypothesis is needed. The 3-dimensional T-test on the complete coordinate triplet is better equipped to trace the deformation, although it will not be able to trace the exact direction into which the station has moved.

☞ A situation in which the W-test is accepted but the associated T-test of the observation is rejected, which is not unlikely in practice, does not necessarily imply a contradiction. It is simply a matter of having tested different hypotheses.

---

### 4.7.7.6 Interpreting Test Results

**Interpreting Test Results**

When dealing with test results we always have to keep in mind that a certain amount of probability is involved in the process, and that there is no ‘absolute truth’. Statistics in general should be used with discretion, i.e. together with common sense, practical experience and external independent evidence.

As discussed in the topic on the F-Test a rejection of the F-Test, meaning a rejection of \( H_0 \), may happen because of:

- gross errors or blunders
- an incorrect mathematical model
- an incorrect stochastic model

Needless-to-say, a combination of these reasons for a rejection is also possible, which makes it difficult to define strict rules for drawing conclusions from
the F-Test results. In general, a rejected F-Test in combination with a pattern of rejected W-Tests points to a model error. An incidental W-Test rejection points to one or more gross errors or blunders.

Since F-Test, W-Test and T-Test are interlinked, it is best to interpret all tests in combination:

- A rejected F-Test in combination with a limited number of rejected W-Tests (T-Tests) usually points to one or more gross errors.
- If the F-Test is rejected and all observations of a specific type (e.g. all zenith angles) are rejected as well, the problem probably lies within the mathematical model which needs correction or refinement then. For instance, if all W-Tests for the zenith angles are rejected, it could be helpful to include refraction coefficients.
- If the F-Test is rejected together with most of the W-Test results (without extremes), the problem probably lies within the stochastic model and you can suspect that the input standard deviations are too optimistic. On the other hand, if the F-Test result is well below the critical value and the W-Test (T-Test) results are all close to zero, then the input standard deviations are possibly too pessimistic.

Example:

Suppose that the data snooping on the observations in your network results in a (limited) number of rejections. Further assume that the rejections are not caused by mathematical model errors and that obvious errors such as typing mistakes have been fixed. Then this leaves you with a number of options:

- **Remove the corresponding observations**
  This is a valid but rather abrupt way of handling rejections. Remember that the removal of observations decreases the redundancy and, therefore, influences precision and reliability.

- **Re-measure the corresponding observations**
  Re-measuring observations is an obvious but often expensive way to eliminate rejections, especially when the fieldwork is already completed. Thus, it is recommended to process and cross-check as much of the data as possible on site.

- **Increase the standard deviation of the corresponding observations**
  Increasing the standard deviation of an observation always works, because it always results in decreasing the F-, W-, T-Test values. Keep in mind, though, that the goal is not to get all tests accepted, but rather to detect blunders or model errors!

- **Ignore the rejections**
  This option is obviously very risky and should only be applied if the W-Test results just exceed the critical value. Have a look at the estimated error coming with the rejection and see whether it is acceptable or not, because we also have to keep in mind that, depending on the level of significance, it may always happen that a valid observation is rejected.

☞ Unless there is clear evidence of the reason for an error, e.g. a typing error, do never edit observations just to make it better fit into your network!
4.8 Features

4.8.1 Overview

Features

In the Features module you can manage the thematic information of imported or created data within the current project. Points, Lines and Areas are Features and can have thematic data assigned to them.

Feature Coding is used to describe topographical details of features in the field. The Code Table holds all the thematic and style information that are applicable to the field data in Leica Infinity. Code Tables can be created or registered from within the Backstage > Code Table Management.

See also:
Code Tables

To apply coding style information to the field data, you can assign a Code Table to the project while creating a new project or later from within the Backstage > Info and Settings.

See also:
New Project
Info and Settings

After importing data to the project, use the Inspector to view all features collected with or without codes. This is also where you will see when a code was created in the field and is not in the Code Table.

You can edit a feature code for a single point in the properties.

Feature codes can be managed locally inside a project by the Project Code Manager, which allows you to edit or apply styling. Features in the project can be edited to have an individual style. All feature code edits made with the Project Code Manager are project specific.

See also:
Project Code Manager

Features in the Inspector

In the Feature Coding tab of Inspector all the thematic codes attached to your current project are displayed. You can sort the view by code groups or layer or code name. The coding information is grouped into two groups:

- **Code Table**
  lists the codes that belong to the project’s Code Table
- **Field Codes**
  lists imported new codes that are not part of the Code Table.

☞ You cannot modify any information in this view.

Features in the Properties window

In the Properties window you can find also coding information for the selected object (Point, Line & Area). The information is divided into Feature, Styling and Code sections. These properties can be changed individually:
• In the **Feature** section the **Layer** can be selected or modified to which the object belongs to.
• In the **Styling** section the **line color**, **line width** and **shading color** for lines and areas can be modified.
• In **Code** section you can assign another code to the object within a code group.

**Feature coding workflow**

**General steps to follow:**
1. Create a Code Table with codes, coding style and layer information including blocks in Leica Infinity. - You can also register an existing Code Table.
2. Export a Code Table to a Code List for a specific instrument and use it during data collection in the field.
3. Assign a Code Table to your project while creating it. - You can assign a Code Table also later on when you missed this step.
4. Import data to the project. The data will be processed based on the assigned Code Table.
5. Check field data to be correct with the thematic information. If needed then manage codes using Project code Manager and export the modified Code Table to the instrument.
6. Export the data to a DXF / DWG file.

**4.8.2 Creating new features**

**How to create new Features?**

Functionality to create new features is available via the ribbon bar in the Features module. Alternatively, you can access the same functions from within the context menu in the graphical view.

☞ New points can also be created via the ribbon of the Home module or the Processing module.

To indicate that feature creation is on, the cursor appears as a cross-hair during all Create operations.

**New Point:**

New points can be defined:
• via the Property Grid. Enter the point details and press the Create button at the bottom.
• by picking points from CAD, BIM, ESRI Shape files entities as well as base maps.

See also:
How to create new points from CAD entities?

**New Line, Arc, Spline and Area:**

New lines, arcs, splines or Areas are “drawn” in the graphical view. Their properties can be modified via the Property Grid.

1. Select the first point by clicking onto it in the graphical view.
2. Click on the next point and continue till you come to the last point.
3. Right-click and select:
   - **End** to finalize the feature. Alternatively, click **Create** in the Property Grid.
   - The feature will be created as specified in the Property Grid. The cursor changes back to normal.
   - **Remove last point** to remove the point that you have selected last. Via this function you can make your operations undone step-by-step.
   - **Cancel** to cancel the operation. Alternatively, click **Cancel** in the Property Grid.
   - **Close** to end a line feature on its start point.
   - **Continue...** to continue a feature using a different type of geometry.

See also:

- How to edit the Feature geometry?

  - Lines have to consist of two points minimum. Arcs can always only consist of three points maximum.
  - Areas and closed lines have to consist of three points minimum.

### 4.8.3 Creating new points from CAD

**How to create new points from CAD entities?**

1. Click on **New Point** in the ribbon bar.
   - To indicate that feature creation is on, the cursor appears as a cross-hair during all Create operations.

2. In the graphical View pick a point. This can be the vertex point of CAD/BIM entities, ESRI Shape files or of a point cloud (surface).
   - The new point will snap to the existing point/vertex and adopt its coordinates.
   - The coordinates and other point properties can be viewed and edited in the New Point tool.
   - Change the Point Id, Code and Layer information if required.

3. Pick the next point.
   - Every time you pick a point it will be added to the list in the Property grid. The grid always displays the properties of the point that has been picked last.
   - To view/edit the properties of a previously picked point open the drop-down list at the top of the Property grid and select it from the list.

4. When you have picked all points that shall be created press the **Create** button in the Property grid.
   - Only then will the points be created and added to the Leica Infinity library.

### 4.8.4 Editing feature geometry

**How to edit the Feature geometry?**

The functionality to edit features is available from within the context menu in the graphical view.

To edit features via the ribbon go to the Features module. Activate the feature to be edited by selecting it.
To indicate that feature editing is on, the cursor appears as a cross-hair during all Edit operations.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add point at Start/End of a Line" /></td>
<td>Add point at Start/End of a Line</td>
<td>You can choose to add points either at the start or the end of a line or spline. Click the point(s) to be added. When you are done, right-click and select End from the context menu or press Create in the Property Grid.</td>
</tr>
<tr>
<td><img src="image" alt="Add point in Between" /></td>
<td>Add point in Between</td>
<td>You can choose to add points in between. Right-click the segment where additional points shall be inserted and select Add Point in Between. The existing segment will be removed. When you are done, right-click and select End from the context menu or press Create in the Property Grid. In Between is only available via the context menu.</td>
</tr>
<tr>
<td><img src="image" alt="Remove" /></td>
<td>Remove</td>
<td>You can remove points from a feature. Select the feature and click the point to be removed. In order to remove a point via the context menu, you have to select the point, not the feature.</td>
</tr>
<tr>
<td><img src="image" alt="Continue" /></td>
<td>Continue</td>
<td>You can continue features with the same or another feature type. Follow the Add Point workflow. The feature will be continued at its end. You cannot use Continue with closed lines or area features. To continue a closed line or an area, go and add points in between (see above).</td>
</tr>
<tr>
<td><img src="image" alt="Convert" /></td>
<td>Convert</td>
<td>You can convert lines to splines or splines to lines.</td>
</tr>
<tr>
<td><img src="image" alt="Convert to Arc (Midpoint)" /></td>
<td>Convert to Arc (Midpoint)</td>
<td>You can also convert a feature to an arc. Right-click on a point and select Convert to Arc from the context menu. The arc will be created from the previous to the next point. Features consisting of less than three points cannot be converted.</td>
</tr>
<tr>
<td><img src="image" alt="Join" /></td>
<td>Join</td>
<td>You can join line features that share their start and/or end points.</td>
</tr>
<tr>
<td><img src="image" alt="Split" /></td>
<td>Split</td>
<td>You can split features. Click the point on which you want to split the feature. When you split an area it will be converted into lines.</td>
</tr>
<tr>
<td><img src="image" alt="Reverse" /></td>
<td>Reverse</td>
<td>You can reverse the direction of a feature, which means that the start point becomes the end point and vice versa.</td>
</tr>
</tbody>
</table>
4.8.5 Multi-Editing of Point Code Information

To edit the coding information for more than one point at a time:

1. Select the points for which you want to edit the code information either from inside the Library section of the Navigator or from inside the Points, Lines & Areas tab of the Inspector.
   
   In the Points, Lines & Areas tab of the Inspector go the Points section and select the points.

2. Right-click into the selection and select the Edit code from the context menu.

The Edit code operation will be executed for all selected points.

☞ For observations you can multi-edit the target point codes. For further information see the topic: Observation Properties

4.8.6 Copying from CAD

Functionality to Copy from CAD is available via the ribbon bar in the Features module. Alternatively, you can access the same functions from within the context menu in the graphical View.

You can import entities from *.dx files (CAD data), from *.shp files (GIS data) as well as from *.ifc files (BIM data).

1. In the graphical View, select the entities that you want to import. To select more than one element at a time keep the CTRL-key pressed while clicking onto each element or keep the Shift-key pressed while dragging a rectangle around the group of elements to be selected.
   See also:
   Graphical View

2. Modify the Copy Settings if required.
   See also:
   Copy from CAD: Settings
3. Select one of the following options:
   - **All** to import the selected entities and their points.
   - **Points** to import only the points belonging to the selected entities.
   - **All from Layer** to import all features and points that are on the same layer as the selected entity.
   - **All Points from Layer** to import only the points that are on the same layer as the selected entity.
   - **To Alignment** to import all selected entities to the project as alignment object(s).
   - **To Road** to import all selected entities to the project as a Road object.
   - **All Points from Layer** to import only the points that are on the same layer as the selected entity.
   - **All** to import the selected entities and their points.
   - **Points** to import only the points belonging to the selected entities.
   - **All from Layer** to import all features and points that are on the same layer as the selected entity.
   - **All Points from Layer** to import only the points that are on the same layer as the selected entity.
   - **To Alignment** to import all selected entities to the project as alignment object(s).
   - **To Road** to import all selected entities to the project as a Road object.

   The entities and/or points will be copied to the Infinity Library.
The reference layer is copied to the Thematical Layers and the imported feature will belong to it.

   - **On how to manage layers see:** Project Code Manager
   - **Go to Backstage > Info & Settings** to define defaults for how CAD entities shall be written to the Infinity Library.

---

### 4.8.7 Copying from CAD: Settings

**Copy from CAD: Settings**

To open the Copy CAD Settings:
Click on Copy Settings in the Features ribbon bar.

By default the Copy CAD Settings open up as an additional pane next to the Properties grid.
The Copy CAD Settings can be set separately for Points, Lines, Areas, Surfaces, Alignments and Roads.

In the Backstage under Info and Settings you can pre-define which settings are assumed as default in each tab.
To restore the Leica Infinity defaults go to the Backstage > Info and Settings > Copy CAD to Library and press the Defaults button.
Defaults can be restored separately for Points, Lines, Areas, Surfaces, Alignments and Roads.

See also:
Info and Settings

---

### 4.8.8 Project Code Manager

**Project Code Manager**

The Project Code Manager allows you to manage all the thematic codes and layers attached to your current project. This includes the structured Code Table...
that you may have attached to your project and unassigned Field Codes that have been imported with your data, as well.

When importing data into the project codes that are related to data are checked against the project’s code table. If an imported code is not included in the project’s code table or it has more attributes than the same code in the code table then the imported code is shown in the Field Codes part of the Navigator.

**To launch the project Code Manager:**

In the **Features** module press the **Code Manager** button from within the ribbon bar.

The Code Manager opens in a separate window.

The assigned **Code Table** and the **Field Codes** are shown even if they are empty.

**To manage coding & coding style information:**

In the Code Manager select the **project** Code Table and go to the **Code Table** tab.

Choose from the following possibilities:

- Add a new Code Group/ Code/ Attribute
- Edit a Code Group/ Code/ Attribute
- Delete a Code Group/ Code/ Attribute

Field codes can not be edited within the project. To manage Field Code within the project add them to the project Code Table.

**To add imported field codes to the project Code Table:**

1. Under **Field Codes** navigate to the Code Group that contains the Code that you want to add to the **project** Code Table.
2. Select the Code in the **Content View** and cut it off from Field Codes by pressing **Ctrl+X** on the keyboard.
3. Navigate to the Code Group where you want to insert the Code in your Code Table and press **Ctrl+V**.
4. Edit the Code properties if needed.
5. To save your changes press Apply and OK.

You can select and move not only one Code but more Codes, a whole Code Group or a single Attribute from Field Codes to the Code Table.

Conflicts between the project’s code table content and the newly dropped in content is highlighted. You need to resolve conflicts before applying changes.

**To manage Thematic Layers:**

In the Code Manager select the **project** Code Table and go to the **Layers** tab.

Choose from the following possibilities:

- Add a new Layer to extend thematic grouping for the project features
- Edit a Layer to edit the style of all features on this layer
- Delete a Layer to remove the thematic grouping and style from the project

**To manage Blocks:**
In the Code Manager select the **project** Code Table and go to the **Blocks** tab.

Choose from the following possibilities:
- Edit a Block name
- Delete a Block to remove it from the project

**Export a Code Table**

The project Code Table can be exported to:
- a **Leica Infinity Code Table file** to be used by another Leica Infinity user
- a **SmartWorx DBX** to be used on an instrument

### 4.8.9 Rename

**Rename**

The Rename Tool lets you quickly rename a selection of Point IDs, and likewise Line, Area, Image and Point cloud IDs.

You can rename the selected items
- Using Search & Replace to replace (or remove) some characters.
- Using Rename by renumbering starting from a specific value using a Counter.
- Using Rename by adding fixed characters to the Current Id.

**Search & Replace**

**To search**

You may search for parts of the Current Ids that shall be renamed and replace these parts with a new combination of alphanumeric characters.

You may also search for spaces, dashes, dots and underscores to be replaced.

**To replace**

Define a replacement for the Search string. Spaces, dashes, dots and underscores may also serve or be included as part of the Replace string. If you want to remove a fixed part of the current Ids leave the replace string empty.

**Rename**

**To rename points, lines, areas, images or point clouds**

1. In the Inspector, go to the **Points, Lines and Areas** tab or to the Observations tab and select the items you want to rename. In the Navigator, items can be selected from the **Library** section. Points can also be selected from inside the **Source** section by selecting the job. Alternatively, you can also select items in the graphical View.
2. Press the **Rename** button in the Features ribbon bar or select **Rename** from the context menu to open the Rename Tool.
3. Tick the **Show Report** checkbox to show the Rename Report.
4. Press Apply.

☞ When changing the selection, the items to rename will be updated in the Preview.

☞ To remove a selected item from the list, so it is not renamed, select the items and press the Remove button.

**To define a new Id**
Enter any combination of alphanumeric characters and/or add the expressions by pressing the Add button.

Alternatively type [C], [ID] or [ID#-#].

To add an expression
Select an expression and click the Add button.

Three expressions are available:

**Numeric Counter [C]:** Numeric counter for renumbering the IDs. The following selection fields become active to define the Counter:
- **Start Counter at:** Define the number to start counting with.
- **Increment Counter by:** Define how the counter shall be incremented.
- **Counter Digits:** Define the digits that shall be reserved for inserting the counter.

**Current Id [ID]:** The Id which the selected items currently have. To modify the Current Id, you can enter any combination of alphanumeric characters or add a counter before or after.

**Part of Current Id [ID #-#]:** A part of the Id which the selected items currently have. To modify a part of current Id, you can enter any combination of alphanumeric characters or add a counter before or after.

### 4.8.10 Staked points in Infinity

**Staked Points in Infinity**

Make use of Leica Infinity to:

- prepare data for use with stakeout applications in the field. Such data can come from imported files including CAD files.
- import field stakeout application data to a project and view the details in the Inspector and the Property Grid; as well as within specific Stakeout Reports.

To see the differences in the graphical view the view needs to be zoomed in on single points.

Supported is the import of job data collected with the applications:

- Stake Points
- Stake DTM
- Stake Points & DTM
- Stake to Line (line, line with slope, grid, segment, segment with slope, quick line)
- Stake Road/ Check Road

In Leica Infinity staked points are written to the Points library as well as to a library of their own called Staked Points.
• Staked Points are grouped for easy viewing in the Inspector > Features tab.
• Stake Road/ Check Road results are grouped for easy viewing in the Inspector > Infrastructure tab.
• Run a report on selected results either by pressing the Reports button in the Home ribbon or by selecting Report > Staked Points from the context menu.

There will be additional reports for Staked Infrastructure and Checked Infrastructure. You can run them from general list of reports but also from the Infrastructure ribbon.

Define the Stakeout Tolerances in the Backstage > Info and Settings. Stakeout results exceeding the tolerances will be marked in bold red in the report.

See also:
Reports

**Stakeout Workflows**

Make design points coming from CAD available for use with Stakeout Field Applications:

1. Import of the CAD job into Leica Infinity.
2. Copy the CAD entities to be staked out from CAD into a project.
3. Export the project for use within the Stakeout Application in the field.

See also:
How to Copy from CAD?

To check and document stakeout results import the stakeout job into Leica Infinity.

The aim is to check the stakeout results. The differences between design coordinates and stakeout results can be:
• seen in the graphical view
• checked in the Inspector > Features tab or in the Infrastructure tab under Checks and Stakes.
• saved in a report

---

4.9 External Services

4.9.1 The Leica ConX Service

**The Leica ConX Service**

The Leica ConX Service allows you to login to iCON Build/ iCON Site projects and assign data to the project or directly to the units, that is the machines working on building sites.

**To connect to the Service:**

1. Click on Login in the External Services > Leica ConX ribbon bar.
2. Enter User and Password and click on Login.
   
   The Select a Project button becomes active.
3. Select the iCON project that you want to assign data to.
4. Click on Leica ConX Data to open the Leica ConX project window.
A default user can be set in the Backstage under Services > Leica ConX.

**To assign/unassign Leica ConX data:**

In the Leica ConX project window:

1. Click on \(\rightarrow\) to assign selected data to a unit.
2. Click on \(\leftarrow\) to unassign selected data from a unit.
3. Click on \(\times\) to delete the selected file from the server.

On how to export data to the Leica ConX Service see:

Export to Leica ConX

### 4.9.2 The Leica JetStream Service

**The Leica JetStream Service**

Leica Infinity supports the Leica JetStream Service and allows you to publish point clouds to an existing storage location.

To learn more about this service visit:

To publish the data:

1. In the Leica Infinity project select the **Point Clouds** for publication.  
   ☞ If no point cloud is selected, all point clouds are exported.

2. Click in the External Services ribbon bar.  
   Alternatively, click on **Export > Selection** in the Home ribbon bar.

3. In the Export dialog, click **Leica JetStream** in the tree view.  
   Go to the required storage location.

4. Press the **Export** button.  
   The point cloud(s) is/are stored in the defined storage location on the server.  
   ☞ The exported file is written to Exported Files\Leica Infinity Archive.

See also:  
Leica JetStream
5 Backstage

5.1 Overview

Backstage (File tab) The File tab bundles all so-called Backstage functionality. Here you can configure global settings and perform global operations.

- Data Import and Export
- Configuration of:
  - Info and Settings
  - New Project
- Managing Projects
- Creation and/or management of global objects under Tools:
  - Tools Overview
  - Using Services:
    - Leica Exchange
    - Leica ConX
    - HxGN SmartNet
    - Hexagon Imagery Program
    - OpenStreetMap
    - Map Services
- Configuration of:
  - Preferences
- Get Help and Support on:
  - Check for Updates
  - Localise Leica Infinity

5.2 Info and Settings

Info and Settings In this section of the backstage you can find information on the settings for the Leica Infinity project that you are currently working on. You can adapt the settings to your personal requirements.

☞ To save your settings as default for all future projects press the "Save as Project Defaults" button.
**Project and Project Customer Details**

View and/or edit the **Project Details** and **Project Customer Details** as set when you created a project under Backstage > New Project.

See also:

New Project

**Feature Coding**

Choose a different **Code Table** to be used with the current project. Press **Apply** to make your changes become effective in the current project.

---

**Coordinates & Units**

**Units**

Decide on your preferred distance, area, volume and angle **units** and the **decimal places** to be available.

Decide on your preferred temperature and pressure **units** and the **decimal places** to be available.

Choose the **coordinate order** you prefer. Available are Easting/ Northing or Northing/ Easting.

☞ Your choice is applied to the listing of coordinates in, for example, the wizards or the Property Grid. It does not apply to the content views, though, where a change in the column order can be achieved by drag and drop of columns.

**Coordinate Systems**

Choose one of the coordinate systems that are **stored with the project** to be used as the **Master**. Coordinate Systems are either stored to a project **automatically** by being imported together with raw data or can be **copied** to a project **manually** from inside the global Coordinate System Management under Backstage > Tools > Coordinate Systems.

The coordinate system you choose will be used for converting between WGS84 and local coordinates.

See also:

Coordinate Systems inside a Project

Coordinate Systems

Choose **None** if you want each job to be converted using its own coordinate system.

☞ If you want a different coordinate system to be **attached to a job** then change the Job Properties accordingly in the Property Grid.

View information on the Transformation and Residual distribution, on the Ellipsoid and Projection as well as on the Geoid and CSCS Model used with the selected coordinate system. A different Geoid or CSCS Model can be selected in the Coordinate System Properties.

See also:

Coordinate System Properties
**Coordinate Display**

Choose **Local** if you want Leica Infinity to hide WGS84 coordinate representations in the Inspector, the Property Grid and the Graphical View. Only WGS84 observations which **can be converted** to local grid will show up in the graphical view.

Choose **Local and WGS84** if you want Leica Infinity to output local grid and WGS84 coordinates. To display local grid coordinates is by default always selected. You can additionally select Geodetic and/or Cartesian coordinate representations to be output in either Local and/or WGS84 if available or convertible. The Inspector will show additional columns. In the Property Grid switch between representations by selecting a different **Output**.

☞ To be able to convert coordinates from one format to another a coordinate system has to be selected to be used with the project data.

**Coordinate Direction**

Choose to switch the Northing and/ or Easting.

---

**Points & Angles**

**Point Averaging Settings**

Define the **Maximum Distance** allowed between an average and the measurements from which it has been computed.

Define whether **weighted averages** shall be computed for the current project. The setting will be applied to Points and GNSS Tracks.

☞ For GNSS Tracks the average is computed with respect to the solution type. This means that if a Phase Fixed solution and a Code solution shall be averaged then automatically the Phase Fixed solution will be taken into account while the Code solution is ignored.

**Angle Reduction Parameters**

Define the **Angle Residuals** and **Slope Distance Residuals** to be allowed when computing sets of angles.

☞ The tolerance settings can also be changed for **single computation runs** in the Sets of Angles wizard or for **single targets** once a Sets of Angles computation is completed. To change the tolerances for single targets click the **button** in the **Observation** section of the **Sets of Angles Target** properties. The tolerances shown correspond to those last used but can be changed for single targets if required.

Define the maximum **Face Differences** to be allowed when computing sets of angles.

**Image Point Tolerances**

Defines the **Maximum 3D accuracy** allowed for the computed image points. If the 3D accuracy is outside of this value, no point is computed.

You can always reset your changes to the factory defaults.
**Staked Points**

Define the stakeout tolerances. Defaults are available. When you import stakeout data to Leica Infinity then the delta values that exceed the defined tolerances will be marked in bold red in the stakeout report.

See also:
Reports

---

**Data Processing: TPS**

**Default Traverse Adjustment Parameters**

Define the *default* parameters for adjusting traverses like *method* and *balancing*.

Decide whether you want to **Apply the computed scale to observations**.

**Tolerance Checks in Traverse Wizard**

Define which *Tolerance Checks* shall be used in the Traverse Wizard and enter different values for the *limits*.

**Station Difference before and after Adjustment**

Define the *maximum allowed difference between* stations before and after the adjustment computation.

The changes you make here will be used as defaults in the *Traverse Wizard*. You can always reset your changes to the factory defaults.

For entering different values for the tolerance checks the available decimal places should be set to at least five positions after the decimal point for angles and three positions after the decimal point for distances.

For detailed information on single parameters see:
Traverse Processing Parameters

---

**Data Processing: GNSS**

The sections ‘Data’ and ‘Processing Strategy’ correspond to dialogs in the GNSS processing module. See also:

Settings: Data
Settings: Strategy
Settings: Advanced

The defaults used in the advanced settings suffice most use cases. Only modify them if you are an advanced user and have special data to be processed.

The section 'Time' sets the time format used in the Inspector > Intervals View. See also:
GNSS Inspector

The section 'Computation' steers automated behavior that follows a computation.

You can also decide whether or not Navigated Tracks shall be processed on import. Only when this setting is active will GNSS Tracks automatically be recognized as data objects on import.
Level Line
Define default Level Line adjustment method - **By Distance** or **Equally**
Set the default tolerance values to flag the line information before applying adjustment

Observations
Set the default tolerance values to flag the Observation information to help identify data issues

Point Heights
Set the default tolerance values to flag the Height differences to be applied to the points

Staff Corrections
Set the default Staff Correction values that could be applied in a Level Line adjustment

General
Set the **general parameters** for adjustment computations and iterations

Test Criteria
Define the **test criteria** to be used in adjustment computations

Advanced Terrestrial Parameters
Decide whether **reduced observations** and/or **refraction coefficients** and **scale factor corrections** shall be used
Define the values for the refraction coefficients and scale factor corrections

Coordinate System
Decide on the **coordinate system** and **height mode** in which your observations shall be adjusted
Define **rotations about the axis** and a **scale** if required.
The changes you make here will be used as defaults in the **Adjustment** module of your project. You can always reset your changes to the factory defaults.

☞ For entering different values the available decimal places should be set to at least five positions after the decimal point for angles and three positions after the decimal point for distances.

For detailed information on single parameters see:
General Adjustment Settings
Test Criteria
Advanced Terrestrial Parameters
Coordinate System Settings
**Network Adjustments: Accuracy**

**TPS**
Define standard deviations and centering and height errors for TPS Observations

**GNSS**
Define standard deviations and centering and height errors for GNSS Observations

**Level**
Define standard deviations and centering and height errors relative to the Level data

---

**Copy CAD to Library**

The Copy from CAD Settings can be set separately for Points, Lines, Areas, Surfaces, Alignments and Roads.

Define the Point Role that points copied from CAD shall have. Choose between “User-entered” or “Control”.

Define a Naming Scheme (a prefix or a suffix) that entities copied from CAD shall have.

Separate prefixes and/or suffixes can be defined for points, lines, areas, surfaces, alignments and roads.

Decide if/how the imported entities shall be coded.

A code table needs to be defined.

Surfaces and Roads cannot be coded.

Decide on which layer the imported entities shall be:

- by default the layer structure will be taken over from the source file.
- if the source file does not contain layer information, then the entities will be imported to a Default layer.

If a code table is defined and codes are assigned to layers, then layer selection will be blocked.

Define how heights shall be managed for points copied from CAD.

Define a default height that 2D objects shall get.

You can also specify a height to be excluded. Entities with that height will be copied either as 2D objects (with no height) or they will get the default as specified above.

Defaults can be restored separately for Points, Lines, Areas and Surfaces

---

**Infrastructure**

**General**

Choose the way and with which precision chainages are displayed in the graphical View, Inspector and Property Grid.

Choose Major Interval and Minor Frequency to define how the alignment shall be segmented visually.

Define your own abbreviations for horizontal and vertical points of interest.
Road
Set the tolerance thresholds for the maximum deflection angle that two consecutive elements are allowed to have in a horizontal or vertical alignment. Exceeding values will be flagged in the application and reports.
The Stringline Chord Tolerance defines the spacing used for digitizing stringlines.
Curves need to be digitized as a sequence of straight segments and the tolerance defined here will be used for it.
☞ Angular and metric units can be changed under "Coordinates and Units" (see above).

5.3 New Project
New projects can only be created from inside the Backstage.

To create a new project:
1. Go to the Backstage and select New Project from the menu on the left.
2. Define the Project Details
   • give the project a unique Project Name
   • optionally, fill in details on the Surveyor
   • optionally, add Comments and Tags
3. Optionally, fill in Customer Details.
4. Decide on the Settings for Angle and Distance Units and the decimal places to be available. These settings define how the project data is presented.
   Optionally, choose a Code Table to be used with the project. To be able to do so at least one Code Table has to be globally available from inside the Backstage > Tools > Code Table Management.
5. Optionally, select a Coordinate System to be used with the new project. To be able to do so at least one Coordinate System has to be globally available from inside the Backstage > Tools > Coordinate System Management.
   If you choose None the new project will be created without using a specific coordinate system.
6. Choose a location where the new project shall be stored to.
7. Select the Create Project Subfolder checkbox to create project subfolders. Project subfolders provide a clear folder structure to organise the following data:
   • Data sent and received via ConX
   • Data sent and received via Leica Exchange
   • Exported data from Infinity
   • Imported data to Infinity
   • Reports generated within Infinity
8. Press the Create button to create and open the new project in the Home module.

5.4 Project Manager
Managing Projects
The whole data and object management in Leica Infinity is done in working units called Projects. Each project uses its own database. The same data and objects may belong to and can be handled in different projects as well. Invoke the Project Manager from the Backstage (File tab). All the projects that have been created / registered are listed there.
To see the list of all projects in this instance of application
Select Backstage > Project Manager.

Load an existing project into Leica Infinity
1. Select Backstage > Project Manager.
   A list of projects appears in Content Area.
2. Select the project to be loaded into the application.
3. Press Load.

Register a project that already exists on your hard disk
1. Select Backstage > Project Manager.
2. Press Project > Register Project.
   A new window appears.
3. Select the project you want to register.
4. Press Open to register or Cancel to skip the operation.

Unregister a project from Leica Infinity
1. Select Backstage > Project Manager.
   A list of projects appears in Content Area.
2. Select the project you want to unregister from the application.
3. Press Project > Unregister Project.

Delete a project from your hard disk that is registered in Leica Infinity
1. Select Backstage > Project Manager.
   A list of projects appears in Content Area.
2. Select the project you want to delete from your hard disk.
3. Press Project > Delete Project.

5.5 Preferences
Under Preferences you can configure global application settings.

Display
Under Display you can configure the graphical view. The settings you make here will apply to all projects.

Graphics Adapter:
Allows you to change from a discrete graphics card to internal graphics memory.

Background Color:
Allows you to choose a different background color for the graphical view.

Show Pivot Point:
Allows you to make the pivot point be shown or hidden in the centre of the graphical view.

Proxy
Under Proxy you can configure a proxy server. Only needed if your company establishes internet connections via Proxy.
By default, this option is disabled.
5.6 Tools

5.6.1 Tools Overview

From the Tools menu in the Backstage global objects are managed and/or created.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Code Tables</td>
<td></td>
<td>Targets</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Antennas</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Coordinate Systems</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Georeferenced Images</td>
</tr>
</tbody>
</table>

Use Copy to Project to use them inside your active project.

5.6.2 Code Tables

To manage Code Tables and the thematic data they hold independently of a current project go to the Backstage under Tools > Code Tables.

You can create new Code Tables or edit or delete existing Code Tables. You can register existing Code Table to your project. Code tables have the extension *.lict and can be registered from any storage device.

**To access the Code Table Management:**
Select Backstage > Tools > Code Tables.

**To create a new Code Table:**
1. From the Backstage > Tools > Code Tables select New.
2. Enter a Code Table Name.
   The Code Table name must be unique and is limited to maximum 16 characters
3. Enter a Description and a Creator. Those fields are optional.
   The Description and Creator is limited to maximum 16 characters.
4. Press OK to confirm or Cancel to abort the function.

**To delete a Code Table:**
1. From the Backstage > Tools > Code Tables select a Code Table.
2. Select Delete to remove the Code Table.
3. Press OK to confirm or Cancel to exit without deleting.

**To register a Code Table:**
1. From the **Backstage > Tools > Code Tables** select **Register**. A new window appears.
2. Select the **Code Table** that you want to register and press **Open**.
3. Press **OK** to register the Code Table or **Cancel** to abort the function.

**To edit a Code Table:**
1. From the **Backstage > Tools > Code Tables** select a Code Table.
2. Click on the field you want change. The field becomes editable.
3. Edit the field and press **Enter**.

☞ You can apply changes to code table content via the Code Manager tool.

---

### 5.6.3 Targets

**Targets**

Targets can be managed independently of the current project in the **Targets Tool**.

**To access the Target Management:**

Go to the Backstage **Tools > Targets**.

You can add **new**, user-defined targets to the list. Name and Constant can be edited inline.

☞ A list of default targets is available. Default targets can neither be edited nor deleted.

---

### 5.6.4 Antennas

**Antennas**

Antennas can be managed independently of the current project in the **Antennas list**.

**To access the Antenna Management:**

Go to the Backstage **Tools > Antennas**.

**Import Antennas:**

You can add new Antennas to the list. Name and Constant can be edited inline.

By default, the following calibration sets are available:

- **GEO++ GmbH Absolute** and **GEO++ GmbH Relative**: for Leica antennas only, include the elevation and azimuth calibration values.
- **Leica Absolute** and **Leica Relative**: for Leica antennas only, include the elevation only calibration values.
- **NGS 14 Absolute** and **NGS Absolute**: for Leica and third-party antennas, include the elevation and azimuth calibration values.

☞ **NGS Absolute** contains the NGS 08 calibration values.

☞ **NGS calibration set** provides the antennas calibration values published by NGS at the following link: [https://www.ngs.noaa.gov/ANTCAL/](https://www.ngs.noaa.gov/ANTCAL/)

**Copy to Project:**

Antennas can be copied from the Backstage into single projects to make them available in calibration sets for processing.
5.6.5 Coordinate Systems

To manage Coordinate Systems independently of a current project go to the Backstage under Tools > Coordinate Systems.

You can:

- open the Coordinate System Manager
- delete coordinate systems from the list
- import existing coordinate systems either from SmartWorx DBX (*.xcf) or from *.dat Coordinate System files or from LandXML.
- export coordinates systems as TRFSET.dat files, i.e. as Global Transformation Sets.
- copy selected coordinate system(s) to the current project
- access the Localization Tool

Coordinate Systems can also be imported directly to a project either as TRFSET.dat files or together with SmartWorx jobs or from LandXML. To make them vice versa available in the global Coordinate System Management they can manually be Exported to Global.

To be able to copy a coordinate system to a project, the project has to be open. You can only copy coordinate systems to the project which are not attached already.

The globally available coordinate systems are listed by their Name together with their Source and information on the Transformation and Residual distribution, on the Ellipsoid and Projection as well as on the Geoid and CSCS Model used with each coordinate system.

5.6.6 Georeferenced Images

Infinity supports the display of Georeferenced images. Using these images is a nice way to help visualize, reference and relate your project data.

Georeferenced images are shown as objects in the Library and can be set to visible or not visible. It's possible to use many Georeferenced images. An existing georeferenced image can be edited and updated with a new transformation.

Georeferenced Images are Global objects. You will find from the Backstage, under Tools menu, the Georeferenced Images list.

Import

Images can be imported from PNG or JPG format to the project.

When the images include a matching world file PNG+PNW or JPG+JGW, then they are imported and translated as a Georeferenced image.
Otherwise it is possible to reference these images using the Georeference Image Wizard inside the project or from the Tools menu in the Backstage.

1. Locate the image(s) from the disk to import.
2. Define the Import Settings unit for the file(s).
3. Press Import.

Note: Georeferenced images from a project can be exported to be used in other projects.

From the properties, press the Export to Global button.

Export
Georeferenced images can be exported in JPG format with the matching JGW world file.
1. Select the image to export.
2. Choose Georeference Image.
3. Edit the suggested file name.
4. Define the world file units.
5. Navigate to the desired export location.
6. Press Export.

5.6.7 Coordinate System Manager

5.6.7.1 Overview
In the Coordinate System Manager, you can create and manage all the components that constitute a coordinate system, i.e. Transformations, Ellipsoids and Projections as well as Geoid Models and CSCS Models.

To open the Coordinate System Manager:
1. Go to Backstage > Tools > Coordinate Systems.
2. Click the Manager button to open the Coordinate System Manager.

The ribbon bar gives access to the following actions:

Data Import to import existing coordinate systems either from SmartWorx DBX (*.xcf) or from *.dat Coordinate System files or from LandXML or from CSYS Infinity coordinate system file.

Export to export coordinates systems as CSYS Infinity coordinate system files or TRFSET.dat files, i.e. as Global Transformation Sets.

Copy to Project to copy selected coordinate system(s) to the current project.

Report to get a coordinate system report.

Create Geoid Field File to create a new geoid field file.

Create CSCS Field File to create a new CSCS field file.

New Coordinate System to create a new coordinate system.

Transformation to create a new transformation.
Ellipsoid to create a new ellipsoid.

Projection to create a new projection.

Geoid Model to create a new geoid model.

CSCS Model to create a new CSCS model.

Determine Transformation to determine a new transformation.

Edit

Delete coordinate systems from the list

To be able to copy a coordinate system to a project, the project has to be open. You can only copy coordinate systems to the project which are not attached already.

In the Properties window you are shown the properties of any selected item, be that a coordinate system, a transformation, an ellipsoid, a projection, a geoid model or a CSCS model. Some properties are editable. Confirm any changes with Apply.

In the status bar at the bottom:

• press the button to hide or show the Properties window.
• change the linear and angular units and the available decimal places if required
• change the way latitude and longitude are displayed if required

The functionality is similar to the Status Bar in the main frame.

See also:
Status Bar

If you have long lists make use of the Search functionality to quickly find an item.

5.6.7.2 Geoid Field File

Create Geoid field file

Geoid Models may also be used on the receiver in the field. This command enables you to create a Geoid field file.

Geoid models usually consist of a geoid height grid where a Geoid Separation is defined for each grid point. Depending on the extent and the grid spacing of the Geoid Model it may require considerable disk space. In order to use the Geoid Model on a GPS sensor the disk space has to be reduced and a special field file has to be created which will allow the field system to interpolate Geoid Separations.

This command enables you to extract a Geoid height grid from an existing Geoid Model for a particular area. The area boundary can be defined by a rectangle or circle and a grid spacing in meters can be selected. The file can then be uploaded to the receiver.

1. From the Coordinate System Manager, select Create Geoid Field File.
2. Select a Geoid Model from the list.

3. Select the **Interpolation Type**, which shall be used when interpolating in the Geoid Model field file. You can choose between Bi-quadratic, Bi-linear and Spline interpolation methods.

4. Select the method to define the limits of the Geoid field file. Select between **Center and Radius** and **Bounds**.

5. Enter the Coordinates of the Center point, the Radius and the Grid Spacing or enter the Coordinates of the South-west and North-east corner and the Grid Spacing.

6. From the file browser, select the path where the file shall be created.

7. Enter a File name without extension. (Extension "gem" will be added automatically)

8. Click on the **Create** button to confirm.

☞ Depending on the file size, this may take a while.

☞ Check the file size. If you wish to use the file on the System RAM it must not exceed a certain size. The maximum possible file size may vary depending on the free memory in the system RAM of the receiver. Refer to the Technical Reference Manual on how to free system RAM of the receiver.

---

5.6.7.3 CSCS Field File

**Create CSCS field file**  
CSCS Models may also be used on the receiver in the field. This command enables you to create a CSCS Model field file.

1. From the **Coordinate System Manager**, select **Create CSCS File**.

2. Select a CSCS Model from the list and Add a New CSCS Model.

3. Select the **Interpolation Type**, which shall be used when interpolating in the CSCS field file. You can choose between Bi-quadratic, Bi-linear and Spline interpolation methods.

4. Select the method to define the limits of the CSCS Model field file. Select between Centre & radius and Extents.

5. Enter the Coordinates of the Center point and the Radius or enter the Coordinates of the South-west and North-east corner.

6. From the file browser, select the path where the file shall be created.

7. Enter a File name without extension. (Extension "csc" will be added automatically)

8. Click on the **Create** button to confirm.

☞ Depending on the file size, this may take a while.

☞ Check the file size. If you wish to use the file on the System RAM, it must not exceed a certain size. The maximum possible file size may vary depending on the free memory in the receivers system RAM. Refer to the Technical Reference Manual on how to free system RAM of the receiver.
Coordinate Systems

A Coordinate System provides the information necessary to convert coordinates between different representations (Cartesian, Geodetic, Grid) and to transform coordinates between the WGS84 and a Local system.

Coordinate Systems can be imported and exported and copied to project.

See also:
Coordinate System Manager

☞ To be able to copy a coordinate system to a project, the project has to be open. You can only copy coordinate systems to the project which are not attached already.
☞ Coordinate Systems can always be deleted from the list of globally available coordinate systems.

Coordinate System Properties

The Properties window is filled dynamically depending on the selected coordinate system. It shows you information on all the components which constitute a coordinate system.

Different constituting components can be chosen. Basically all Transformations, Ellipsoids, Projections, Geoid Models and CSCS Models that are available from within the global Coordinate System Management are available for selection, too. But which of these are available for a specific coordinate system depends on validity.

The dependencies are as follows:

• When you select a coordinate system of with a Projection of Type Customized, then the connected Ellipsoid is predefined and cannot be edited. You cannot choose another. Customized projections are country-specific, predefined projections.
• If you select a Projection then an Ellipsoid must be selected, too.
• When you select a coordinate system with a Transformation that does not have common points stored with it, then there are no residuals to be distributed. This is typically the case with manually entered Classical 3D transformations. Residual Distribution will be set to None and cannot be edited.
• When you select a coordinate system with a Transformation of Type One-step, then Ellipsoid and Projection will be set to None and cannot be edited because knowledge of the local map projection and the local ellipsoid is not needed with One Step transformations and will thus not be available.
• When you select a coordinate system with a Transformation of Type Two-step, then Ellipsoid and Projection must be read from the transformation and cannot be edited.

Geoid and CSCS Models can be selected or imported.

• To import a Geoid or a CSCS model press the button and then the Select Field File button from within the fly-out.
• Only valid models are available for selection. For further information on validity see the topics: Geoid Models CSCS Models
5.6.7.5 Geoid Models

A Geoid Model can be defined for Geodetic or Grid coordinates and refers to a particular Ellipsoid. With a Geoid Model attached to a Coordinate System geoid separations can be computed for the points in your project.

If geoid separations are available you can switch between viewing Ellipsoidal and Orthometric heights.

Geoid models are always an approximation of the actual geoid. In terms of accuracy, they may vary considerably and in particular global models should be used with care. If the accuracy of the geoid model is not known it might be safer to use local control points with orthometric heights and apply a transformation to approximate the local geoid. The Classical 3D transformation can be used in areas where the geoid has a regular shape.

To import a Geoid Model:
1. In the Coordinate System Manager go to the Geoid Models tab and click Import from within the ribbon bar.
2. Browse for the *.gem file to be imported and open it.

To create a new Geoid Model:
1. In the Coordinate System Manager go to the Geoid Models tab and click New from within the ribbon bar.
2. In the Properties window give the geoid model unique Name.
3. Press the button to browse for and select a Geoid Model Field file (*.gem).
4. Press Create to create the new geoid model or Cancel to exit the function.

See also:
Coordinate System Manager

Types of Geoid Models

WGS84 Geodetic Models

Geoid Models of this type are of Coordinate TypeGeodetic based upon the WGS84 Ellipsoid. To obtain local orthometric heights the geoid separations are applied to the ellipsoidal heights on the WGS84 coordinate side, i.e. models of this type are never flagged to be applied on local side and they are only valid and can only be used with coordinate systems that either have TransformationNone or a transformation with Height ModeEllipsoidal, i.e. a transformation which flags the local heights as ellipsoidal.

Local Geodetic Models

Geoid Models of this type are of Coordinate TypeGeodetic based upon either a local Ellipsoid or the WGS84 Ellipsoid but flagged to be applied on local
side. To obtain local orthometric heights the geoid separations are applied to
the ellipsoidal heights on the local coordinate side. Models of this type are
valid and can be used with coordinate systems that either have Transformation
None or Classical 3D. The ellipsoid of the Coordinate System must be the
same as the ellipsoid used with the Geoid Model.

Local Grid Models

Geoid Models of this type are of Coordinate Type Grid based upon Ellipsoid
None. To obtain local orthometric heights the geoid separations are
applied to the ellipsoidal heights on the local coordinate side. Models of this
type are valid and can be used with coordinate systems which either have a
Projection defined or which are of Transformation Type Onestep or Twostep.

☞ If a Local Grid model is imported that is based upon an ellipsoid
other than None then the ellipsoid of the Coordinate System with
which the model shall be used must match the ellipsoid of the Geoid
Model.

Geoid Model Properties

The Properties window is filled dynamically depending on the selected geoid
model. It shows you the Path to the imported *.gem file, the Ellipsoid upon
which the model is based, its Extents and Spacing.

For Geodetic geoid models which are based upon the WGS84 ellipsoid you
can see whether or not they are flagged to be Applied on Local Side. Valid
WGS84 Geodetic models never have this flag set. They are always applied on
the WGS84 coordinate side. Valid Local Geodetic models must have the flag
set if they are based upon the WGS84 ellipsoid. Local Grid models are always
applied on the local side.

The Name of a Geoid Model can always be modified even if it is in use with a
Coordinate System.

☞ To be able to delete a Geoid Model it must not be in use with any
coordinate system.

5.6.7.6 CSCS Models

Several countries have produced tables of conversion factors to directly
convert between GPS measured coordinates given in WGS84 and the corre-
sponding local mapping coordinates, taking the distortions of the mapping sys-
tem into account. Using these tables it is possible to directly convert into the
local grid system without having to calculate your own transformation parame-
ters. A Country Specific Coordinate System Model (CSCS Model) is an addition
to an already defined coordinate system, which interpolates corrections in a
grid file and applies the interpolated corrections. The extra step of applying
these corrections can be made at different points in the coordinate conversion
process. Therefore, different methods of CSCS Models are supported.

To import a CSCS Model:

1. In the Coordinate System Manager go to the CSCS Models tab and click

   ![Import](image)

   Import from within the ribbon bar.

2. Browse for the *.csc file to be imported and open it.

To create a new CSCS Model:
1. In the Coordinate System Manager go to the **CSCS Models** tab and click **New** from within the ribbon bar.
2. In the **Properties** window give the geoid model unique **Name**.
3. Press the **** button to browse for and select a CSCS Model Field file (*.csc).
4. Press **Create** to create the new CSCS model or **Cancel** to exit the function.

See also:

Coordinate System Manager

**Conversion Methods**

**Grid conversion method (Grid Shifts):**

The Grid file is usually based upon **Local Grid** coordinates and can only be applied to coordinate systems for which a **Projection** is defined.

1. Step: applying the specified transformation, map projection and ellipsoid to get preliminary grid coordinates
2. Step: interpolation of a shift in Easting and Northing in the Grid file of the CSCS Model to get the final local Eastings and Northings

**Cartesian conversion method (Cartesian Shifts):**

The Grid file can be based upon **WGS84 Geodetic** or upon **Local Geodetic** coordinates and can only be applied to coordinate systems for which either a **Classical 3D Transformation** is defined or for which the **Transformation** is **None**.

1. Step: applying the specified transformation
2. Step: interpolation of a 3D shift in the grid file of the CSCS Model resulting in Local Cartesian coordinates
3. Step: applying the specified local ellipsoid and map projection to get the final local Eastings and Northings

**Geodetic conversion method (Geodetic Shifts):**

The Grid file can be based upon **WGS84 Geodetic** or upon **Local Geodetic** coordinates and can only be applied to coordinate systems for which the **Transformation** is **None**.

1. Step: interpolation of a shift in geodetic latitude and longitude in the grid file of the CSCS Model resulting in final local geodetic coordinates
2. Step: applying the map projection to get the final local Eastings and Northings

**Ellipsoidal conversion method (Ellipsoidal Shifts):**

The Grid file can be based upon **WGS84 Geodetic** or upon **Local Geodetic** coordinates and can only be applied to coordinate systems for which an **Ellipsoid** is defined.

1. Step: applying the specified transformation and the ellipsoid to get preliminary local geodetic coordinates
2. Step: interpolation of a shift in geodetic latitude and longitude in the grid file of the CSCS Model resulting in final local geodetic coordinates
3. Step: applying the map projection to get the final local Eastings and Northings
CSCS Model Properties

The Properties window is filled dynamically depending on the selected CSCS model. It shows you the Path to the imported *.csc file, the Kind of conversion method it uses, its Geodetic Datum Kind (either WGS84 or Local) and its Coordinate Type (either Grid or Geodetic) as well as the Extents and Spacing of the model.

The Interpolation Type can be either Bi-linear, Bi-quadratic or Spline and is pre-defined by the imported Grid file, too.

The Name of a CSCS Model can always be modified even if it is in use with a Coordinate System.

☞ To be able to delete a CSCS Model it must not be in use with any coordinate system.

5.6.7.7 Determine Transformation

5.6.7.7.1 Overview

In many surveying jobs it is necessary to transform the WGS84 coordinates into a local coordinate system or vice versa.

Using the Determine Transformation wizard, you can determine transformation parameters necessary to perform datum transformations between two sets of coordinates.

To determine a transformation it is necessary to have common control points whose positions are known in both WGS 1984 coordinates and local coordinates. The more points that are common between datum, the more accurately the transformation parameters can be calculated. Depending on the type of transformation used, details about the map projection, the local ellipsoid and a local geoid model can also be needed.

To create a new transformation

1. Go to the Coordinate System Manager (either from backstage or inside the project) and select Determine Transformation from the ribbon bar.
2. The Wizard consists of 3 steps:
   1. Step: Determine Transformation Wizard: Settings
   2. Step: Determine Transformation Wizard: Match Points
   3. Step: Determine Transformation Wizard: Results

Calculated transformations can be accessed and managed using the Coordinate System Manager.

Depending on the purpose of determining transformation parameters, there are three different transformation types supported in Infinity.

See also:

Classical 3D
One Step
Two Step
Which approach to use
Minimum Requirements for Coordinates
5.6.7.7.2 Determine Transformation Wizard: Settings

To define the settings:
1. Enter the transformation Name.
2. Select the transformation Type from the list box: Classical 3D, One-step or Twostep.
3. Depending on the selected Type choose the parameters.
   ☞ You can enter the parameters for shift, rotation and scale manually or let Leica Infinity compute them using common points.

5.6.7.7.3 Determine Transformation Wizard: Match Points
To match common points:

1. Select a project to load the list of points for System A (WGS84).
   ☞ Only points stored in the project as WGS84 are shown.

2. Select a project to load the list of points for System B (Local).
   ☞ Only points stored in the project as local grid are shown.
   Points can be loaded into the list for System A (WGS84) and System B (Local) separately by selecting an Infinity project. These can be two different projects, but you can also select the same project for A and B.

3. Match points:
   - **Match the points manually**
     Available only for the single selection.
     Select a point in System A (WGS84) then select a point in System B (Local).
     Press the button to make a pair.
   - **Match the points automatically**
     Available if nothing is selected or if at least one point which has a match is selected.
     The match looks for the same point ID from selected points and makes automatically pairs.
     Pairs always use the highest point roles.
     ☞ To unselect a point press CTRL+click.

4. ☀: When selected, the pair is removed from the list. The calculation is updated based on remaining pairs.

5. Select the **Use**: Position & Height, Position, Height or None.
   ☞ None removes matched common points from the transformation calculation but does not delete them from the list. This option can be used to help improve residuals.
   ☞ For Classical 3D, only Position & Height or None are available.

6. Press **Next** to proceed with Step 3: Determine Transformation Wizard: Results.

---

**5.6.7.7.4**

**Determine Transformation Wizard: Results**
To finalise the calculation:

1. Review the calculated transformation Parameters.

2. Select the Create Coordinate System checkbox to create a new coordinate system containing the newly calculated transformation. The new coordinate system will be available for further usage in Global Coordinate System Manager. Decide on a residual distribution.

3. A report is created by default and opens when you click Finish. Deselect the Show Transformation Calculation Report checkbox to hide the report.

4. Press Finish to perform the operation.

5.6.7.7.5 Classical 3D

Classical 3D

The Classical 3D transformation approach creates transformation parameters using a rigorous 3D Classical method.

Basically, the method works by taking the Cartesian coordinates of the GNSS measured points (WGS84 ellipsoid) and comparing them with the Cartesian coordinates of the local coordinates. From this, Shifts, Rotations and a Scale factor are calculated in order to transform from one system to another.

The Classical 3D Transformation approach allows you to determine a maximum of 7 transformation parameters (3 shifts, 3 rotations, and 1 scale factor). However the user can select the parameters to be determined.

The Classical 3D transformation allows the choice of two different transformation models: Bursa-Wolf or Molodensky-Badekas.

For the Classical 3D transformation method, we recommend that you have at least three points for which the coordinates are known in the local system and in WGS84. It is possible to compute transformation parameters using only three common points but using four produces more redundancy and allows for residuals to be calculated.
The Advantage
- The advantages of this method of calculating transformation parameters are that it maintains the accuracy of the GNSS measurements and may be used over virtually any area as long as the local coordinates (including height) are accurate.

The Disadvantage
- The disadvantage is that if local grid coordinates are desired, the local ellipsoid and map projections must be known. In addition, if the local coordinates are not themselves accurate, any new points measured using GNSS may not fit into this existing local system once transformed.
- In order to obtain accurate ellipsoidal heights the Geoid separation at the measured points must be known. This may be determined from a geoidal model. Many countries do not have access to an accurate local geoidal model. See also Geoid Models.

Other transformation approaches:
One Step
Two Step
Which approach to use

5.6.7.7.6 One Step

This transformation approach works by treating the height and position transformations separately. For the position transformation, the WGS84 coordinates are projected onto a temporary Transverse Mercator projection and then the shifts, rotation and scale from the temporary projection to the "real" projection are calculated.

The Height transformation is a single dimension height approximation.

Because of the way in which the position transformation approach works it is possible to define a transformation without any knowledge of the local map projection or local ellipsoid.

The height and position transformations are separate and therefore errors in height do not propagate into errors in position. Additionally, if knowledge of local heights is not good or non-existent you can still create a transformation for position only. Also, the height points and position points do not have to be the same points.

Because of the way in which the transformation works it is possible to compute transformation parameters with just one point in the local and WGS84 system.

The combinations of the number of points in position and the position transformation parameters that can be calculated from them are as follows:

<table>
<thead>
<tr>
<th>No. of position points</th>
<th>Transformation parameters computed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Classical 2D with shift in X and Y only</td>
</tr>
<tr>
<td>2</td>
<td>Classical 2D with shift in X and Y, Rotation about Z and Scale</td>
</tr>
<tr>
<td>More than 2</td>
<td>Classical 2D with shift in X and Y, Rotation about Z, Scale and Residuals</td>
</tr>
</tbody>
</table>
The number of points with height included in the transformation directly affects the type of height transformation produced.

<table>
<thead>
<tr>
<th>No. of height points</th>
<th>Height transformation based on</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No height transformation</td>
</tr>
<tr>
<td>1</td>
<td>Constant height transformation</td>
</tr>
<tr>
<td>2</td>
<td>Average constant between the two height points</td>
</tr>
<tr>
<td>3</td>
<td>Plane through the three height points</td>
</tr>
<tr>
<td>More than 3</td>
<td>Average plane</td>
</tr>
</tbody>
</table>

The Advantage

- The advantages of this method are that transformation parameters may be computed using very little information. No knowledge is needed of the local ellipsoid and map projection and parameters may be computed with the minimum of points. Care should be taken however when computing parameters using just one or two local points as the parameters calculated will only be valid in the vicinity of the points used for the transformation.

The Disadvantage

- The area of the transformation is restricted to about ten km² (using four common points).

Other transformation approaches:

Classical 3D
One Step
Which approach to use

Two Step

This transformation approach works by treating the height and position transformation separately. For the position transformation the WGS 84 coordinates are first transformed using a Classical 3D pre-transformation to obtain preliminary local cartesian coordinates. These are projected onto a preliminary grid using the specified ellipsoid and map projection. Then the 2 shifts, the rotation and the scale factor of a Classical 2D transformation are calculated to transform the preliminary to the “real” local coordinates.

The position transformation requires knowledge of the local map projection and the local ellipsoid. However, as the distortions of the map projection are taken into account, Two Step transformations can be used for larger areas than One Step transformations.

The height transformation is a single dimension height approximation.

The height and position transformations are separate and, therefore, errors in height do not propagate into errors in position. Additionally, if knowledge of local heights is not good or non-existent you can still create a transformation for position only. Also, the height points and position points do not have to be the same points.

Because of the way in which the transformation works it is possible to compute transformation parameters with just one point in the local and WGS84 system.
The combinations of the number of points in position and the position transformation parameters that can be calculated from them are as follows:

<table>
<thead>
<tr>
<th>No. of position points</th>
<th>Transformation parameters computed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Classical 2D with shift in X and Y only</td>
</tr>
<tr>
<td>2</td>
<td>Classical 2D with shift in X and Y, Rotation about Z and Scale</td>
</tr>
<tr>
<td>More than 2</td>
<td>Classical 2D with shift in X and Y, Rotation about Z, Scale and Residuals</td>
</tr>
</tbody>
</table>

The number of points with height included in the transformation directly affects the type of height transformation produced.

<table>
<thead>
<tr>
<th>No. of height points</th>
<th>Height transformation based on</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No height transformation</td>
</tr>
<tr>
<td>1</td>
<td>Constant height transformation</td>
</tr>
<tr>
<td>2</td>
<td>Average constant between the two height points</td>
</tr>
<tr>
<td>3</td>
<td>Plane through the three height points</td>
</tr>
<tr>
<td>More than 3</td>
<td>Average plane</td>
</tr>
</tbody>
</table>

**The Advantage**

- Errors in local heights do not affect the position transformation
- The points used for determining the position and height transformation do not necessarily have to be the same points.
- The distortions of the map projection are taken into account which enables you to use this kind of transformation for larger areas.

**The Disadvantage**

- Knowledge of the local projection and local ellipsoid are required.

**Other transformation approaches:**

- Classical 3D
- One Step

**Which approach to use**

This question is almost impossible to answer since the approach used will depend totally on local conditions and information.

If you wish to keep the GNSS measurements totally homogenous and the information about the local map projection is available, the Classical 3D approach would be the most suitable.

For cases where there is no information regarding the ellipsoid and/or map projection and/or you wish to force the GNSS measurements to tie in with local existing control then the One Step approach may be the most suitable.

The Two Step approach also treats position and height information separately which allows for position only control points to be used as well. Compared to the One Step approach, information regarding the ellipsoid and map projection...
Minimum Requirements

The following list provides you with the minimum requirements for coordinate system A and B, necessary to calculate transformation parameters using the different transformation types. The coordinates either have to comply with the minimum requirements or the coordinate system attached must allow the conversion of the coordinates to the type required. For example, if coordinates are required in cartesian format but are available in geodetic format only, an ellipsoid must be defined allowing the system to convert to the appropriate format.

<table>
<thead>
<tr>
<th></th>
<th>Classical 3D</th>
<th>One Step</th>
<th>Two Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>System A</td>
<td>Cartesian + Ellipsoid</td>
<td>Cartesian</td>
<td>Cartesian</td>
</tr>
<tr>
<td>System B</td>
<td>Cartesian</td>
<td>Grid</td>
<td>Grid + Ellipsoid + Projection</td>
</tr>
</tbody>
</table>

*Cartesian + Ellipsoid* means that the coordinates have to be available in Cartesian or Geodetic format plus an Ellipsoid must be defined in the attached Coordinate System.

The One Step and the Two Step transformations require that the geoid model is of type Grid. This means that geoids of type Geodetic or geoids created from WGS84 or another ellipsoid cannot be used.

Additionally, when a transformation is determined it is important to state whether ellipsoidal or orthometric heights are intended to be used in the target system B. With this information being stored as part of the transformation definition (Height mode), the system knows in which direction the geoid separations have to be applied.

<table>
<thead>
<tr>
<th>Type</th>
<th>Minimum requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classical 3D 7 parameters</td>
<td>3 points with position + height</td>
</tr>
<tr>
<td>Classical 3D 3 shifts</td>
<td>1 point with position + height</td>
</tr>
<tr>
<td>Classical 3D 3 shifts + Scale Factor</td>
<td>2 points with position + height</td>
</tr>
<tr>
<td>Classical 3D 3 shifts + Rotation about Z</td>
<td>2 points with position + height</td>
</tr>
<tr>
<td>Classical 3D 3 shifts + Scale Factor + Rotation about Z</td>
<td>2 points with position + height</td>
</tr>
<tr>
<td>Classical 3D Other combinations</td>
<td>If 3 unknowns or less 1 point with position + height</td>
</tr>
<tr>
<td></td>
<td>If 4,5 or 6 unknowns 2 points with position + height</td>
</tr>
<tr>
<td>One Step</td>
<td>1 point with position only</td>
</tr>
<tr>
<td></td>
<td>1 point with height is required for the height part of the transformation to be determined.</td>
</tr>
<tr>
<td>Type</td>
<td>Minimum requirements</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Two Step        | 1 point with position only  
1 point with height is required for the height part of the transformation to be determined.                                                                 |

Only if these requirements are met it will be possible to see the points loaded in the lists and to move to the Result page with the Next button of the Match Points.

☞ Since a One Step transformation may be calculated without any given height information on the local side the system will take the WGS84 ellipsoidal height as the local height in that case. This height will also be displayed as ellipsoidal then.

☞ If a Two Step transformation is calculated without any given height information on the local side the system will display the height after applying only the pre-transformation as a local height.

5.6.8 Code Manager

5.6.8.1 Overview

Code Manager

The Code Manager tool allows you to manage all feature coding information included in Code Tables:

• Coding information,
• Coding style informations,
• Layers. Layers can be used to overwrite individual coding style information.

To open a Code Table for managing content with the Code Manager:

1. Go to Backstage > Tools > Code Tables.  
   In the Content Area a list of Code Tables appears.
2. Select a Code Table you want to edit.
3. Click on the button preceding the code table in the list of Code Tables.  
   A Code Manager window opens where you can manage content of the selected Code Table.

You can add / edit / delete the Code Groups, Codes and Attributes. You can define global style for Code Tables with Layers and Blocks.

To manage coding & coding style information:

Open a Code Table in the Code Manager application and select the Code Table tab.

For managing coding and coding style information choose from the following possibilities:

• Add a new Code Group / Add a new Code / Add a new Attribute  
• Edit a Code Group / Edit a Code / Edit an Attribute  
• Delete a Code Group / Delete a Code / Delete an Attribute

To manage Layers:

Open the Code Table and select the Layers tab.

To define global styling properties for your Code Table choose from the following possibilities:
• Add a new Layer
• Edit a Layer
• Delete a Layer

To manage Blocks:
Open the Code Table and select the Blocks tab.

To define global styling properties for your Code Table choose from the following possibilities:
• Import Blocks
• Edit a Block
• Delete a Block

5.6.8.2 About Coding

All about Coding

Feature Coding is common to use for describing topographical objects in the field like trees, fences, buildings, roads etc. Collecting in-the-field information with codes and grouping them in the project with layers helps you not only to control visibility and style (color, line width etc) of the survey data but also to recognize coding mistakes and bad observations (points position).

The Code Table contains coding information and coding style information that are applicable to the field data.

Coding Information

Coding information consists of:
• Code Groups
• Codes
• Attributes

Code Group

The primary building block of a Code Table is known as Code Groups. One or more Code Groups may be contained within a Code Table. A Code Group will usually describe a large group of objects such as Buildings, Vegetation etc.

Code

Codes are the secondary building block of a Code Table and may be definite features. For example, a Code Group called Vegetation could have the codes Tree, Shrub and Hedge. Alternatively, the Codes could consist of numbers only with a Code Name describing the code. E.g. code 145 could relate to the code name Tree.

Attribute

Each Code may have one or more Attributes attached to it. Attributes are the tertiary building block of a Code Table. Attributes prompt you to enter information describing a Code.

For example, the code Tree could have the attributes Diameter, Species, Height, and Remark attached to it. You may then define an Attribute Value for an Attribute. It may be chosen from a predefined Choice List or a predefined Range. For example, possible Values for the Attribute Diameter could be from a Range from 1 to 25 (meters) and the Attribute Species from a Choice List that contains the Values Pine, Fir, and Oak.
Note that you do not have to define an Attribute Value within Code Management. If no value is defined for an Attribute you may enter a value or description in the field.

**Coding Style Information**

The coding style information consists of:

- **Layers**
- **Blocks**

which are extended code properties used for visualization.

**Layer**

A layer is used to group thematic information within a project. The layer includes style information that can apply to all of the coded features that are using this layer.

Use the **Style option** to decide if the feature is presented in the project with its individual **By Code** style or with the common **By Layer** style.

**Block**

Blocks are CAD blocks that can be assigned to a point code.

**Free Codes**

A Code Table may also contain **Free codes**. These codes are imported from an instrument but there is no Code in the Code Table to which they could be assigned.

You can assign **Free codes** to the Code Table manually.

### 5.6.8.3 Code Groups

**Code Groups**

Code Groups describe groups of objects, which have a common theme. A Code Table may contain as many Code Groups as you define. For example, *Utilities, Vegetation, Buildings* could all be different Code Groups within a Code Table. Each Code Group then has sub-components known as Codes and Attributes.

You can **add** new Code Groups, **modify** existing Code Groups and **delete** Code Groups.

Code Group names may be up to 16 characters long and may consist of alphanumeric characters.

You can add / edit / delete the Code Groups belonging to a specific Code Table with the Code Manager tool at Backstage.

**To add a new Code Group to the Code Table:**

1. **Open the Code Table** in the Code Manager and select the **Code Table** tab.
2. **Press New Code Group.**
   - In the Content Area a **New Group** line will be created with default settings that you can modify.
   - A Code Group name must be unique and may be up to 16 characters long.
   - A Description is optional.
3. **Press Apply** to store changes in the Code Table and **OK** to close the Code Manager.
You can set Code Groups to be visible on the instrument by selecting **Activated on instrument**.

**To edit a Code Group in a Code Table:**
1. **Open the Code Table** in the Code Manager and select the **Code Table** tab.
2. In the Content Area edit required Code Group fields.
3. Press **Apply** to store changes in the Code Table and **OK** to close the Code Manager.

**To delete a Code Group from a Code Table:**
1. **Open the Code Table** in the Code Manager and select the **Code Table** tab.
2. Select the Code Group that you want to delete and press **Delete**.
3. Press **Apply** to store changes in the Code Table and **OK** to close the Code Manager.

If you delete a Code Group all Codes and Attributes in that Code Group will be deleted.

---

### 5.6.8.4 Codes

**Codes**

Codes are parts of Code Groups and are used to describe objects. A set of Codes with a common theme is grouped into a Code Group, e.g. the Codes **Tree**, **Hedge**, **Grass** may be attached to a Code Group entitled **Vegetation**.

There is no limitation for the number of codes. You can add new Codes, modify existing Codes and delete Codes within a Code Group. Each Code may have Attributes attached to it. Attributes prompt you to enter further information about the Code.

A Code consists of **coding information** and **coding style information**.

**Coding information:**

- **Code Name** may be up to 16 characters long and may consist of numbers or alphanumeric characters (for example Tree).

- **Code Description** may be up to 16 characters long and may consist of alphanumeric characters (for example Outstanding Tree). The Description of a Code is optional.

  For Leica Captivate V2.30 and higher the allowed length is 48 characters when ASCII characters are used. If other than ASCII characters are used, then it depends on the character set whether longer names will be truncated on export. Code lists and jobs with names longer than 16 characters cannot be imported to any Leica Infinity version lower than 2.4.

- **Type** can either be Point, Line, Area or Free.

- **Quick Code** must be unique within a Code Table and up to three alphanumeric characters are allowed. To define a quick code is optional.

- **Linework** is only available for codes type **Point** and it can be either None, Start Line or Start Area.

**Coding style information:**
Layer enables grouping of codes by theme. For example, the Codes Kerb, Can-ter line, Pavement can be grouped by the same layer called Road.

Style option can be either By Layer or By Code. This option allows you to set if the code uses its own style in the project or uses the style from the layer. For example, the codes Kerb and Pavement (type Line) can use different colors. Both can be assigned to the same layer called Road. When you select By Code option they will be presented in the project with their own color. When you select the By Layer option they will be presented with the same color defined for layer Road.

☞ This option is not available for free codes.
☞ By Code is not available for the point code if Linework is set to 'None'.

Additional style properties:
Line Color is available for code types Point/linework (Start Line/Start Area), Line, Area.

Line Width is available for code types Point/linework (Start Line/Start Area), Line, Area.

Line Style is available for code types Point/linework (Start Line/Start Area), Line, Area.

Shading color is available for code types Point/linework (Start Area), Area Layer.

Managing Codes
To add a New Code to the Code Group:
1. Open the Code Table in the Code Manager and select the Code Table tab.
2. Select the Code Group in the Navigator view to which you want to add a New Code and press New Code.
3. In the Content Area a New Code line will be created with default settings that you can modify. In the Attributes you can see how many attributes the Code has.
4. Press Apply to store changes in the Code Table and OK to close the Code Manager.

☞ You can create new Layers or modify existing Layers to be used for a Code in the Layers tab.

To edit a Code in a Code Group within a Code Table:
1. Open the Code Table in the Code Manager and select the Code Table tab.
2. In the Navigator select the Code Group to which the Code belongs to.
3. In the Content Area edit the fields you want change.
4. Press Apply to store changes in the Code Table and OK to close the Code Manager.

☞ You can edit only fields that are allowed for the given code type.

To delete a Code in a Code Group within a Code Table:
1. **Open the Code Table** in the Code Manager and select the **Code Table** tab.
2. In the **Navigator** select the **Code Group** to which the Code belongs to.
3. Select the Code in the **Content Area** and press **Delete**.
4. Press **Apply** to confirm and **OK** to close the Code Manager.Press **Cancel** to exit without deleting.

☞ If you delete a Code all Attributes of that Code will be deleted.

---

### 5.6.8.5 Attributes

**Attributes**

Attributes are the tertiary building block of a Code Table. Attributes prompt you to enter information describing a Code. You can **add** new Attributes, **modify** or **delete** existing Attributes of a Code.

For example Attributes for the **Code Tree** could be **Species**, **Diameter** and **Remark**.

An Attribute generally consists of Attribute Name and Type and the Attribute Value with a defined Value Type, an optional Value Region and a Default Value.

**Attribute Name**

The Attribute Name may consist of alphanumeric characters and may be maximum 13 characters long.

☞ For Leica Captivate V2.30 and higher the allowed length is 48 characters when ASCII characters are used. If other than ASCII characters are used, then it depends on the character set whether longer names will be truncated on export. Code lists and jobs with names longer than 16 characters cannot be imported to any Leica Infinity version lower than 2.4.

**Attribute Type**

For every Attribute the Type must be chosen. Possible Attribute Types are **Normal**, **Mandatory** or **Fixed**. Choosing Normal means the Attribute Value can be edited in the field.

If **Mandatory** is chosen, the Attribute Value must be edited in the field.

If the Attribute type is **Fixed**, no Value is shown on the instrument and the Default Value will automatically be attached to the Attribute.

**Value Type**

For every Attribute a Value Type must be selected. Possible Value Types are **Text**, **Real** or **Integer**.

If you choose Real or Integer you have the possibility of entering a Choice List or a Range of possible Values.

If you choose Text possible Values may only be entered in a Choice List.

For example for the Attribute **Species** choose Text, whereas for the Attribute Diameter choose Integer as the Value Type.

**Value Region**

Depending on the chosen Value Type you can select the Value Regions **None**, **Choice List** or **Range**.

In a Choice List all possible Values can be entered, in a Range the smallest and the largest possible Value can be entered.
For example for the Attribute Species choose Choice List, for Diameter choose Range, and for Remark choose None.

**Attribute Values**

For a **Choice List** you can enter or modify a list of possible Attribute Values. For example Oak, Pine and Fir could be possible Choice List entries for the Attribute Species.

To add new Values to the Choice List press the **Add** button.

To remove Values from the Choice List press the **Delete** button.

To modify the sequence of the values in the Choice List press the **Move Up/Move Down** buttons.

For **Range** the interval (Range From, Range To) can be entered or modified.

For example, for the Attribute Diameter a Range from 1 to 5 (meters) could be defined.

Setting a **Default Value** is optional.

If you select *Choice List* or *Range* for Value Region you can enter a value from the Choice List or within the Range as Default Value.

If the Attribute Type is *Fixed* you need to enter a Default Value otherwise no Attribute Value will be set at all.

**Managing Attributes**

**To add a New Attribute:**

1. Open the Code Table in the Code Manager and select the **Code Table** tab.
2. In the **Navigator** select the **Code** to which you want add a new Attribute and press **New Code Attribute**.
3. In the Content Area **New Attribute** line will be created with default settings that you can modify.
4. Press **Apply** to confirm and **OK** to close the Code Manager.

☞ To copy attributes between codes use Ctrl C and Ctrl V.

**To edit an Attribute of a Code of a Code Group within a Code Table:**

1. Open the Code Table in the Code Manager and select the **Code Table** tab.
2. In the **Navigator** select the **Code** to which the Attribute belongs to.
3. In the Content Area **edit** required Attribute fields.
4. Press **Apply** to confirm and **OK** to close the Code Manager.

**To delete an Attribute:**

1. Open the Code Table in the Code Manager and select the **Code Table** tab.
2. In the **Navigator** select the **Code** to which the Attribute belongs to.
3. In the Content Area select an Attribute and press **Delete**.
4. Press **Apply** to confirm and **OK** to close the Code Manager.

☞ Multi-selection is available with Shift and Ctrl.
**Layers**

The layer property allows you grouping coded features by theme. Use layers to define common style. You can later decide if you want the feature to be presented in a project with its individual style or with the common style.

You can fully manage Layers belonging to a Code Table within the Backstage > Code Manager tool.

☞ **New Layers** can be created only from within the Backstage > Code Manager.

**To add a new Layer to a Code Table:**
1. Open the Code Table in the Code Manager and select the **Layers** tab.
2. Press **New Layer**.
   In the Content Area a **New Layer** will be created with default setting that you can modify.
3. Press **Apply** to store changes in the Code Table and **OK** to close the Code Manager.

**To modify existing Layers:**
1. Open the Code Table in the Code Manager and select the **Layers** tab.
2. Select the Layer you want to modify from the list and edit the required fields.
3. Press **Apply** to store changes in the Code Table and **OK** to close the Code Manager.

**To delete a Layer:**
1. Open the Code Table in the Code Manager and select the **Layers** tab.
2. Select the Layer from the list that you want to delete and press **Delete**.
3. Press **Apply** to store changes in the Code Table and **OK** to close the Code Manager.

☞ You can assign a **Code** to a **Layer** by setting the **Style Option** of a Code to **By Layer** in the Project Code Manager.

---

**5.6.8.7 Line Styles**

**Line Styles**

Line style is a visual property that can be assigned to geometric objects. Line styles can be for example a pattern of dashes, dots or text.

Line styles are defined in a line style definition (LIN) file. You can import the line styles from the LIN file and use them with your codes.

The line style functionality is not supported by SmartWorx Viva or Captivate. Therefore, line styles are not exported to the code list. Collect your data as normal and assign the Code Table to the project for the correct style representation.

☞ Line style names are case sensitive. During an import, line styles with the same name are overwritten.

**To import line styles from a LIN file to a Code Table:**
1. Open the Code Table in the Code Manager and select the **Line Styles** tab.
2. Select the Import button from the ribbon bar and select **Line styles** from the pulldown menu.
3. Browse to the location where the source file is stored.
4. Select the LIN file and press **Import**.
To import line styles from a LICT file to a Code Table:
1. Open the Code Table in the Code Manager.
2. Select the **Import** button from the ribbon bar.
3. Select the Infinity Code Table file (*.lict) type to be imported.
4. Browse to the location where the source file is stored.
5. Select the file and press **Import**.

To assign a Line style to a Code:
1. **Import** line styles to the Code Table.
2. In the Navigator, select the Code Group which the code belongs to.
3. Select the Code in the content area and select the Line style combo box.
4. Choose your **Line style** from the list.

☞ Line style combo box is only available for the Code type **Line** or for the Code type **Point** with Linework set to **Start Line** or **Start Area**.

5.6.8.8 Code Data Exchange

The Code Table content can be built by importing an existing Leica Infinity Code Table or an existing SmartWorx Viva Code List.

Export functionality enables you to create a SmartWorx Viva Code List or a Code Table that can be redistributed to be used on other PCs.

To import a Code Table or a Code List:
1. In the Code Manager **open the Code Table** that you want to update.
2. Press **Import** in the **Navigator**.
3. Browse to a Code Table or a Code List that you want to import and press **Open**.
4. Press **Apply** to store changes in the Code Table and **OK** to close the Code Manager.

☞ After importing a Code List you may add **coding style** properties to the imported Codes.

To export a Code Table or a Code List:
1. In the Code Manager **open the Code Table** that you want to update.
2. Press **Export SmartWorx DBX** or **Export Leica Infinity Code Table File** in the **Navigator**.
3. Browse to a folder where you want to place your Code Table or Code List.
4. Press **OK** to export and **OK** to close the Code Manager.

☞ You can find the exported Code Table for further activity in your file system in a specified folder.

5.7 Services

5.7.1 Leica Exchange

Infinity supports the Leica Exchange service.
Transfer objects easily between the field and the office with Leica Exchange.
The yearly Leica Exchange Service allows an unlimited number of exchanges to an unlimited number of users.
To use Leica Exchange, sign in with your **User name** and **Password**.

To make it as easy as possible:
• Choose to remember credentials.
• Connect on startup.

When logged in, you can import or export data direct from the project.

☞ Refer to the tutorial "How to send and receive data to and from the field - Working with Leica Exchange":
https://leica-geosystems.com/-/media/279c6f19b6ce49479aa9942529c85994.ashx
Tutorial data can be downloaded in the Localisation Tool.

Importing data
In the Import dialog select Leica Exchange from the drive list.
1. Select Leica Exchange.
2. View the available data form the Leica Exchange window.
3. Double click the data you wish to import to your project. This will copy the data to the computer.
4. Select the data, and if applicable choose the import settings.
5. Press Import.

☞ The Leica Exchange data will always be copied to your computer. From the Archive you can always access the location from the computer the data is stored.

Exporting data
In the Export dialog select Leica Exchange from the drive list.
1. Select Leica Exchange.
2. From the Leica Exchange window select the user or users to send data to.
3. Choose the data format and export settings.
4. Press Export.

☞ The Leica Exchange data will always be copied to your computer. From the Archive you can always access the location from the computer the data is stored.

5.7.2 Leica ConX
Leica Infinity supports the Leica ConX Service. In the Backstage you can enter a default user and password.
If you do so, User and Password will automatically be filled in when you click on Login from within the External Services module.
See also:
The Leica ConX Service
Click on Connect to connect to the service from within the Backstage.
You will stay connected until you log out from within the External Services module.

5.7.3 Leica JetStream
Leica Infinity supports the Leica JetStream Service.
You can publish point clouds to existing storage locations.
To connect to the Leica JetStream Service:
1. Go to the Backstage.
2. Select Services from the menu on the left.
3. Select Leica Jetstream from the Services menu.
4. Define the hostname and port.
   ☞ You can use the default port 9090.
5. Press the Connect button.
☞ To learn more about this service visit:

See also:
The Leica JetStream Service

5.7.4 HxGN SmartNet

HxGN SmartNet
Leica Infinity supports the HxGN SmartNet Service and allows you to download post-processing data from GNSS reference station service providers directly to a project.

To connect to the HxGN SmartNet service:
1. Select a Provider in your region from the drop-down list. The list is updated regularly online.
   Or select to enter the host manually and type the provider's Address in the field below.
   ☞ If there is no HxGN SmartNet service provider listed for your region, contact your local Leica Geosystems sales representative to find out more.
2. Login with your User Name and Password.
   ☞ If you do not have a subscription, yet, click the hyperlink to go to the provider’s webpage.
3. Press the Connect button.

When logged in, you will additionally see all HxGN SmartNet reference stations in the GNSS Manager > Reference Stations tab. HxGN SmartNet reference stations are indicated by red station icons in the Map view and have got HxGN SmartNet listed as Provider in the Inspector view. Download works in the same way as for all other stations.

See also:
GNSS Manager
5.7.5 Hexagon Imagery Program

Infinity supports the **Hexagon Imagery Program** Basemap service. Also referred to as **HxIP**.

This Basemap Service is a cached basemap imagery service consisting of up to 30-centimetre true colour imagery that is updated on an ongoing basis. This service provides a backdrop to your Infinity projects which is a nice way to help visualize, reference and relate your project data. It provides up to 30-centimetre true colour imagery that can be loaded and displayed in a project and with the **Clip Basemap** function, downloaded as a **Georeferenced** image and available for export to the field software. This service is currently provided free of charge for Infinity customers having an active **Customer Care Package** subscription. The software reads from the **Infinity** EID license the information about the maintenance period. When the maintenance period has expired, you will not have access to the imagery.

To learn more about this service visit: [https://hxgncontent.com/imagery](https://hxgncontent.com/imagery)

5.7.6 OpenStreetMap

Infinity supports the **OpenStreetMap** service. Also referred to as **OSM**.

This service provides a backdrop to your Infinity projects which is a nice way to help visualize, reference and relate your project data. It provides open source maps that can be loaded displayed in a project and with the **Clip Basemap** function, downloaded as a **Georeferenced** image and available for export to the field software. This service is available for Infinity customers having an active **Customer Care Package** subscription. The software reads from the **Infinity** EID license the information about the maintenance period. When the maintenance period has expired, you will not have access to the OpenStreetMap service.

5.7.7 Map Services

Infinity supports the following **Map Services**:
- WMS (Web Map Service)
- WMTS (Web Map Tile Service)
- WFS (Web Feature Service)

<table>
<thead>
<tr>
<th>Map Service</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WMS</td>
<td>A WMS (Web Map Service) delivers georeferenced map images. A WMS service provides various layers that the user can turn on and off. WMS focuses on rendering custom maps and is an ideal solution for dynamic data or custom styled maps.</td>
</tr>
<tr>
<td>WMTS</td>
<td>A WMTS (Web Map Tile Service) delivers pre-generated georeferenced map images. A WMTS service may contain one or more styles, dimensions, or tiling schemes to specify how the WMTS layer is to be displayed. WMTS trades the flexibility of custom map rendering for the scalability possible by serving of static data where the bounding box and scales have been constrained to discrete tiles.</td>
</tr>
<tr>
<td>WFS</td>
<td>A WFS (Web Feature Service) serves, queries, and updates feature geometry and attributes using a Geography Markup Language (GML) profile.</td>
</tr>
</tbody>
</table>

How to define a WMS, WMTS or WFS map service

1. Go to the Backstage and select Services from the menu on the left and Map Services from the Services menu.
2. Click the WMS, WMTS or WFS button to create a new user-defined map service.
3. Insert all necessary login information in the Configuration table.
   - Name: The name of map service.
   - URL: The web address of map service.
   - User Name: Your user name.
   - Password: A valid password.
4. Click the button Get Capabilities to connect to the map service. Information about the map service appears in the Detail table after connection.
5. Activate the checkbox Remember Credentials to save the login information.

For WMTS only:
In the Data table, you can select various Layers and Styles. Click on the arrow in the table field to open a drop-down list of options. In the drop-down list, click on the layer/style to define a default layer/style for your project.

For WMS only:
In the Data table, various layers are displayed. Click on the eye icon to turn the layers on and off.

How to delete a WMS, WMTS or WFS map service

1. Click on a user-defined map service to bring it to front and activate it.
2. Click the Delete button to delete the map service.
To use map services in a project, refer to "Map Services".

5.7.8 AUTODESK BIM 360

Infinity supports AUTODESK BIM 360 service for easy and direct collaboration with construction projects.
Log in directly to your project services to access, download and upload field data.
You need an existing account and subscription in order to use this service. You will be guided through the steps to log in and authorise Infinity to connect to the BIM 360 service.

Refer to the Infinity YouTube video to learn how to use the service: https://www.youtube.com/watch?v=QMMPzShF2UA&t=0s&list=PL0td7rOVk_IV_al3Zi5-KuAYa1VvU6WOrM&index=2

5.8 Help and Support

5.8.1 Overview

Help and Support In the Help and Support backstage you get information on:

Your License:
The purchased Product Options are listed together with your License Model.
With Floating Licenses, it is interesting to see whether an option is momentarily available or not.
You can also see when your license expires and your maintenance has to be renewed.

If you are using a Floating license, you can connect to a different license server here if necessary.

Your version of Leica Infinity:
Under Legal Trademarks you are informed that and how Leica Infinity is protected by copyright.
Under Remarks you are informed on legal and licensing notices on third party software components that Leica Infinity makes use of.

You can also:
"Check for Updates"
"Localise Leica Infinity"

5.8.2 Check for Updates

Check for Updates Periodically, Leica Infinity updates will be made available for download and installation. These updates can include new releases with new modules or new features. Updates can also include maintenance releases with software patches.

You can check for updates from the Help&Support menu in the backstage, or have the checks made automatically on start-up. Updates can be downloaded from myWorld@Leica Geosystems, the Leica Geosystems’ customer information portal.
To get the most from any new updates for Leica Infinity that may be available, it is recommended to have a current Leica Geosystems Customer Care Package (CCP). Having an active CCP allows access to all software updates including new releases.

**Note:**
For users who do not have administrator rights on their computer, the Check for Update message will only inform of available updates. The files required for any update must be downloaded and installed by your IT department or a person with administrative rights for that computer.

### 5.8.3 Localise Leica Infinity

#### Localisation tool

The Localisation tool allows you to download and/or import data that are predefined for your region. The following objects are supported:

- Coordinate Systems
- Geoid Models
- Stylesheets
- Training Materials
- Documents

To get access to the Localisation tool, do the following:

1. Select the **Help & Support** menu on the Backstage file tab.
2. A left mouse click on **Localise your Infinity** opens the **Localisation Tool** with Global folder open as default.

The Localisation tool is only available with the latest version of Infinity.
How to download/import data

1. Select your location to see all available data for download/import in the Data field.

2. Select the check box of the data category you want to download/import. Drill into the category by clicking the little arrow to select single files.

3. To select a download location, click on the folder icon . The Select Folder dialog appears and you can change the default download path.

4. Click the Start button to start the download/import.

Pre-defined data

<table>
<thead>
<tr>
<th>Coordinate Systems</th>
<th>Downloaded coordinate systems will automatically be imported and available for use under: Tools &gt; Coordinate Systems. In the Coordinate Systems Manager, click the Copy to Project button to make the selected coordinate system available for use in the currently active project. See also: &quot;Coordinate Systems&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geoid Models</td>
<td>Geoid Models and CSCS Models can be downloaded and imported separately. After download they will automatically be available for further use in the Coordinate System Manager</td>
</tr>
<tr>
<td>Stylesheets</td>
<td>Downloaded stylesheets are automatically imported and available to select in settings for Export data using stylesheets</td>
</tr>
<tr>
<td>Training Materials</td>
<td>Downloaded training materials, for example tutorials, are saved at the selected download location. See also: &quot;Training materials&quot;</td>
</tr>
<tr>
<td>Documents</td>
<td>Downloaded documents, for example readme files, are saved at the selected download location.</td>
</tr>
</tbody>
</table>

☞ Only data provided by your local Leica distributor will be available for download.